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About this guide 

This guide describes workflow, concepts and procedures for using the Infor Distribution FACTS 
Sales Orders Module. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require an 
understanding of the product and how to use it. 

Related documents 
You can find the documents in the product documentation section of the Infor Xtreme Support portal, 
as described in "Contacting Infor" on page 9. 

For information about other Infor Distribution FACTS modules or basic usage information, see the 
other users guides in the Infor Distribution FACTS PDF Library.  Access these documents from the 
bookmarks of this document: FACTSDocNavigation.pdf. 

Contacting Infor 
If you have questions about Infor products, go to the Infor Xtreme Support portal at 
www.inforxtreme.com. 

If we update this document after the product release, we will post the new version on this Web site. 
We recommend that you check this Web site periodically for updated documentation.  

If you have comments about Infor documentation, contact documentation@infor.com. 

http://www.infor.com/inforxtreme
mailto:documentation@infor.com
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Chapter 1 Overview 1  
 

Sales Orders Overview 
The Infor Distribution FACTS Sales Orders Module is the backbone of the FACTS customer 
service element. It maintains file information, provides complete audit trails on all orders, 
invoices, credit memos and other transactions. The module also optionally posts to General 
Ledger according to the parameters you establish in the GL posting tables.  

The Sales Orders module is broken down into the following subsystems:  

Quotes  

MSDS 

Orders  

Inquiries 

Invoices  

Reports & Prints 

Customer Returns  

End of Period 

Shipping  

File Maintenances  

Contract Pricing  

Many of these subsystems and additional features are optional so you can effectively use 
the parts of the SO module that you need and ignore the others. 

ICVerify, CenPOS or PayPro Flow Credit Card Handling  
FACTS offers two methods for processing credit card transactions: manual and automatic. 
FACTS by itself allows you to process these transactions manually via voice authorization. 
Automatic credit card processing is possible by integrating the FACTS system with 
ICVERIFY, PayflowPro or CenPOS software and magnetic or stripe devices, which are 
purchased separately from ICVERIFY, Inc, PayPal, or CenPOS. (See www.icverify.com, 
www.PayPal.com, or www.cenpos.com for more information.)   
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With either method, FACTS users can perform sales, credits and voids. 

Credit Card Processing with ICVERIFY, PayflowPro, or CenPOS 

ICVERIFY, PayflowPro, and CenPOS are third-party credit card processing software 
packages that can be integrated with FACTS to provide automatic credit card processing 
capabilities.  

The companies also offers several types of magnetic card stripe readers that plug into to 
terminals or PCs. No device drivers or link files are required. Credit card processing 
companies often offer higher discounts to companies using card swipe devices. 

Setting up credit card handling for manual processing  

1 Set up a cash type terms code in the Accounts Receivable Terms Code F/M program. 
Credit cards must be cash type payments, not an A/R type. The General Ledger Number 
you choose must be a cash G/L account number. 

2 Navigate to the Company Control F/M in System Management File Maintenances. 
Choose "Manual" or "Manual do not collect information". 

Manual Credit Card Processing  

If you chose Manual in Company Control F/M, when you enter a credit card payment, 
FACTS opens a pop-up window, which displays the amount of the purchase and whether the 
transaction is a sale, void sale, credit or void credit.  

In this window, enter the customer’s credit card number and the expiration date.   

The system then asks whether it is OK to process a sale.  

The credit card will be checked by FACTS to ensure it is a valid credit card number but will 
not communicate to a credit card processor to validate whether the card is authorized for the 
amount charged or even if the account is active. 

If you chose "Manual do not collect information" in Company Control F/M, credit card 
payment types will not display a window to collect the credit card information. 

Credit Card Processing with PayflowPro   

When processing for PayPal using the PayflowPro client, FACTS uses the Credit Card 
Processing (SOC611) program to gather all information (according to the selections chosen 
in SM Credit Card Control F/M). 

The system displays the amount, but it cannot be changed on this screen. You can enter the 
Credit Card Number manually, or by a swipe by pressing the Swipe button, or F1. When you 
press the Swipe Card button, FACTS displays a message indicating that it is waiting for the 
card to be swiped. You can press F4 to cancel. The system remembers the last mode the 
system was in when the credit card information was successfully gathered (swiped or 
manually entered), and stores this in the SMT record so that the next time you access the 
Credit Card Information screen, it is in the same mode as last time. Note: This only applies to 
"Sale" type transactions. The program displays the credit card number in the Credit Card 
Number field, and other track data into the appropriate fields. The system disables the Credit 
Card Number and Expiration Date fields after you swipe the credit card.   
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Credit Card Processing with ICVERIFY 

ICVERIFY is a third-party credit card processing software package that can be integrated 
with FACTS to provide automatic credit card processing capabilities. The company also 
offers several types of magnetic card stripe readers that interface with FACTS terminals. 
Since the card readers are recognized as keyboard devices, no device drivers or link files 
are needed. 

When processing for ICVerify, FACTS uses the credit card processing (SOC611) program to 
gather all information (according to the selections chosen in Credit Card Control F/M 
(SOF957)). 

The system displays the amount, but it cannot be changed on this screen. You can enter the 
Credit Card Number manually, or by a swipe by pressing the "Swipe" button, or F1. When 
you press the "Swipe Card" button, FACTS displays a message indicating that it is waiting 
for the card to be swiped. You can press F4 to cancel. The system remembers the last mode 
system was in when the credit card information was successfully gathered (swiped or 
manually entered), and stores this in the SMT record so that the next time you access the 
Credit Card Information screen, it is in the same mode as last time. Note: This only applies to 
"Sale" type transactions. The program displays the credit card number in the Credit Card 
Number field, and other track data into the appropriate fields. The system disables the Credit 
Card Number and Expiration Date fields after you swipe the credit card.   

Working with automatic credit card transactions 

After entering the terms code and the purchase amount, you can choose F1 to swipe the 
card or enter the card information manually. 

Choose Process when you are ready to process the sale.  

A mini dialog box will appear, telling you the system is waiting for recognition and then a 
response.  

If the credit card processing company does not answer or respond within the time set in the 
Credit Card Control F/M, the system gives you either a recognition timeout (if the card 
processing card cannot connect to the provider’s system) or a response timeout (if the 
provider’s system answers but does not approve or decline within the established response 
time). 

Recognition timeouts.  You can wait again or cancel the transaction. Canceling a document 
after a recognition timeout creates no problems because the processing company is not 
aware of the transaction.    

Response timeouts.  You have the option to wait or hold the document. If you choose to 
hold, you must call the processing company to determine whether the transaction has been 
approved or declined. 

If for some reason the swipe device is not working, the CPC is offline or the Voice 
Authorization flag in the Credit Card Control F/M is set to Y, the person entering the credit 
card transaction will need to call the processing company and enter the provided 
authorization code. 

At the end of the transaction, FACTS checks to see if you are signed on to a cash drawer. If 
not it asks you to do so. Press F2 to search. 
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Run the Process Pending Transactions (SOU610) program.  

If the CPC accepts all transactions, the system tells you the "Batch Processing of Pending 
Transactions Is Complete," and you can press Enter to return to the Invoices menu. 

If a transaction in the batch is declined, it must be resolved (e.g. with another method of 
payment), and the Process Pending Transactions program must be run again. 

As with single credit card transactions, recognition and response timeouts sometimes occur. 
If you get a recognition timeout, you can wait or press F3 to stop processing. 

If you are faced with a response timeout, you can either wait or abort the process. Be 
advised that when you abort the process, you will need to call your processing company and 
verify which transactions they received. Those they did not receive will have to be settled 
through the ICVERIFY/PayflowPro software.  

Credit Card Processing with CenPOS 

The FACTS interface with CenPOS only requires Internet Explorer to be installed on the 
user’s system; no other installation is necessary.  All of the CenPOS interface is managed 
through CenPOS and is displayed in an Internet Explorer window. The TCP/IP Manager is 
not used for the CenPOS integration. 

Process Pending Transactions  

(Communications down) 

To process credit card payments offline requires storing credit card numbers on the system. 
Since the goal is to eliminate the storing of credit card information, offline transactions are 
not supported at this time.  The Process Pending Transactions (SOU610) program does not 
process transactions for CenPOS. 

Refer to the Electronic Payments Guide for more information about the FACTS setup and 
use for credit card processors.  Refer to www.icverify.com, www.PayPal.com, or 
www.cenpos.com for more information about using each credit card processor. 
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Order Entry Management Suite  
This is a group of programs comprised of  

Order Entry  

Service Order Entry  

Order Confirmation  

Direct Invoice Entry  

Credit Memo Entry  

Counter Sale Entry  

All of the programs in the suite use a similar layout and share many of the same functions. 
You can access any of the programs in the suite from the Go To menu.  

Use the SO Entry Options F/M to customize the header, line-item entry and footer sections of 
these programs. 

Order Entry Header Processing 

The upper portion of the screen is called the header portion where you enter the customer 
placing the order, the customer’s ship-to address, and other general information required to 
process the order. Refer to the following procedures for more information about Order Entry 
header processing: 

Enter a new document 

Delete a document 

Open an existing document 

Create a document number 

Line Item Processing 

The lower portion is called the line item portion where you add items, quantity and pricing 
information to the sales order. The program automatically switches to add mode once you 
complete the header. This means the cursor appears in the Item Number field after you exit 
the last header field. You can use the line item browser to view items that you have already 
entered, select items so you can edit them and organize items so they appear in a certain 
order on the pick ticket. Use the mouse or arrow keys to choose add from the item browser, 
or select Edit>Add Line from the menu. Refer to the following procedures for more 
information about Order Entry item processing: 

Add a line 

Edit a line item 

Delete a line item 

Insert a line item 
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Find a line item 

From the buttons in the lower portion of the screen, you can access the Deposit/Payment 
Entry screen (via the Deposits button) to enter customer deposits or payments on SO 
documents, the Header Detail window (via the Header button) to access sales order header 
information, and the Line Detail (via the Line Detail button) to access items details for 
selected sales order lines. 

Order Entry Footer Processing 

The ending routine consists of final fields prior to completion of the sales order. The ending 
routine is not accessible if you have not entered line items for the order. At the end of the 
footer routine, the new total represents the total amount of the order. Refer to the Order 
Entry Footer Information topic for field descriptions. 

Ship Complete Feature Overview 
Ship Complete is a warehouse- and line-level designation that has one of three values: 

Yes: The shipped quantity must equal (or be greater than) the ordered quantity. No partial 
shipment is allowed. Ship complete for the warehouse designation means all lines must ship 
complete, and the line level ship complete is not considered. Ship complete for the line 
means that the quantity ordered must be the same as the quantity shipped on that line. 

No: The shipped quantity may be less than the ordered quantity. 

Balance Complete: The initial shipped quantity may be less than the ordered quantity, but 
the backordered quantities must be shipped complete. Balance complete for the warehouse 
designation means all lines can ship partial on the first shipment, and the line level ship 
complete is not considered. Once a warehouse is processed through the DSR, it is changed 
to ship complete. Balance complete for the line means that the quantity shipped may be less 
than the quantity ordered on the first shipment. Once the line is processed through the DSR, 
it is changed to ship complete.               

Shipping Eligibility of an Order  

If an order or line is "eligible to ship", that means the order has met the requirements to ship 
according to the ship complete setting and the amount of committed stock on the order. 
Balance complete on both the warehouse and line level will behave like a partial shipment 
when considering if the order is eligible to ship. If items are shipping from a warehouse that 
is set to require approval, those items must have an approved status in addition to being fully 
committed in order to be considered eligible to ship. 

Ship Complete in a Multiple Warehouse Environment:  In a multiple warehouse environment, 
warehouse-level ship complete applies to each warehouse individually. However, if the 
initiating warehouse is set to print consolidated pick ticket only, all warehouses will be 
evaluated together to determine if the order is eligible to ship. 

The Ship Complete setting on SO Entry Options F/M (SOF915) determines which Order 
Entry programs use the Ship Complete feature. Based on your systems settings in SO Entry 
Options F/M, all of the Sales Order entry programs (except Credit Memo Entry (SOE330)) 
contain a Ship Complete field on the detail screens but only the pick ticket is affected by this 
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setting. It is available through other Sales Order Entry programs because order processing 
from them can in certain instances create a pick ticket. For example when you backorder a 
direct invoice you can create a pick ticket. Blanket orders and recurring documents also 
ultimately create a pick ticket. The Ship Complete setting from Blanket Sales Order Entry 
(SOE710), Quote Entry (SOE110), and Recurring Document Entry (SOE350) default to the 
order and is for all warehouses. Once the order is created this setting is modifiable like any 
other order. . 

The Ship Complete field also resides in Customer F/M (ARF910) on the Invoicing tab. It is 
used as the initial default when orders or quotes are created for a customer. When a new 
customer is added by using the F1-Add feature in the Sales Order entry programs, the ship 
complete setting is loaded with the default values used when adding a new customer in 
Customer F/M. If the fields need to be changed, it must be done in Customer F/M.  

The Additional Info tab of Ship-To F/M (ARF920) also contains a Ship Complete field. When 
a new ship-to record is added, these value defaults from the customer record. 

Order Processing  

When lines are added to an order, the line ship complete value always default to "N". 

If a warehouse ship complete setting is changed and there are lines on the order shipping 
from that warehouse, changes will take place as follows: 

If you change the ship complete setting from "N" to "Y" or "B" 

The system displays the message "The Ship complete setting for all lines shipping from 
warehouse XX will be cleared. OK / Cancel".   

If you select Cancels, no change is made and the system returns you to the Ship Complete 
field. 

If you select OK, the ship complete setting on all lines for the selected warehouse is changed 
to "N". Since the line ship complete flag is not considered when a "header or warehouse" is 
ship complete or balance complete, changing the flags to "N" sets them to the proper default 
value. 

If all lines were already set to "N", no prompting nor changes are done to the lines. 

If you change the ship-to value: 

If there are no lines on the order shipping from the initiating warehouse, the warehouse ship 
complete flag is changed to the ship-to’s ship complete flag. No user prompt occurs. 

If the ship-to’s ship complete setting is different from the initiating warehouse’s ship complete 
setting, the system displays the message "Change the initiating warehouse ship complete of 
XXX to the ship-to ship complete of XXX? Yes/No". 

If you select "No", the initiating warehouse ship complete remains unchanged. 

If you select "Yes", the system performs the same steps as above that deal with the change 
to ship complete. The only difference is that if you received the message that the line setting 
will be cleared, you will not have the Cancel option. The system will have already displayed 
messages that allow you to cancel from this process. The system displays informational 
messages only and changes the ship complete settings as necessary. 
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If you change the ship-to value to "SAME" or "TEMP" all of the above processing still applies, 
but the values come from the customer record instead of the ship-to record. 

If the ship complete is changed for the initiating warehouse, the system determines if the 
warehouse pick ticket has already been printed but is not in the reprint file already and 
prompts you to add changed warehouse to the reprint file (similar to when a line is edited). 

Customer Credit Check Processing 
The Customer Credit Check Processing program performs all the calculations and gives the 
appropriate messages for customer credit check. This routine is called from various entry 
programs and only the results are returned. 

The system performs a customer credit check for each customer during Sales Order entry 
programs based on the Credit Limit value and the number of Credit Check Days entered on 
the Accounting tab of Customer F/M.  If the customer fails the credit check a message 
appears. No action is taken by the system unless a password is required. The system rejects 
the customer if a valid password is not supplied. 

The credit hold option for a customer is based on the Credit Check prompt on the Accounting 
view of Customer F/M.  If the Credit Check prompt is set to "Message", "Refuse", "Hold", or 
"Password", a message displays if the customer fails the credit check.  The current balance 
figure used for processing comes from the customer’s existing balance in AR Customer F/M. 
The password for the credit check override resides in the AR Static Control F/M. 

Adding Customers On-the-Fly 

To add a new customer during order entry, you can access the Quick Customer Add dialog 
box.When a new customer is added by using this feature in the order entry programs, the 
customer credit check field value is loaded from the default in the AR Static Control record. 
You cannot enter credit check information this screen. If you need to modify the customer 
credit information, access AR Customer F/M. 

Disputed Invoice Details 

For Quote Entry, Sales Order Entry, Direct Invoice Entry, Counter Sale Entry, Credit Memo 
Entry, Customer Returns Entry and Blanket Sales Order Release Register and Post 
Recurring Documents, the credit check routine also checks the Disputed Invoice setting in 
AR Document Change F/M for each open AR document record. If it finds a disputed invoice 
record, the credit check processing checks the invoice’s Exclude from Credit Check setting in 
AR Document Change F/M to determine if the disputed invoice is to be considered in the 
credit check past due processing. Documents marked as excluded from credit checking are 
skipped from the total amount past due. All invoices total into the customer’s balance and 
aging figures. Any disputed invoices that are excluded from the credit check are accumulated 
into a new total. The check for over credit limit is calculated as the customer’s balance minus 
disputed invoices not to be included plus document totals. Then, if the customer is past due, 
the excluded total displays on the optional Customer Aging window that displays in AR 
Invoice Entry and Sales Orders Entry programs: Quote Entry, Sales Order Entry, Direct 
Invoice Entry, Counter Sale Entry, Credit Memo Entry, Customer Returns Entry, and Blanket 
Sales Order Release Register and Post Recurring Documents. 
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Customer Aging Window 

The optional Customer Aging window displays in AR Invoice Entry and Sales Orders Entry 
programs: Quote Entry, Sales Order Entry, Direct Invoice Entry, Counter Sale Entry, Credit 
Memo Entry, Customer Returns Entry, and Blanket Sales Order Release Register and Post 
Recurring Documents   

Customer aging information includes the customer number, credit limit, aging as of date, 
balances for aging columns set in AR Aging Control F/M, balance, aging open documents 
totals, amount excluded from credit check processing and a "Disputed Invoices’ indicator 
(based on the Disputed Invoice setting in AR Document Change F/M. 

Automatic and Quoted Freight Processing Details 
In Order Entry, Confirmation Entry and Direct Invoice Entry, FACTS provides automatic 
freight calculations using freight schedules or quoted freight, based on control settings in 
Ship Via F/M, AR Customer Maintenance and SO Static Control F/M (SOF980). Blanket 
sales orders allow for multiple shipping warehouses but have no freight amount field. When 
blanket sales orders are released, the system sets the document freight method from the 
customer record. 

If the default Freight Method is Quoted: 

If "Default Quoted Freight with Calculated Freight in Order Entry" is set to "No" on the SO 
Static Control F/M Freight tab, then FACTS sets the order quoted freight field to zero. 

If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static Control 
F/M Freight tab, is to "Yes", then freight is calculated for each shipping warehouse and 
displayed in the quoted freight field. 

If the default Freight Method is calculated: 

 If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static Control 
F/M Freight tab, is to "Yes", the freight will be calculated for each shipping warehouse and 
stored in the SOFRWH records. 

If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static Control 
F/M Freight tab, is to "No", then the freight in each SOFRWH record is set to zero. 

Entering Lost Sales 
Use the Lost Sales Entry (SOC320) program to track lost sales on items and update usage. 
Lost Sales functionality is only available if the Lost Sales checkbox is selected on the Use 
Features tab of SO Static Control F/M (SOF930).  

Accessing Lost Sale Entry (SOC320)  

You can access this program three ways: 

The Order Entry Quote Entry, Direct Invoice Entry, Counter Sale Entry, Confirmation Entry, 
Purchase Order Entry, and Contract Item Entry programs have a menu option to access Lost 
Sales Entry if the Lost Sales checkbox is selected on the Use Features tab of SO Static 
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Control F/M (SOF930).  You can right-click to access Lost Sale Entry from the same entry 
screens listed above except , providing you have the proper security and the system has 
Lost Sale ability enables in SO Static Control F/M.  The Lost Sale Entry option can be 
triggered automatically. If you reset the ordered quantity from the original order quantity 
entered, but the shipped, backordered and committed quantities do not equal the new order 
quantity. The program prompts you to indicate whether to post the difference (original order 
quantity minus new reset order quantity) to lost sales. Select R-Review to display the Lost 
Sales Entry (SOC320) screen and modify the lost date, update usage, quantity, price, cost, 
reason, and/or notes. Note that you must have the proper security code clearance as 
entered for SO Static Control F/M (SOF930) to select the R-Review option and display this 
program. If a password is required for SO Static Control F/M (SOF930) then the password 
prompt will display before allowing you to continue. If you select Cancel on the Password 
prompt, a lost sale will automatically be recorded.  

When Lost Sales Entry (SOC320) is displayed, you can modify the lost date, update usage, 
quantity, price, cost, reason, notes fields and indicate whether to update usage for this lost 
sale entry.  Use the Skip button to not record the lost sale.  Save records the lost sale.  The 
“lost sale reason code” value set in SO Static Control F/M displays as the default.  Reason 
codes are created and maintained in the Lost Sales F/M (Sales Orders>File 
Maintenances>Lost Sales Reason Code F/M). 
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Chapter 2 Sales Orders Work Flow & 
Program Concepts 2 

 

 

Quotes Work Flow and Program Concepts 
Use this subsystem to enter, correct, print and remove quotes in the system. You can also 
automatically convert a quote into a sale (work order). 

You can access the following programs from the Quote Entry menu: 

Quote Entry is used to enter and modify quotes. This program is similar to other entry 
programs in the Sales Orders module, but it is not part of the Sales Order Entry Suite. 

Quote Print is used to print or reprint quotes. If you need to modify or correct a quote, return 
to the Quote Entry program. 

Quote Removal is used to remove sold and expired quotes. 

Operating Tips and Suggestions 

When you enter quotes, you enter a customer number, and the system assigns the quote 
date (usually the system date) and expiration date, both of which can be changed later if 
necessary. The entry screen provides fields in which you can enter name of the person who 
gave the quote and the person who is receiving the quote. 

The system also allows you to create quotes for companies or individuals that are not 
existing customers. Before you convert these quotes to a sales order, you must create a 
temporary customer in Customer F/M. 

Items entered on quotes are not committed in the warehouse, but the Quote Entry program 
lets you see the availability of those items. 

Quote Entry also supports the FACTS multiple warehouse feature. If your company has 
several locations with their own inventory, this feature allows you to enter items from other 
warehouses if your default warehouse is out of stock. 

The system also allows you to create quotes for companies or individuals that are not 
existing customers. Before you convert these quotes to sales orders, you must create a 
temporary customer in Customer F/M. 

Quote status is also available to track Win/Loss information. Quotes status options are: 
Accepted/Declined/Partially Converted/Expired/Open. The date the quote was accepted or 
declined, and the reason declined also display on the Header screen. The Reason Declined 
field is validated against standard Lost Sale Reason Codes in FACTS. 
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As with the other Sales Order Entry programs, Quote Entry displays all pricing but allows you 
to override that pricing if necessary. If multiple units of measure for pricing or selling are 
available for an item, you can also change the unit of measure while entering a quote. 
Quotes may also include discounts, tax and freight. 

Once you finish entering a quote, the program gives you several options: print the quote 
immediately, save it for batch printing or convert it to a sale (providing that the customer, or 
at least a temporary customer, is valid in the system). 

At that time of entry the quote is assigned an order request date and order number in the 
Sales Orders Document File. If you use the Job Cost subsystem, the system enters a job 
number for the order at this time. Through Order Entry, you can open the document to review 
or change it. 

Quotes can be printed or reprinted through the Quote Print program. If you need to modify or 
correct a quote, return to the Quote Entry program. Quote print parameters are determined in 
the SO Document Print Control F/M. These parameters include the depth of the quote, 
whether the form is preprinted, and the standard memo. 

The system also prints any notes flagged during Quote Entry to print on the quote. Urgent 
document notes print before normal document notes. Memos print before any line notes, and 
line notes print in the order of entry with no special dispensation for urgent notes. 

A quote may be corrected and reprinted as often as needed up until the time it is converted 
to an order. If the quote is not converted at the time of entry, it may be converted at a later 
date through the same ending routine at the end of the entry program (if the customer is 
valid). 

When a quote is converted to a sale, it stays in the Quote File as a sold quote. They may be 
left on file so they can be printed through the Quote Listing. Since this file eventually fills up, 
make sure you run Quote Removal periodically to remove the quotes that you no longer 
need to keep on file. Sold and expired quotes may be removed by their type (expired, sold) 
and the expiration date (cutoff date). 

Orders Subsystem Work Flow and Program Concepts 
Programs on the Orders menu enable you to enter, correct, place on hold and print orders in 
the system. 

The Orders menu contains these programs: 

Use Order Entry to enter new sales orders, or review and edit existing sales orders. A sales 
order effectively commits quantities of items for a customer and produces a pick ticket, which 
warehouse personnel use to fill the order. The Order Entry screen is divided into three 
sections: the header portion where you enter the customer placing the order and other 
general information required to process the order, the line item portion where you add items, 
quantity and pricing information, and the footer window where you enter final fields prior to 
completion of the sales order. 

Pick Ticket Print is used to print and reprint orders through in this program. You can correct 
and reprint pick tickets (or printed orders) as often as needed until you confirm the order and 
convert it to an invoice. If an order includes shipments from multiple warehouses, you can 
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set the system to print pick tickets in the initiating, shipping or both warehouses. You also 
can access this program from the Order Entry footer. From there, you can print pick tickets 
on an order-by-order basis. 

The pick ticket includes all pertinent header and line item information, total package weight 
and a quantity shipped column. If the Use routes flag is selected in SO Static Control, the 
route will print on the pick ticket under the date. If the pick ticket was created from a Blanket 
Sales Order, the Blanket Sales Order document number will print in the description column 
before the line item or items. 

Bill of Lading Print is used to print bills of lading for orders (BOLs) on demand, past invoices 
or warehouse transfer tickets. The BOL must comply with the rules determined by the DOT 
for transporting hazardous materials. For more information on hazardous materials and 
regulations, please refer to the DOT’s Hazardous Materials Guide. 

BOL print properties are determined in the SO Document Print Control F/M, including 
whether the form is preprinted, whether to print hazardous materials only, and whether to 
print item weights. If you are printing BOLs for sales orders, transfer tickets or current 
invoices, all BOLs that are ready to print will do so through this program. If you are printing 
BOLs for past invoices, you have to specify which past invoice that you want to print. 

Use Order Review to display, place or release documents from credit or service hold. 
Documents may be displayed by warehouse, order type, order status, origin, priority, request 
date and outside salesperson. If an order is placed on hold, it cannot be confirmed, and 
therefore will not be updated by the Daily Sales Register (DSR). However, if an invoice is 
placed on hold, it will be updated by the DSR and the resulting backorder document, if any, 
will be placed on hold. 

Documents can be placed on hold through this program or during entry if the Credit Check 
flag in the Accounts Receivable Static Control is set to H-hold. The Order Review program 
displays the document number, origin, on hold status, customer number and name, 
warehouse, date entered, total of the document and the terms code. 

Commit Backordered Quantities is used to update the backordered quantities on sales 
orders, warehouse transfers and backorders to committed quantities and to provide a report 
of what is updated. The report prints as the update occurs. You can select whether to include 
sales orders only, transfers only or both when the report is run. You also have the option to 
print the transfer tickets for the transfers that had backordered quantities committed. 

As orders and invoices are entered, some line-items have backordered amounts, usually 
because a customer ordered an amount greater than the quantity available. In time, another 
shipment of the backordered item arrives at the user’s company. Some of this new stock 
may be partially committed from special orders that were imported to create purchase 
orders; however, the rest of the quantity is available. Since the quantity is available, it can 
once again be committed by new orders and invoices, leaving none left over to fill 
backorders. 

To avoid leaving backordered quantities on permanent backorder, the system allows the 
user to run this program. This program checks orders and backorders for backordered 
amounts. The program does not check invoices, printed or confirmed orders, quotes, counter 
sales, etc. Sales orders and backorders for customers on hold are not checked for 
backordered amounts. If the program finds backordered amounts, it then looks to see if the 
item has any quantity that is available. If there is enough of the item available to fill the entire 
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backorder quantity and leave at least one in stock, the system automatically commits the 
quantity and sets the backordered amount to zero. For serial or lot number items, the system 
does not commit the backordered amounts if the OE Serial/Lot Number Entry flag in the 
Sales Orders Static Control Record is set to Y. Report information includes order number, 
order type and status, requested date, warehouse code, customer number and name, item 
number and description, and the amount committed and its corresponding unit of measure. 

Infor™ recommends that you run this program after running the Purchase Order Receipt 
Register, after entering adjustments in inventory control, or after a large amount of line-items 
have been deleted or voided. If there are a large number of orders and invoices in the 
system, this program may take some time to run. 

Item Shipment Approval is used to release lines that are on-hold because the order take did 
not have security rights to the initiating and/or shipping warehouse, on multiple warehouse 
orders. Items can be viewed in item or document order. A password is required for entry. 
However, if the user is the approved user for this shipping warehouse, the password is not 
required. The approval user code and password are set up in Warehouse F/M. This program 
is only accessible if multiple warehouses are used on an order. 

Operating Tips and Suggestions 

How sales orders affect inventory 

As you enter items on an order, FACTS automatically commits those items in the selected 
warehouse. That means that the items are now committed to the customer indicated on the 
sales order. For tighter inventory control, however, you can override the committed amount 
and set the ordered quantity to backordered until the order is confirmed in the warehouse. 

As you enter items, FACTS displays item availability in the selected warehouse. If the items 
are not available at the time they are being ordered, you can tell FACTS to backorder them if 
allowed, and you can tell FACTS to automatically create a suggested purchase order or a 
suggested transfer for the item. If multiple warehouses on an order are allowed, the user 
may be able to order items from another warehouse. If a user does not have rights to order 
items from the initiating or shipping warehouses, FACTS places the line-items on hold. 
Authorized users set in Warehouse Code F/M can release the items with the Item Shipment 
Approval program. 

Pricing flexibility 

FACTS displays all prices available for an item — and the customer — in the Price Options 
window while you are in the Price field during order entry. From the Price field, you can also 
perform a Price Search or you can manually override the price options by simply entering a 
price in the price field. The Order Entry program enables you to select a different pricing unit 
of measure than the ordered unit of measure. 

Printing from Order Entry 

At the end of the entry program the order can be printed immediately or saved in a file for 
batch printing. A printed order is referred to as a print ticket. 

A bill of lading (BOL) for the order can be added and printed later. If the order sends the 
customer over their credit limit, a message may flash on the screen indicating this to the 
user. If the user has set the system to place orders on hold if the customers are over their 
credit limits, the order does not print until the document has been taken off hold. 
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Program Concepts 

Order Entry (SOE210)  

EWMS Processing 

The Order Entry (SOE120) program checks to determine if the order you are modifying has 
been sent to Radio Beacon. If it has, and it has already been waved, you will not be able to 
change the order. If the order has not been waved, the Order Entry program sends a ‘nuke’ 
record to Radio Beacon. This record deletes the order from Radio Beacon. You must reprint 
the order before it can be picked. This program also allows you to reprint sales orders right 
from Order Entry. Select the Hot Ship checkbox to control picking priority in Radio Beacon. 

FACTS/eStorefront Integration Order Processing Notes: 

The eStorefront B2C feature allows users who are unknown to FACTS to place new orders 
and check on the status of open orders. Because these users are not individually in the 
customer master file, the system uses the email address to distinguish users. When orders 
are sent from eStorefront to FACTS Order Entry, there is no indication in the record that this 
order is for a B2C customer. FACTS processing cannot check that the order has credit card 
terms instead of AR terms. It is very important that the eStorefront administrator set up the 
guest account to only allow credit card terms. 

Because the current FACTS/eStorefront integration only supports a single warehouse on an 
order, all B2C orders are processed through one warehouse. The customer record that is set 
up in FACTS to be the B2C customer has an eStorefront warehouse assigned to it. All B2C 
orders then use that customer number and subsequently that warehouse. 

Note that document and line notes for orders entered in eStorefront do not display in FACTS 
Order Entry. 

Additional features 

The Order Entry program supports the following features.  Refer to the FACTS online help 
for details. 

Designating items for direct ship 

Using the Order Entry Menu options 

Using the Price Search 

Using the Past Sales Search 

Changing ship via 

Entering serial/lot items 

Creating BOM items (kitting, on-the-fly) 

Using the Job Costing Entry 

Customizing the main order entry screen 



Orders Subsystem Work Flow and Program Concepts  

26 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

Pick Ticket Print (SOP210) Processing Details 

As document numbers are entered, the system performs processing checks for service hold, 
type, and priority. Orders on service hold do not print a pick. If the order does not match what 
is selected, the system displays a message and removes the document number. 

A pick ticket will not print if there is nothing committed to the order and the SO Static Control 
record parameter for Pick Ticket Quantity is set to C--print committed quantity and 
backordered quantity. 

Templates that store "system date" resolve to the "current system date at the time the report 
is run" rather than what the "current system date" was at the time the template was created. 
For example: If you save a template for the Pick Ticket Print and select "Current Date" for the 
Cutoff Date field, when that template is selected to run again (either manually or via Job 
Stream) the cutoff date is determined using the current date in the Company Periods & 
Ending Dates F/M (GLF970) when the print is run not the current date when the template 
was created. 

Formatting Print Tickets 

Some pick ticket print properties are determined in the SO Document Print Control F/M, 
including depth of the pick ticket, whether the form is preprinted and the standard memo. 

Printing BOM Items 

If an item is a bill of material item and the BOM on Pick Ticket flag is selected in SO Static 
Control, the component items used to produce the BOM item will print on the pick ticket. Pick 
tickets will be printed by all (consolidated) warehouses or by the shipping warehouse, 
depending on what the Pick Ticket Print flag is set to in the IC Warehouse F/M. 

Printing MSDS Information 

If FACTS is set up to use the Material Safety Data Sheet (MSDS) System, the message 
entered in the MSDS Message on Pick Ticket field in the MSDS Control F/M will print below 
the item description for the appropriate MSDS items. If literature locations are used to 
process MSDS sheets, the MSDS Processing flag is set to L and the MSDS by Pick 
Ticket/Invoice flag is set to P, the literature location will print before the MSDS message on 
the same line. 

Printing Multiple Bin Locations on Pick Tickets 

If the Print Alternate Locations on Pick Ticket setting on the SO Static Control F/M is set to 
yes, the Print Pick Ticket program prints a new line after the main item line that includes all 
alternate locations set up for the warehouse/item. If the Print Alternate Locations on Pick 
Ticket setting on the SO Static Control F/M is set to no or there are no alternate locations set 
up, no additional line prints on the pick ticket. 

Direct Shipment Documents 

Note that pick tickets do not print for exclusively direct ship documents. The presence of a 
direct ship line on a sales order will not cause a pick ticket to print that otherwise would not. 
Meaning, if the Direct Ship on Pick setting on the Main view of Warehouse F/M (ICF970) is 
turned off and the pick does not print then it will not print with the setting on. Direct ship lines 
can print as additional lines on a pick ticket but are not considered by the system when 
determining if there is a pick to print. You can add a leading memo to the order to cause the 
pick ticket to print. 
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Sales Order Notes 

The system also prints any notes flagged during SO Entry to print on the pick ticket. Urgent 
document notes print before normal document notes. Memos print before any line notes, and 
line notes print in the order of entry with no special dispensation for urgent notes. 

Ordered By Information 

Based on the value of Print Ordered By prompt on the Pick Ticket tab of Document Print 
Control F/M (SOF950) and if the ordered by field is not blank, the pick ticket includes 
"Ordered by xxxxx" in the line region on the first page only after the order priority and ship 
complete information but before the blanket order or CRS information. 

Printing Alignments 

 To print an alignment, select Print Options>Print Alignment. 

EWMS Processing Note 

The Pick Ticket Print (SOP210) program creates flat files that are sent to Radio Beacon. 
Select the EWMS checkbox to control whether a flat file needs to be created. 

Blanket Sales Orders Work Flow and Program Concepts 
The Blanket Sales Orders Subsystem (BSO) is an optional feature of the FACTS system. It’s 
located on the Orders menu (Sales Orders>Blanket Sales Orders). Blanket Sales Orders 
provides you with a method of delivering future order merchandise on time to the customer. 
The objective of the BSO sub-module is to provide timely response to customers while 
minimizing internal costs and maximizing internal controls on orders with multiple shipments. 
This flexible module allows unlimited future shipments based on customer needs. 

Blanket Sales Orders provides the ability to accept and handle orders where the customer 
requires fulfillment with multiple shipments at specified future ship dates. For example, a 
customer wants to receive 1,000 gallons of paint over the next five months, in five equal 
shipments, with delivery guaranteed on the first of each month. Simply create the blanket 
sales order, answer a few questions about the release dates and quantities, and the releases 
of all five shipments will be calculated. Individual sales orders will be created for each 
release at the appropriate time based on the customer request dates and the item’s lead-
time. The sales orders generated are then subject to the normal sales order processing. 

You can access the following programs from the Blanket Sales Orders menu: 

Blanket Order Entry is used to create a blanket order that allows release dates to be 
scheduled per line-item. Since releases are by item, the releases of a given blanket order 
may be set up to release all line-items together, or some items on the blanket order may ship 
at different time from other items. 

A blanket order entry consists of three sections: the header, where you enter the customer 
number, expiration date, etc.; the line-item entry, where you enter each item, price, quantity, 
and so on; the requested release dates entry; and the ending routine, also known as the 
footer, in which and the customer’s credit limit can be checked. During entry of a BSO, you 
can change, add, insert, or delete line items at any time, or delete entire unreleased or 
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incomplete BSO documents. Temporary items and catalog items are among the additional 
features available in the Blanket SO Entry Program. 

Inquiries include Interchange, Catalog, Customer Item, and Past Sales. Release requests 
may be made for an individual line item or all line items on a document. A BSO 
Acknowledgment may be printed. 

Blanket Order Acknowledgment (SOP710) is used to print and reprint the blanket order 
acknowledgment, which can be given to the customer as an order confirmation. Blanket 
Order Acknowledgment information includes item number, item descriptions, request dates, 
request status, total order quantity, order quantity per release request, and blanket order 
expiration date. This program uses the invoice parameters in SO Document Print Control 
F/M to control the print formats. 

Blanket Order Inquiry (SOI710) is used to inquire into the status of any open or completed 
blanket order. The inquiry is especially useful for locating orders for a given warehouse, 
customer, or item. The actual document may be displayed in detail through this program. 
The Blanket Order Inquiry program is the Document Inquiry in Blanket Order view. 

You can inquire by document number. Displayed information includes document number, 
type, status, and entry date, customer number and name, ship-to number, document total, 
and designated warehouse salesperson, and order priority. If the View Description 1 option is 
"off", a memo will now display in the Full Description column (at the end of the browser). If 
the View Description 1 option is "on", the memo will now display in the Description column. 

For open blanket orders, document and line notes are available to view or edit, based on 
your user security access. For past documents, notes are only available to view/edit (, based 
on your user security access) from the Invoice view (accessed by the Invoice button) of 
Document Inquiry. 

Documents that are archived in UnForm are available for viewing from literally hundreds of 
programs throughout FACTS. Throughout the Document Inquiry view, look for buttons or 
hyperlinks that refer to Archived Doc, Archived Pick, Archived Inv, Archived BSO to view the 
archived document that contains a line in the inquiry browser. 

Blanket Order Report is used to list release requests on open blanket orders and determine if 
any releases need to be processed. This program provides a report of all orders currently on 
file in the BSO subsystem. This report is designed to track the status of the entire blanket 
document as well as the status of each individual request on the order document. It provides 
the user with information from the blanket document, as well as, information from any related 
sales order document when applicable. 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, header ship complete, order priority, document line number, item 
and description, reason code, disposition code, return quantity, unit of measure, price and 
pricing unit of measure, price extension, line status, document total, and credit memo or 
sales order document number (when applicable), or vendor number, name, vendor return 
document, line number and status (when applicable). This report differs from the Returns 
Analysis Report in that it includes pricing information. 

Blanket Order Removal is used to remove completed BSO documents that do not need to 
remain on the system. This program automatically removes completed BSO documents, 
including notes, based on your entries. This program skips any BSO document tied to an 
active SO document. This program is especially useful for removing large numbers of 
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documents, e.g., all documents for a specific customer, or particular warehouse based upon 
document completion date. 

Blanket Order Release Register is used to determine, for each blanket order, whether the 
next release of each item is called for based on the release basis, the current date, and the 
customer request date of the next release. If the next scheduled release meets all the 
criteria, it will appear on the release register. This program automatically generates sales 
orders and/or purchase orders based on the BSO document release request dates. The 
program cannot process expired documents, documents on hold and locked documents. The 
Blanket Order Release Register processes rush orders before BSO documents with a 
normal or service hold order status. The program steps through the next scheduled request 
for each document line-item, taking the request date, subtracting any additional days 
padding from the line entry and from the header, and subtract either the lead time for the 
item or the number of days from the Sales Order Static Control F/M. For lines flagged for 
immediate release, the system will not release all other requests with the same request date. 

Operating Tips and Suggestions 

The Blanket Order Entry program creates an order similar to an order created through Sales 
Order Entry. However, it also allows release dates to be scheduled per line-item. Since 
releases are by item, the releases of a given blanket order may be set up to release all line-
items together, or some items on the blanket order may ship at different time from other 
items. The system allows great flexibility when scheduling releases. Optionally, an order 
acknowledgment may be printed. 

The Blanket Order Release Register is run on a regular schedule, perhaps daily. This 
program determines, for each blanket order, whether the next release of each item is called 
for based on the release basis, the current date, and the customer request date of the next 
release. If the next scheduled release meets all the criteria, it will appear on the release 
register. When the release register is updated, this release is created as a sales order. 

As the created sales orders are processed, the original blanket sales order is updated so that 
all release history on the blanket sales order is available. The Daily Sales Register updates 
blanket sales order information as blanket-generated sales orders are updated. Blanket 
order processing is complete when the last release of the order is processed. 

Release Basis 

The release basis determines when the next release must take place, based on the request 
date. Regardless of the release basis selected, when the system calculates that a release 
should take place, the system will release all items that have the same request date as one 
sales order. 

Longest Lead Time 

Longest lead-time is the longest average lead-time of all the items on the blanket order, 
which have the same request date. To ensure that inventory is available for a requested 
shipment, the system must attempt to commit merchandise based on the longest average 
lead-time for those items. 

Fixed Days 

When fixed number of days is used for the release calculation, sales orders will be created 
this number of days prior to the request date. For example, in order to maintain customer 
service levels, you may always commit goods two weeks prior to the request date. The two 
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weeks allows time to special order, restock or transfer goods into the warehouse. In this 
example, fixed days would be set to 14 days. 

Greater of Longest Lead Time and Fixed Number of Days 

The system looks at the longest lead-time and the fixed number of days, and selects the 
greater of the two to determine when to release the sales order. This is the most common 
method for calculating the release basis. 

Initial Setup Procedures 

The setup required to begin using the Blanket Sales Order program is minimal; however, 
there are several questions that you should consider prior to set up. Your answers to these 
questions will determine how you set up your system controls, in accordance with your 
company’s policies and procedures. 

• Do you want item usage figures to be updated by the BSO subsystem? 

• How do you determine on what date a sales order should be created to ensure that items 
are shipped in a timely fashion? Do you calculate release dates based on item lead-time, by 
a fixed number of days, or by the greater of the two? 

• What is the normal lead-time for the most commonly ordered non-stock items? 

Blanket Order Release Register (SOU720) Program concepts 

Sales Order documents generated from the BSO register adhere to the credit check method 
specified in the AR Customer F/M. The Sales Order document, if placed on hold, is clearly 
marked indicating hold status and a message also displays so that these documents can be 
reviewed prior to updating the release register. For additional credit check processing details, 
such as disputed invoice processing, adding customers on-the-fly, or displaying customer 
aging, refer to the Customer Credit Check topic. 

If the SO Control F/M flag, Allow Serial/Lot Assignment in OE is selected, any line items or 
BOM components that require serial or lot numbers are clearly marked. 

For BOM items for which all components cannot be committed, the maximum amount of 
finished items for which all components can be committed will be calculated, and only those 
that must be backordered will be backordered. 

For Direct Shipped lines, purchase orders will be created using the FACTS standard 
routines. For warehouse ship backordered lines, suggested purchase order(s) will be created 
automatically. 

As Sales Order documents are created, records will be added to the Ready to Print 
(SOOPRX) file for all documents that are not placed on hold. 

The Blanket Sales Release Register recalculates the commission percentage for non-user 
override commissions. 
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Invoices Work Flow and Program Concepts 
The Sales Orders Invoices system allows you to confirm orders, enter direct invoices (which 
do not create work orders), enter credit memos, print invoices and credit memos, and update 
the documents to all the appropriate files in the system through the Daily Sales Register. 

Two additional subsystems are accessible from this menu: Counter Sales and Recurring 
Invoices. 

The Invoices menu contains these programs: 

Order Confirmation (SOE310), is used to tell the rest of the FACTS system what was pulled 
from inventory, what was shipped, what was backordered, what the final freight and handling 
charges were, the amount discounted from the order and how much tax was charged for 
each order. Once you complete the confirmation process, this program converts the order to 
an invoice. The Order Confirmation (SOE310) program does not allow confirming of orders 
that have been sent to Radio Beacon. The upload stock picks program does that for you. 

Direct Invoice Entry (SOE510) is used to correct confirmed orders that have been converted 
to invoices. You can also use it to enter invoices directly in situations where the order has 
already been processed and shipped and needs to be invoiced. The Direct Invoice Entry 
(SOE510) program does not allow changing of shipped quantities on Radio Beacon 
controlled lines. You will be allowed to change pricing and other non Radio Beacon 
controlled fields. 

Credit Memo Entry (SOE330) is used to enter customer credit memos, into the sales orders 
processing cycle edit and delete existing credit memos and refund Counter Sales. 

Invoice & Credit Memo Print (SOP310) is used to print and reprint invoices, as well as and 
credit memos. The printed invoice or credit memo includes all pertinent header and line-item 
information, addresses and totals. Order Confirmation, Direct Invoice Entry, and Credit 
Memo Entry programs also print through this program when you indicate that you want to 
print individual documents. Invoice numbers (not to be confused with document numbers) 
are assigned just before each document is printed. Invoice numbers are not affected by 
reprinting. If the invoice was created from a Blanket Sales Order, the Blanket Sales Order 
document number will print in the description column before the line-item(s). Use the SO Bill 
of Lading Print program to print a bill of lading for an invoice. 

Route Release (SOU310) is used to release invoices tied to specific routes so that the 
invoices print on the Daily Sales Register. This program is not available if the Use Routes 
flag in the SO Static Control F/M is not selected. 

Process Pending Transactions (SOU610) is used to enables ICVERIFY users to carry out 
credit card transactions in those cases where the Transmit to ICVERIFY flag in SO Static 
Control F/M has to be set to N for a period of time. When this occurs, credit card processing 
is considered to be off-line. When processing is off-line, transactions must be cleared 
through this program before you can run the Daily Sales Register (DSR). 

Daily Sales Register (SOR310) is used to Print a daily sales register of all confirmed orders, 
invoices, credit memos and counter sale slips, build and print a general ledger distribution, if 
needed, post to accounts receivable and if the GL distribution is built, to general ledger 
according to the sales information, and update inventory, sales orders, and the Sales 
Analysis Holding File according to the sales information. 
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Operating Tips and Suggestions 

Order Confirmation 

Orders entered through the Order Entry Program are confirmed (or invoiced) through the 
Order Confirmation Program. In other words when the order is shipped, and ready to be 
billed, the order may be converted into an invoice. In the Order Confirmation program, the 
user enters the order number and the order is displayed in its entirety. If multiple warehouses 
are on the order, the user has the choice of which warehouse(s) to confirm. The program 
asks what to do with the committed quantities on the order (backorder, confirm shipment, 
etc.). The user then has to confirm the invoice date, ship date, etc. At the end of the 
program, the user may enter the off invoice discount, tax and freight (if applicable). Once the 
order is confirmed it is now considered an invoice and may be corrected through the Direct 
Invoice Entry Program. The invoice may be printed at the time of confirmation or printed 
through the Invoice and Credit Memo Print Program. 

Order Confirmation Processing Notes 

A sales order can be confirmed even if it has not yet been printed from either the Order Entry 
or Pick Ticket Print programs. 

You can open a partially confirmed order to complete the confirmation process as long as 
you did not print an invoice. If you print an invoice before the whole document is confirmed, 
you must confirm the rest of the document after the next Daily Sales Register run. 

The program only accepts sales order type document numbers. If you enter a document 
number related to blanket sales order, direct or recurring invoice, service order or counter 
sale, the system prompts you to select a document to confirm. 

You cannot confirm an order that is already fully confirmed, nor can you confirm an order that 
has been deleted. 

You cannot confirm an order that is on service hold. 

Order Confirmation checks to determine if the order is ready to be shipped. If it is not, the 
system displays a message indicating this and prompts you to confirm the sales order 
anyway. If you select not to confirm, the system returns you to document number prompt. 
Refer to the Ship Complete Feature Overview topic for details. 

Once a document is fully confirmed, changes must be made through the Direct Invoice Entry 
program (Sales Orders>Invoices>Direct Invoice Entry). 

Over Commitment of serial/lot items: If the OE Serial/Lot# Entry flag in SO Static Control is 
set to "M" or "N" then you can under commit serial/lot items. Refer to the Over Commitment 
of Serial/Lot Items topic. 

Confirming Orders with Multiple Warehouses 

If the document has lines shipping from multiple warehouses, the system prompts you to 
select which warehouses to confirm. After you select warehouses, the system checks for 
shipment eligibility for each of the selected warehouses individually. If any warehouse does 
not meet requirements for shipping, the system displays one message listing all ineligible 
warehouses with the option to confirm anyway. If the pick ticket prints consolidated and all 
warehouses are selected, the system evaluates all warehouses individually and all 
warehouses are ineligible to ship, the system displays a message indicating all warehouses 
are ineligible. If you select individual warehouses to confirm, each will be evaluated 
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separately and any that are not eligible to ship display in one message listing all the 
warehouses. 

Access this program by choosing Sales Orders>Invoices>Order Confirmation. 

Direct Invoice Entry 

To enter invoices directly into the system (i.e., without processing an order), use the Direct 
Invoice Program. This program is similar to Order Confirmation except that the invoice must 
be entered in its entirety, indicating that the items ordered were shipped or backordered; on 
hand quantities are reduced immediately by the quantity shipped. If multiple warehouses on 
an order are allowed, the user may enter items from different warehouses on the same 
invoice. At the end of the program, the user may enter the discount, tax and freight, (if 
applicable). The invoice may be printed at the time of entry or added to the Reprint File for 
batch printing. 

Credit Memo Entry 

Credit memos are entered through the Credit Memo Entry Program. Because it is a credit 
memo program, there is no need to enter negative (-) numbers. The system automatically 
inserts negative signs. At each line-item the user must indicate whether the credit is a return 
or allowance. A return indicates to the system that the item has been returned and inventory 
has increased immediately. An allowance indicates the credit memo is issued but no items 
are returned. If multiple warehouses on an order are allowed, the user may enter line-items 
from different warehouses on the same credit memo. The discount, tax and freight may also 
be credited (if applicable). The credit memo may be printed at the time of entry or added to 
the Reprint File for batch printing. 

Printing MSDS Information:  If the Print MSDS Literature Location flag in the MSDS Control 
F/M (SOF985) is set to I, this program will print the MSDS literature locations or print the 
message "MSDS included" on the invoice for items that require an MSDS. 

Be sure to include partially completed orders that have been zeroed out and orders with only 
backordered amounts. Even though the system does not print invoices for these orders 
(since there is no amount due), they must be run through this program so that the Daily 
Sales Register can process them. 

Setting invoice and credit memo print parameters:  Some invoice and credit memo 
parameters are determined in the Sales Orders Document Print Control Record including 
depth of the invoice/credit memo, whether the form is preprinted, and the standard memo. 

Printing Ordered By Information:  Based on the value of Print Ordered By prompt on the 
Invoices or Credit Memo tabs of Document Print Control F/M (SOF950) and if and the 
ordered by field is not blank, the invoice or credit memo includes "Ordered by xxxxx" in the 
line region on the first page only. 

Printing BOM items on invoices and credit memos:  Make sure the BOM on Invoice flag 
is set to Y in the Static Control F/M. The component items used to produce the BOM item 
print on the invoices and credit memos when this flag is selected. 

Direct Invoice and Credit Memo Notes 

The system also prints any notes flagged during Direct Invoice Entry or Credit Memo Entry to 
print on invoices and credit memos. Urgent document notes print before normal document 
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notes. Memos print before any line notes, and line notes print in the order of entry with no 
special dispensation for urgent notes. 

Freight 

When you sort the invoices by shipping warehouse, a line prints with warehouse, ship via 
and freight charges before the line’s shipping for each warehouse. If the document freight 
method is quoted, the freight charges do not print on this line. The total freight charges 
continue to print at the bottom of the invoice. 

Route Release 

If routes are used, each customer may be assigned to a route. The route is then entered for 
each quote, order or invoice entered, defaulting to the route assigned to the customer. 
Orders and invoices can be printed according to specific routes. These orders or invoices are 
then usually sent out on the delivery truck by route when the goods are being delivered. 
These invoices are not printed on the Daily Sales Register (i.e., posted to the Accounts 
Receivable Open Receivables File) until the route has been approved and subsequently 
released. 

For example, on Tuesday a truck goes out with TUE route invoices. When the Daily Sales 
Register is printed on Tuesday, TUE invoices do not appear because the Route Release 
Program has not been run for route TUE. This is because the TUE invoices are still on the 
delivery truck and some merchandise might have been refused, i.e., some corrections may 
have to be made to the TUE invoices before updating them to accounts receivable. Only 
after the truck has returned with the invoice slips and the corrections have been made to 
these invoices should the TUE route be released. After the route has been released, the 
Tuesday invoices will print on the next Daily Sales Register to post to accounts receivable. 

Daily Sales Register 

Use the Daily Sales Register to print a report of all confirmed orders, invoices, credit memos 
and counter sale slips. You can also print a general ledger distribution and update the 
system with the transactions that appear on the report. 

Use the Daily Sales Register (DSR) program to: 

• Print a daily sales register of all confirmed orders, invoices, credit memos and 
counter sale slips. 

• Build and print a general ledger distribution, if needed. 
• Post to accounts receivable and if the GL distribution is built, to general ledger 

according to the sales information. 
• Update inventory, sales orders, and the Sales Analysis Holding File according to the 

sales information. 
• Update warehouse and order line Balance Complete status to Ship Complete. 
• Print summary or detail information. 
• Copy document notes to past invoice notes and delete notes when documents are 

deleted or lines are complete. 

Summary information includes invoice number, date, terms code, initiating warehouse, 
salesperson/territory, department, document number, customer number and name, sales 
cost, margin, tax, freight, discount and total. 
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Detail information includes summary information plus, for each line-item, line number, item 
number, description, quantity, selling unit of measure, shipping warehouse, cost, costing unit 
of measure, price, pricing unit of measure, extension, margin, item class, taxable flag, 
miscellaneous sales flag, Temporary flag, return or allowance flag, GL table flag and 
commission percent. 

Usage: The Daily Sales Register Update assigns usage to the ship warehouse only if the 
Replenish flag on the Main view of Warehouse/Item F/M (ICF920) is set to Y. If this 
Replenish setting is not Y, then program does not update the ship warehouse’s usage. As 
the program reads each line item, the update ship usage flag is set to true. Then, if the ship 
warehouse and initiating warehouse are not the same, the system reads the ICWHSE record 
for the initiating warehouse. If there is no record or the replenishment flag is not Yes, the 
update ship usage flag will remain unchanged. If the Replenish flag on the Main view of 
Warehouse/Item F/M (ICF920) is Yes, then the update ship usage flag will be changed to No 
indicating that the initiating warehouse usage is to be updated and not the ship warehouse 
usage. If the update ship usage flag remains unchanged (true) or Yes, then the program 
checks the Replenish flag for the shipping warehouse. If it is Yes, the usage is updated. If it 
is not Yes, then the ship warehouse usage is not updated. 

Subtotals are included for cash and AR totals. Register totals include the total number of 
invoices and the average invoice amount along with the total sales, cost, margin, tax, freight 
and overall total. 

The DSR prints recaps by terminal, warehouse, salesperson and terms code if configured to 
do so in the SO Static Control F/M. If the DSR Recap MTD flag is set to Y in the SO Static 
Control Record, information in the Sales Register Recap F/M program is used to print the 
Period Sales Register and the period-to-date information on the Daily Sales Register. For 
remote orders (R-Origin), the DSR shows a section for "Origin" with breakouts for "Remote", 
"Non-Remote", and "Web" order details. 

The DSR prints an asterisk beside the document number (as indicated in the legend) if the 
document was edited after the invoice was printed. If printing the DSR in summary, no 
additional information will be printed. If printing in detail, each individual occurrence of a 
change will be printed, including the user code, terminal ID, date and time. 

Additionally, the DSR also indicates the user code, terminal ID, date and time for each 
deleted document. 

You can elect to build a general ledger distribution, according to one of three formats, or skip 
the distribution altogether. The GL distribution information includes GL account number, 
description, customer number, name, ship-to number, invoice number and the amount to be 
debited or credited. 

The Daily Sales Register updates: 

• Accounts Receivable - Customer Balances, Sales History, Open Receivables File and 
Sales Tax File. 

• Sales Analysis - uses the API toolkit to publish the invoices via XML. If multiple warehouses 
are being used, credit for sales for shipping warehouses will be based on the Shipping 
Warehouse Sale Percent flag in the IC Warehouse F/M. 

• Sales Orders - Monthly (period) Sales Register, Past Sales History File and past invoice 
information. Backorders are also updated for any orders that were not shipped in full. 
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Over Commitment of serial/lot items: The over-commitment of serial/lot items is not 
allowed in Order Entry and Confirmation Entry. If the OE Serial/Lot# Entry flag in SO Static 
Control is set to "M" or "N" then you can under commit serial/lot items. In the Daily Sales 
Register, if the Serial/Lot shipped amount doesn't match the order's shipped amount the 
system now displays a message and return to the menu and no longer displays an error 40. 
The system also displays a message if the Serial/Lot committed amount is greater than the 
order's committed amount and returns to the menu. Refer to the Over Commitment of 
Serial/Lot Items topic for more information. 

Invoice Processing for Overpayments or Remaining Deposits 

You cannot exit an invoice without indicating what is to be done with any overpayment or 
remaining deposit. Overpayments or remaining deposits can be applied on account, 
refunded, transferred to another document, and so forth. If the invoice print process detects 
an overpayment remaining on an invoice, "deposit held" or "applied on account "prints on the 
invoice, based on processing in the Daily Sales Register (SOR310) program. If the Daily 
Sales Register (SOR310) processing detects an overpayment, it will determine whether 
there will be a backorder generated for this document. If there is a backorder, the 
overpayment will be converted to a deposit on the document. If no backorder will be created, 
the overpayment will be applied on account. If the Daily Sales Register (SOR310) detects a 
deposit remaining on a completed document, the deposit will be applied on account. 
Payments applied on account from Sales Orders, via the Daily Sales Register (SOR310), 
now update the last payment date in the customer master record. 

• Inventory Control - sales history (in the Item File and also in the Warehouse File). 

• General Ledger - journal entry. 

• System Management - Bank Transaction system for cash type terms codes (C,1-4) that 
have the cash GL# set to "BANK". 

EWMS Processing Note 

The Daily Sales Register (SOR310) program removes records from the sales order 
companion file and write them to the past invoice companion file. It also clears the ledger 
files that hold the "XC" records sent back from Radio Beacon. 

FACTS/eStorefront Integration Order Processing Notes: 

When the invoice information is being written to SOPINA, for web orders the customer name 
and address will come from SORSOA instead of ARCUST. The email address will also be 
written to SOPINA data table. 

Automatic and Quoted Freight Processing Details 

In Order Entry, Confirmation Entry and Direct Invoice Entry, FACTS provides automatic 
freight calculations using freight schedules or quoted freight, based on control settings in 
Ship Via F/M, AR Customer Maintenance and SO Static Control F/M (SOF980 ). 

The document freight method cannot be changed once the document has been run through 
the Daily Sales Register. 

Note: Quoted freight is on the header of the order not on the warehouse level. If not all of the 
items from an order ship, the backorder’s quoted freight will reflect the amount of the freight 
originally quoted minus the amount that was billed on the first invoice. 
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Freight Method 

• If freight method is quoted 

The system adds Invoice Billed Freight Amount adds into Previously Billed Freight Amount 
and the Invoice Calculated Freight Amount into Previously Calculated Freight Amount in the 
SORSOH record. 

Then, the Order Quoted Freight Amount is reduced by the Invoice Billed Amount and the 
Order Calculated Freight Amount is recalculated based on new order quantity. 

If the SO to GL Posting F/M has freight set to post by ship via, the ship via of the initiating 
warehouse is used to get the GL number. If post by branch is set, this would be the branch of 
the initiating warehouse. Quoted freight does not post by shipping warehouse like calculated 
freight. 

• If freight method is calculated 

The system adds the Invoice Calculated Freight Amount into the Previously Calculated 
Freight Amount in the SORSOH record and recalculates the Order Calculated Freight 
Amount gets recalculated based on new order quantity if the Default Freight flag is Sales 
Order Static F/M is set to "yes". 

The new fields will move into the past invoice header file. 

Invoice Processing for Overpayments or Remaining Deposits 
You cannot exit an invoice without indicating what is to be done with any overpayment or 
remaining deposit. Overpayments or remaining deposits can be applied on account, 
refunded, transferred to another document, and so forth. If the invoice print process detects 
an overpayment remaining on an invoice, "deposit held" or "applied on account "prints on the 
invoice. Processing in the Daily Sales Register (SOR310) program determines which is 
appropriate. If the Daily Sales Register (SOR310) processing detects an overpayment, it will 
determine whether there will be a backorder generated for this document. If there is a 
backorder, the overpayment will be converted to a deposit on the document. If no backorder 
will be created, the overpayment will be applied on account. If the Daily Sales Register 
(SOR310) detects a deposit remaining on a completed document, the deposit will be applied 
on account. Payments applied on account from Sales Orders, via the Daily Sales Register 
(SOR310), now update the last payment date in the customer master record.  

Counter Sales Work Flow and Program Concepts 
Counter Sales acts as a point-of-sale system, providing capabilities such as deposit 
handling, multiple payments, cash drawer and tray handling, credit limit checks, credit card 
handling (with ICVERIFY integration) and register balancing with Z-out reports. It also allows 
you to backorder items and drop ship them, check warehouse quantities, search for items, 
customers and documents, and review past sales and quotes. 

The Counter Sales menu contains these programs: 

Counter Sale Entry (SOE510) is used to create point of sale documents. 
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Counter Sale Print (SOP320), which prints counter sale documents in batch or documents 
not printed on the end of a sale entry. Counter Sale Print can also be used to batch print 
(and reprint) groups receipts. Printed counter sales receipts include all pertinent header and 
line-item information, addresses and totals. Use the Sales Orders Document Print Control 
F/M to change the depth of the counter sales receipt, indicate that the form is preprinted, 
enter the standard memo, etc. This also enables you to use the same format — and 
preprinted forms — for counter sales receipts, invoices and credit memos. 

You can also print sales receipts from the Counter Sale Entry program. Invoice numbers (not 
to be confused with document numbers) are assigned just before each document is printed. 
Invoice numbers are not affected by reprinting. 

Cash Drawer F/M (SOF610) is used to set up cash drawers in FACTS. It also allows you to 
see which terminals are signed in to which drawers. 

Cash Tray F/M (SOF620) is used to create, or if necessary, delete cash trays, which are 
assigned to cash drawers in the Update Shift program. 

Cash Drawer Sign On (SOE650) is used to sign onto a drawer in this program; the system 
ask them to sign on when they enter a cash-type payment in Counter Sale Entry or 
Payment/Deposit Entry. If the system does not require you to sign on in those programs, 
check that the SO Static Control Use Cash Drawer Handling flag is selected. 

Cash Drawer Sign On also serves as inquiry since it allows you to review which cash 
drawers are in use and which terminal, or user, is signed on to it. 

Balance Cash Tray (SOR840) is used to ensure that trays balance at the end of each shift 
(after the Update Shift program). currency calculator is built into this program to help you 
count the amount of currency, coins, checks, credit card slips and other legal tender taken 
into the drawer during the shift. 

If there is a discrepancy in a tray, you can assign it to a specific branch or let the program 
distribute it proportionately among the branches. Any discrepancies will post to the DSR. 

After you finish counting a tray, you can print a Z-out report, which lists the tray’s activities for 
the shift. Once balanced, the tray can be assigned to another drawer. You cannot access 
this program if the DSR is in the middle of an update. 

Update Shift (SOU840) is used to place trays in drawers and to assign starting amounts to 
trays and remove trays from cash drawers so they can be balanced in the Balance Cash 
Trays program. If you use cash drawer handling, use this program before Cash Drawer Sign 
On at the beginning of each shift and before Balance Cash Trays at the end of each shift. 
Update Shift is the program enables you to place trays in drawers and to assign starting 
amounts to trays. It also allows you to remove trays from cash drawers so they can be 
balanced in the Balance Cash Trays program. 

Assigned trays are removed by assigning a new tray to a drawer in this program’s Cash Tray 
ID field (see below). For example, if you want to remove tray dd1 from drawer ssi, enter 
another tray ID, say dd2. Once you specify another tray, it is ready to be balanced in the 
Balance Cash Trays program. 
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Operating Tips and Suggestions 

Counter Sales is effectively the entire sales order process rolled into one program; it is 
structured so that you can service walk-in and established customers alike as quickly as 
possible and still tie into FACTS. 

Distributors that don’t need the cash drawer handling features available in this system can 
still benefit from the Counter Sale Entry program. This program can be used to process 
orders quickly without requiring users to run through each of the programs normally involved 
in the sales order process. Counter Sales documents, also called sales receipts, can be 
printed in batches to further speed the order entry process. Small staffs with generalized 
responsibilities that process large volumes of orders may find this entry program useful. 

Setting up the Counter Sale system 

To use the complete Counter Sales system with cash drawer and tray handling, several 
programs in the Counter Sale menu will need to be set up and a few file maintenances will 
need to be edited. 

Terms Codes 

If you have not already done so, you will need to establish the payment types that will appear 
in the Counter Sale Entry footer. This step may be unnecessary since several order entry 
programs, as well as Payment/Deposit Entry, also use this information. If this program has 
not been set up, FACTS reminds you to do so when you try to open Counter Sale Entry. 

From the Counter Sale Menu, enter the access code navigate to the SO Infrequent File 
Maintenances menu and select Terms Code Order Setup from the Infrequent File 
Maintenances menu. 

Begin by entering a cash-type terms code (set in Accounts Receivable Terms Code F/M). 
Press F2 to search the available codes, then enter a user-defined description. FACTS only 
accepts cash-type terms codes in this F/M, which are those that are designated as type 1 
though 4. 

Use the up and down arrow keys to select, move, insert, edit or delete the six terms codes so 
they are in the order in which they need to appear in the ending routine. See Chapter 16 for 
more information about the Terms Code Order Setup program. 

Cash Drawers and Trays 

Cash drawers can be simple shoe boxes or sophisticated peripheral devices. Either way, 
setup procedures are essentially the same. 

To enable cash drawer and tray handling in FACTS, set the Use Cash Drawer Handling flag 
located on the Use tab of SO Static Control. Then refer to the Cash Drawer F/M and Cash 
Tray F/M sections. 

If you use cash drawers that interface with your terminals or PCs, your Affiliate will need to 
create link files and install device drivers. In addition, a hotkey that automatically opens the 
drawer should be set up in Terminal F/M. 

Using the Counter Sale system 

At the beginning of a shift, open Update Shift to open a drawer, assign a tray to it and place 
an opening amount in the tray. 
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Have your sales clerks sign on to cash drawers in Cash Drawer Sign On. This program 
shows you which drawers are already in use and tells you which terminals (users) are signed 
on to them. If someone forgets to sign on in this program, the system will prompt them to do 
so when they enter a cash-type payment in Counter Sale Entry or Payment/Deposit Entry. 

Begin entering sales in the Counter Sale Entry. 

At the end of the shift, open Update Shift to remove trays from their respective drawers. 
Trays are actually removed by assigning another balanced tray to the same drawer. Once 
another tray is assigned, the first tray is automatically removed and ready to be balanced. 

Open Balance Cash Trays to count out the trays and run Z-out reports, which are printouts of 
the transactions run through those trays. A currency calculator is available to help you keep 
an accurate count of currency, checks, credit card slips, etc. 

Once a tray is balanced it can be assigned to another drawer. 

At the close of a day, make sure all drawers are signed off by entering Cash Drawer Sign On 
and setting each drawer to NONE. 

Counter Sale Entry Processing Details 

The Counter Sale Entry screen is divided into three sections: the header portion where you 
enter the customer placing the counter sale and other general information required to 
process the counter sale, the line item portion where you add items, quantity and pricing 
information, and the footer window where you enter final fields prior to completion of the 
counter sale. 

Counter Sale Print (SOP320) Notes 

The system also prints any notes flagged during Counter Sale Entry to print on receipts. 
Urgent document notes print before normal document notes. Memos print before any line 
notes, and line notes print in the order of entry with no special dispensation for urgent notes. 

To use the invoice format on counter sale documents: 

1. Go to Sales Orders>File Maintenances>Infrequent File Maintenances>SO Document Print 
Control F/M. 

2. Choose the Counter Sales tab and set the Print Format option to Use Invoice Format. 

3. Save and exit. 

Printing BOM item components on counter sale receipts 

If an item is a bill of material item and the BOM on Invoice flag is set to Y in SO Static 
Control (Inventory tab), the component items used to produce the BOM item print on the 
counter sale receipt. 

To print an alignment, select Printer Options>Print Alignment. 
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Recurring Invoices Work Flow and Program Concepts 
You can use the Recurring Invoices subsystem to generate any invoices that need to be sent 
on a recurring basis (e.g., service contracts or blanket orders). It enables you to set up the 
document one time and to have the system automatically post it to the Sales Orders 
Document File for each month designated. It also makes it possible for you to set up a cutoff 
so that the monthly posting stops at a predetermined time. 

As with regular invoicing all recurring documents are entered using the customer number 
and item number, etc. 

The Recurring Invoices menu contains these programs: 

Use the Recurring Document Entry program to enter recurring customer invoices to post into 
the sales orders processing cycle. 

The Recurring Document Entry screen consists of three sections. The upper portion of the 
screen is called the header portion where the customer number, ship date, etc. are entered. 
The middle portion is called the line-item portion where each item, price, quantity, etc. is 
entered. The lower portion, which shows up after line items are entered, is called the ending 
routine and consists of the final inputs prior to completion of the document. The screen is 
designed to look like a printed invoice. You have the option of changing, adding to, removing 
line items from or deleting the recurring invoice at any time. 

Use the Recurring Document Listing program to obtain a listing of all recurring documents on 
file. An optional update allows removal of expired documents. If only expired documents are 
selected, an optional update which follows the following printing of the listing, allows the 
removal of all expired documents just printed. Report information includes the following: 
customer number, name, sequence number, ship-to number, warehouse to be shipped from, 
salesperson/territory, terms code, tax code, whether to print the document as a work order 
and/or an invoice, day of month to post, months to post, total document amount, total 
number of documents and dollars posted, memo and status. 

Use the Post Recurring Documents program to post recurring documents into the Sales 
Order processing cycle based upon the post month and day for the current period. The 
program recalculates all commission percentages on lines not flagged as commission user 
override as the SO document is created. The Post Recurring Documents processes any 
Rush orders before any normal or service hold. 

Start by selecting the day through which recurring documents are to post. 

This program must be run in order to bill customers. 

Recurring Document Entry does not allow for multiple shipping warehouses. When recurring 
documents are being posted, the system sets the document freight method from the 
customer record. If the Freight Method is quoted, the system uses the freight in the recurring 
document header in the quoted freight amount field. 

If the Freight Method is calculated: 

• Because recurring documents are a contracted with the customer, even if the freight 
method for the customer is calculated, the system uses the freight from the recurring 
document header. 
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• if the freight amount in the header record is not zero, the freight amount is used in 
the SOFRWH record of the initiating warehouse and the user-override flag is set to 
"Y" (selected). 

• if the freight amount in the header record is zero, a zero freight amount is used in the 
SOFRWH record of the initiating warehouse and the user-override flag will be set to 
"N" (unselected). 

Shipping Work Flow and Program Concepts 
The Shipping Subsystem is a manifest system that handles multiple carriers but is geared 
mainly toward UPS. 

UPS requires that companies use a UPS approved shipping package. Contact your FACTS 
affiliate if you have questions about which shipping software system you should use. 

The Shipping menu contains these programs: 

Freight Entry Program, is used to enter orders into the freight manifest system. Each order 
you enter appears on the manifest when you print it. You should enter orders by sales order 
number or consignee and ship via. In other words, enter all the packages to the same 
address using the same ship via on the same freight entry (this saves time and reduces 
errors in entering header information). 

Freight orders can be entered for any warehouse. Keep in mind that the shipper number is 
determined by the warehouse (stored in the Warehouse File), and the charges are based on 
the zone, which for ground service, is also warehouse dependent. 

The system stores default zones in both the Customer File and the Ship-To File. During 
header entry the program displays the latest default zone, the entered zone if any, and the 
zone calculated by the zip code. You must select the correct zone. NOTE: UPS has different 
zones for rural and urban Alaska. 

The Freight Entry Screen consists of two sections. The upper portion of the screen is called 
the header portion where the customer number, ship via, and department are entered. The 
lower portion is called the line-item portion where each package, weight, value, etc. is 
entered. During the entry of an order, the user has the option of changing, adding to, 
removing line items from, or deleting the order at any time. 

Shipping Label Print outputs UPS-style labels for sales and freight orders. The Shipping 
Label Print Program is identical to the UPS Shipping Label Print Program in the way each 
works. The difference between the two is the output. This program prints a label 4 1/8 x 2 
15/16 inches. The UPS shipping label is 2 15/16 x 5 3/4 and subscribes to UPS regulations. 
This program is also called by the Freight Entry Program when printing freight orders with a 
ship via other than UPS. Print up to 99 labels for each document entered. Also print shipping 
labels for freight and sales orders by warehouse. 

Use the UPS Shipping Label Print program to print UPS-style shipping labels for sales orders 
and freight orders. The UPS Shipping Label Print Program is identical to the Shipping Label 
Print Program in the way each works. The difference between the two is the output: This 
program prints shipping labels that measure 2 15/16 x 5 3/4 inches. The Shipping Label Print 
Program prints a general mailing label 4 1/8 x 2 15/16 inches. Print up to 99 labels for each 
document entered. Also print shipping labels for freight and sales orders by warehouse. 
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Use the UPS C.O.D. Label Print program to print regulation UPS C.O.D. labels for sales 
orders and freight orders. Even if you are not using a computerized manifest system, this 
program can be run to print multiple C.O.D. labels. Enter the information in Freight Entry or 
pull over the sales order, and enter the C.O.D. amount for each package. Then, run this 
program to print labels for each individual package. You can also enter the invoice number 
and C.O.D. amount through this program. The UPS C.O.D. Label Print program prints all the 
required data on the preprinted UPS C.O.D. label. According to the Use Alt Ctl # flag in the 
Shipping Control Record, the system prints the invoice or freight order number on the label 
as well as the preprinted UPS number. If the alternate control number is used, UPS tracks 
the C.O.D. package through the number; it does not track it by the preprinted UPS number. 
You can also print C.O.D. labels for freight and sales orders by warehouse. 

The labels created by these 3 programs are not approved by the carrier. 

Freight Manifest Print program prints the manifest that is required by the carrier. It can print 
all the manifest orders for UPS 1st Day Air, 2nd Day Air, all UPS manifest orders, or orders 
for another carrier. This program prints separate manifests by ship via code to accommodate 
multi-carrier functionality. Note: The manifests created from this program are not UPS-
approved. This program prints a summary of all line-items (packages) in the Sales Orders 
Freight Order File that possess the required criteria. Print manifests on 8 1/2 x 11-inch paper 
and in compressed print, so the manifest will fit in 132-column format. Manifest information 
includes the following: manifest date, shipper’s address and number, invoice number, 
consignee and the consignee’s address, UPS zone, package weight, freight charge, C.O.D. 
amount, declared value, and if the package uses the GroundTrac service, if it is oversized or 
if a call tag has been issued. The manifest also sub-totals every one hundred packages. A 
summary is printed for each zone, including the number of letters, number of packages, total 
weight, total freight charge, number of C.O.D. packages, total C.O.D. charges, total 
insurance charge, and total number of call tags. The summary concludes with the total 
number of GroundTrac packages on the manifest, total number of C.O.D. packages, total 
C.O.D. charges, and total UPS revenue. You have the option of printing manifests by 
warehouse and multiple warehouses. If printing by multiple warehouses, the program uses 
the shipper number from the first warehouse code entered. 

The Freight Inquiry program allows you to view any shipment in process or any past 
shipment. Open freight orders (in process) can be viewed by a warehouse, or customer. Past 
freight orders are also customer and warehouse specific, as well as date sensitive. The 
inquiry displays the documents as they appeared in Freight Entry, with two exceptions: when 
the current warehouse is set to ALL, the warehouse for the freight order is displayed, and if 
viewing the past freight orders, the date of shipment appears. The Freight Inquiry is helpful in 
tracking shipments for customers and/or warehouses. It also enables you to find out exactly 
what date a sales order or package was shipped. 

Use the Freight History Report program to print a history of the manifests that have been 
shipped. The report shows the manifest as it appeared the day the carrier picked up the 
shipment. This is helpful in finding out when an order was shipped, what day it went out, etc. 
Report information includes the following: manifest date; shipper’s address and number; 
invoice number; consignee and the consignee’s city, state, and zip code; UPS zone; 
package weight; freight charge; C.O.D. charge and amount; declared value; insurance 
charge; the total charge; whether the order uses the GroundTrac service; and whether the 
package is oversize or a call tag has been issued. This also provides a hard copy of past 
manifests (which UPS requires to be on file for one year). 
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Use the UPS Chart Print program to print a zip code to zone conversion chart or a rate chart 
based on weight and zone. Both of these charts are required by UPS, when using their 
computerized manifest system. The Zone Chart prints a listing of each warehouse’s zip-zone 
conversion. It shows the zip code prefix and the zone for that prefix. The Weight Chart prints 
the rates for one pound to seventy pounds for the zones selected. Printed are the zone, the 
pounds, and the rate. 

Shipping Processing Notes 

The Shipping Subsystem integrates sales orders shipments as well as the occasional non-
invoiced shipment. The Freight Entry Program prompts you for an invoice number, if you 
enter an invoice number, the system automatically pulls over the customer, address and ship 
via. If the invoice changes, the Freight Entry Program makes the necessary adjustments 
when you enter the invoice number after the changes have been made. It is not necessary to 
delete and reenter the freight information for changes to the header on the invoice. 

If the entry on the manifest does not stem from an invoice, you can enter an order number 
that is not on file. The program perceives this entry to be a non-invoiced entry, and it appears 
on the same manifest as the sales orders shipments. This allows shipments from 
departments other than sales. 

Contract Pricing System Work Flow and Program Concepts 
The Contract Pricing Subsystem is an optional feature of the FACTS System. The Contract 
Pricing subsystem allows you to enter, maintain, list, and remove existing contract prices. 

The programs available in this subsystem are: 

Contract Entry (SOE560) is used to enter and/or maintain contract prices. You can also 
access a delete option for active contracts. The entry screen consists of four sections: 

• header, where you can specify that the contract is for all customers and/or items, the 
contract type, the effective and expiration dates and whether the contract is for all 
direct ships or all warehouse ships . 

• standard pricing, where you enter contract standard pricing and commission 
information for the customer/item scope selected. 

• price level pricing information, where you enter contract price level and commission 
information for the customer/item scope selected. 

• quantity break pricing information, where you enter contract quantity breaks, prices 
and commission information for the customer/item scope selected. 

Contract Listing (SOR510) is used to obtain a listing of selected existing contracts entered 
through the Contract Entry program. You can specify: whether to print based on contract 
status--current, future and/or expired contracts, print based on the ‘approved or not 
approved’ setting, contract type, contract selection method, units of measure, whether to 
print standard price and price levels and/or quantity break prices, and whether to print actual 
prices along with suggested/existing contracts. 

Expired Contract Removal (SOU520) is used to automatically remove expired contracts 
entered through the Contract Entry program. You can delete individual active contracts within 
the Contract Entry program. However, you can use this to remove batches of related expired 
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contracts — for example, all contracts for a specific customer, a specific item, etc. You can 
specify: to remove based on an expiration date, customer scope for remove by criteria, item 
scope for remove by criteria and beginning and ending scope choice to remove. It may be 
helpful to first run the Contract Listing program to generate the list of contracts to delete. 

The Contract Hierarchy F/M is an optional program that allows you to set the hierarchy for 
contract prices. This hierarchy provides the order in which contract prices are searched 
during the Sales Order Entry programs. In the SO Static Control F/M, the Default Price 
control determines what priority the order entry programs give contract prices in relation to 
other types of prices set up in the system. Contract prices will not appear in Sales Order 
Entry programs if the Use Contract Pricing flag in SO Static Control F/M is not selected, or is 
set to N. The contract pricing matrix that you create in this program is based on the customer 
(who is placing the order) and the item (what merchandise is being purchased). You must 
determine the priority by customer of which price the system should select as well as the 
priority by item of which price the system should select. The choices of the hierarchy are as 
follows: Item Scope Priority (Individual Item, Item Price Class, Vendor, and All Items) and 
Customer Scope Priority (Individual Customer, Customer Price Class, and All Customers). 
Based on how you set the priorities of customer and item, the system sets the priorities of all 
contracts from highest priority to lowest automatically. 

Use Contract Maintenance to quickly add/copy/create/chain/delete/list/modify a contract or 
group of contracts. You may also save “Collections” of contracts, or manage/modify a 
collection of contracts. The term collection, from here forward, refers to contracts displayed 
in the list browser (whether one contract or many contracts is displayed). In Contract 
Maintenance, you can use the available menu options to aggregate/compile/build a collection 
that you want to work with or modify in some way. Once you have assembled a collection 
(even if the collection has only one contract), you can save that collection and give it a name 
for later use, i.e. collections can be saved and retrieved. A saved collection is visible upon 
‘look-up’ only to the user who created it. Once a collection is saved, it can be modified using 
the menu options displayed under “Collection”, or, the individual contracts that make up the 
collection can be modified using the menu options displayed under “Contract”. Creating a 
saved collection is not required. You can use Contract Maintenance without ever saving that 
collection. Without saving a collection, the user can simply use the menu options each time 
they come into Contract Maintenance. Saved collections do not ‘update-automatically’ with 
contracts that have been added/changed since the date the collection was last saved – e.g. if 
you create a collection for “all contracts that have not yet been approved”, and save it, and 
then a week later open that collection, all the contracts since created in that week (that are 
not as yet reviewed) will have to be added/merged to that collection (through using the ‘Filter’ 
menu option or adding those contracts specifically through the collection menu option ‘Add 
Contract’). In the list browser, the system displays the contracts comprising the collection 
and includes the following information: contract number, type, description, effective date, 
expiration date, chain from, chain to, approve, priority, customer, item, last Daily Sales 
Register, and Quote number, the contract was generated from. The Customer column 
displays ‘All’ if the ‘all customers’ check box is selected for the contract. If customers are 
listed, then up to 2 customers (separated by a comma) will be listed; if there are more than 2 
customers then after the second customer will be .... If there are no customers listed in the 
contract, instead the contract has only customer price classes, and then the display of two 
classes, as above, applies for customer price class listing in this column. If customers exist in 
the contract (even if only one) then no customer price class entries will display in this 
column, only customers. The Item column works identically to Customer column but for 
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Items. First for items; if no items are listed in the contract then the display is for item price 
class; if no item price classes listed either, then the display is for primary vendors. 

Contract Pricing Processing Notes 

Contracts are written with a contract number and description. After entering pricing 
calculations, effective and expiration dates, and so on, then you enter the "scope" of the 
contract by specifying the Customer Scope ("who the contract is for"), the Item Scope ("what 
it applies to"), and the Shipment Scope ("where it comes from"). 

When FACTS calculates contract pricing and multiple contracts with the same scope apply, 
the system selects the contract with the lowest price. 

You can mark contracts as "Awaiting Review". If the flag is set, the contract will not be used 
even if the dates indicate it should be effective. 

Contract Scope 

Under the Customer Scope, you can enter any number of individual customers (with or 
without ship-to’s) and any number of customer classes. Alternatively, you can specify that 
the contract applies to all customers. 

Under the Item Scope, you can enter any number of specific items, any number of item 
classes, and any number of primary vendors. You can enter UM specifications for any of the 
three Item Scopes: Specific Item, Primary Vendor and Item Price Class. You can enter 
specific UM scopes for any of the three Item Scopes (Specific Item, Primary Vendor and Item 
Price Class). Alternatively, you can specify that the UM applies to all items. 

Under the Shipment Scope, you can specify whether the contract is valid for drop ship lines. 
The Shipment Scope options are Y (for the Vendors entered), N (doesn’t apply to drop ship 
lines) and A (applies to all drop ship lines, regardless of vendor). If you select Y (for the 
Vendors entered), you can enter any number of drop ship vendors. You can also specify 
whether the contract is valid for warehouse ship lines, with the options being Y (for the 
warehouses entered), N (doesn’t apply to warehouse ship lines) and A (applies to all 
warehouse ship lines, regardless of shipping warehouse). If you select Y (for the warehouses 
entered), you can enter any number of shipping warehouse. 

Contract Pricing 

You can setup contract prices for a customer, customer price class, or all customers by an 
item, item price class, vendor or all items by pricing unit of measure. For example, you may 
give a specific customer a special price on an item or class of items, or may give all 
wholesale customers (one customer price class) a discount off the standard price on a 
specific item or a class of items. You can set up any one of the combinations. 

Once the combination of the contract is determined, the contract may have the following 
price types defined: 

• Standard Price - The standard price of the contract as determined by the user. Standard 
contract price may be entered as a dollar amount, a percent (%) change of the actual 
standard price or may be entered using a basis (list price, manual cost, sales order cost, 
standard price or any price level) and multiplier. 

• Level Price - Up to 6 contract level prices per item can be entered. The level price used 
when the item is sold is based on the price level assigned to the customer. For example, if a 
customer is assigned price level 4, the level 4 price is used when selling an item to that 
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customer. Contract level prices can be entered as a dollar amount, a percent (%) change of 
the actual level price or may be entered using a basis (list price, manual cost, sales order 
cost, standard price, or any price level) and multiplier. 

• Quantity Break Price - Up to 6 contract quantity break prices per item may be entered. The 
quantity break price allows the user to enter a minimum quantity of the item to sell along with 
the price per UM for that item. For example, if three quantity breaks are set up as follows: 

Qty Break 1 10 ea. for $2.75 ea. 

Qty Break 2 15 ea. for $2.50 ea. 

Qty Break 3 20 ea. for $2.25 ea. 

The quantity sold is 12, the default price would be $2.75. Contract quantity break prices may 
be entered as a dollar amount, a percent (%) change of the current quantity break price or 
may be entered using a basis (list price, manual cost, standard price or quantity break) and 
multiplier. 

Commission percentages may also be set by price level or quantity break. 

Contracts are set up with an effective and expiration date. Contract prices are only used 
when the sell date is between the effective and expiration date. Once a contract has expired, 
it remains in the system. It can be deleted through the Contract Entry Program or removed 
by date through the Expired Contract Removal Program. 

Contracts Under Review 

In Contract Entry you can enter contracts with an effective date. If you want to ensure that 
the contract does not take effect until it’s been reviewed even after the effective date, select 
the Awaiting Review prompt to prevent the contract from taking effect. To review a contract, 
select the Review option in Contract Entry to access the Price Contract Review screen. On 
the Price Contract Review when you select the Contract Inactive; Awaiting Review field, the 
system records the user id and date in the Review By and Review On fields. You can toggle 
the Contract Inactive; Awaiting Review setting on and off. 

How FACTS determines when to use contract prices 

When entering contracts prices, there may be an actual price for a level and a contract price 
for a level. If the level is then used as the basis the system must determine whether the 
actual level price or contract level price is used. The rules are as follows: 

• If the basis price level is lower than the entered level, the contract price is used. 
• If the basis price level is equal to or higher than the entered level, the actual price is 

used. This is because there is no contract price yet for a higher level. 

For example, below are the bases, multipliers and which prices are used in calculating 
contract prices when setting up contract price levels for an item: 

Level Actual Price Basis/Multiplier Which price used / How calculated 

$25.00 Level 3/ 1.1000 Level 3 actual is basis - calculated price is 23.00 x 1.1 = 25.30 

$24.00 Level 2/ 1.1000 Level 2 actual is basis - calculated price is 24.00 x 1.1 = 26.40 

$23.00 Level 1/ .9500 Level 1 contract is basis - calculated price is 25.30 x .9500 = 24.04 

$22.00 Level 3/ 1.0500 Level 1 contract is basis - calculated price is 24.04 x 1.0500 = 25.24 
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$21.00 Level 2/ 1.0500 Level 2 contract is basis - calculated price is 26.40 x 1.0500 = 27.72 

$20.00 Level 6/ 1.000 Level 6 actual is basis - calculated price is 20.00 x 1.000 = 20.00 

The Contract Entry programs allow you to set up the contract standard price, level prices and 
quantity break prices three different ways. The following three set up options are the basis 
for the entry of all prices throughout these Contract Entry programs: 

1. Using a basis and multiplier 

Contract prices can be entered by setting a basis and multiplier. This means that to set up a 
contract price, another existing cost or price is the basis of the new contract price and a 
multiplier is applied against it. If for example, the basis price was $100.00 and the multiplier 
was .9400, the new calculated price would be $94.00 ($100.00 x .9400). Taking this example 
further, in setting up level prices, you can determine that each one is based on some % 
(percentage) of the list price. If the list price is $100.00 and the levels are 1) $95.00, 2) 
$94.00, 3) $93.00, 4) $92.00, 5) $91.00 and 6) $90.00 the level prices may be set up using a 
basis, list price, and multipliers: 1) .9500, 2) .9400, 3) .9300, 4) .9200, 5) .9100, 6) .9000. 

When entering contract prices using a basis and multiplier, the actual price is not calculated 
and stored in the pricing files. Rather, the basis and multiplier is stored in the contract pricing 
files and the basis amount and multiplier calculation is performed at the time the item is sold 
in the sales order entry programs. The purpose of entering contract prices using a basis and 
multiplier is that if the basis amount changes, no new contract prices will then be required to 
be entered. For example, if the standard price is always a multiplier of manual cost, then the 
standard price will automatically be changed if the manual cost is changed. 

2. Using a dollar amount 

Contract prices may be entered by entering the actual dollar ($) amount. No calculations are 
then necessary. The price entered is the price that is stored in the pricing files and is what is 
used when the item is sold in the sales order entry programs. 

3. Using a change % (percent) 

Contract prices may be entered by entering a change % (percent) from the actual price. For 
example, if a standard price of $100.00 is increasing by 3% then a change % may be 
entered of 3.000. The system will then calculate and display the new calculated price of 
$103.00. When entering a change %, the actual dollar amount is calculated and stored in the 
contract pricing files. In this example, $103.00 is stored in the files and is what is used during 
the sales order entry programs. 

Commission Percentages 

In addition to the three set up options for the standard price, price levels and quantity breaks, 
you can also enter a commission %. 

The Use Commission Percent Levels flag in Inventory Control Static Control F/M determines 
whether this commission flag is used throughout the costing/pricing subsystem. If the flag is 
turned off, the option to enter the commission % is never available. If the flag is turned on, 
each contract price that is set up will require the entry of a commission %. When entering the 
commission %, you can set the commission % to "no priority" (blank) indicating that 
commission is not generated based on the price being set up. (If the item is set to "no 
priority", any commission % entered in the contract pricing system will be ignored). (For more 
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information on commissions, refer to the commission basis flag set in the Company Control 
F/M program in the System Management Manual.) 

Contract Hierarchy 

You can set the contract hierarchy through the Contract Hierarchy F/M program. The 
contract pricing matrix is based on the customer (who is placing the order) and the item 
(what merchandise is being purchased). You must determine the priority by customer of 
which price the system should select as well as the priority by item of which price the system 
should select. The choices of the hierarchy are as follows: 

Customer Scope Priority (Individual Customer, Customer Price Class, All Customers) 

Item Scope Priority (Individual Item, Item Price Class, Vendor, All Items) 

Based on how the priorities of customer and item are set, the system sets the priorities of all 
contracts from highest priority to lowest automatically. 

For example, if you set the Customer Scope Priority to ICA, and the Item Scope Priority to 
IVCA, then the system would display the following hierarchy for the contract pricing: 

The above priority list represents the order that contract prices are used when selling items 
through the sales order entry programs. In the above example, a contract price for a specific 
customer and specific item would take precedence over all other contracts. For example, 
there is a contract price set up for item I100 and customer C100 for $45.00. There is also a 
contract price set up for customer C100 and item price class, widgets for a 10% discount off 
the list price. Item I100 is a widget and is assigned to item price class, widgets. Therefore, 
when item I100 is sold to customer C100, there are two eligible contract prices: one for the 
specific customer and specific item and one for the specific customer and item price class. 
By looking at the hierarchy set above, the system will select the $45.00 price from the 
specific customer/specific item contract since it is higher in the priority than the specific 
customer/item price class contract price. 

If the system should use the lowest contract price available regardless of the hierarchy, there 
is an option to have the system always select the lowest price. 

Contract Entry (SOE560) Processing Details 

The following functionality is available: 

• Contract Price by Ship-To: You can specify that a contract is valid for all customer 
ship-to addresses or for only designated ship-to addresses. 

• Copy Contract: Any new contract can be copied from an existing contract. 
• Contract Price by Warehouse: Any contract can be valid for all shipping warehouses 

or only the warehouses you specify. 
• Shipment Type Designation: For each contract, you can specify whether the pricing 

is valid for warehouse shipments, direct shipments or both. 
• Multiple Scopes for One Contract: Instead of creating the same contract more than 

once for a few customers or items, you can simply create the contract and then 
assign which customers/ship-tos, items, warehouses, and vendors the contract 
applies to. 

• "Approval" Flag: You can enter contracts in Contract Entry with an effective date. A 
contract is not active until it’s been approved, even after the effective date. Select the 
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Approve button to set this flag (check the box to approve the contract, uncheck the 
box to set the contract as ‘not approved’ and thus inactive, even if the effective date 
has passed). Fields for Approved Date and Approved Reviewer are also available. 

• Rounding Codes: Each contract can be assigned a flexible rounding code, which can 
round prices up or down to a specified cents (i.e., to .99) and/or dollar increment (i.e., 
the nearest $5.00). The rounding codes are completely user-defined. 

Customer Returns Work Flow and Program Concepts 
The Customer Returns Subsystem (CRS) is an optional feature of the FACTS Sales Orders 
system. The CRS subsystem provides you with the ability to enter and track customer 
merchandise returns while improving customer service. The objective of the CRS module is 
to provide immediate response to customers who return merchandise for any reason while 
minimizing internal costs and maximizing internal controls over returned goods. 

For example, a customer wants to return a rotary drum pump for replacement. Since the 
pump is still under warranty, the vendor will replace it. A sales order, subject to the normal 
sales order processing, will be generated so that the new pump can be shipped to the 
customer. 

EWMS (Accellos) / FACTS CRS Integration 

Only lines in CRS that are Accellos warehouse integrated (meaning the warehouse is 
enabled/interacting with Accellos) will be sent to Accellos when a CRS document 
authorization is printed.  However, if any line is sent and is at Accellos, the user will be 
denied entry into that document.  This is consistent with processing in Order Entry for orders 
sent to Accellos.  When the CRS document is received back from Accellos and any needed 
sales order and/or credit memo documents are created, the user will be able to access the 
document again in FACTS.  The lines that are already processed will have fields disabled at 
the line level 

You can access the following programs from the Customer Returns menu: 

Customer Returns Entry (SOE810) is used to create and edit customer return authorizations 
and customer return documents. Customer return authorization processing is an optional 
feature. The entry screen consists of three sections: the header, where the customer 
number, ship date are entered; line-item entry, where each item, price, quantity, and so on is 
entered; and the ending routine, also called the footer, which consists of the final fields prior 
to completion of the customer returns document. The screen is designed to look like a 
printed invoice. During entry of a Customer Returns document, you can change, add, or 
delete line items at any time, or delete entire Customer Returns documents. 

Returns Authorization (SOP820) is used to print and reprint the returns authorization. An 
authorization is provided to the customer when the customer calls to indicate that a return is 
to be made. The returns authorization can also be used as a returns packing slip. This 
program prints the authorization based on the information in the text file.  

You have the option to: 

• Enter CRS authorization number to print 
• Perform a search of CRS documents 
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The Returns Authorization includes information as set in the text file. The default text file’s 
information includes: Date of issue, Customer name, Contact name, Returns Authorization 
number, Authorization date, Reference #, Company and address of where to return 
merchandise, Item number and description of each item to return, Quantity and unit of 
measure of each item to return, and Disposition description of each item to return. 

Returns Acknowledgment Print (SOP810) is used to print and reprint the returns 
acknowledgment. An acknowledgment is given to the customer and can be used as a returns 
packing slip or repair ticket. This program uses the invoice parameters in SO Document Print 
Control F/M to control the print formats. 

You can: 

• Print an alignment 
• Select acknowledgments by warehouse 
• Select acknowledgments by type (acknowledgment, repair ticket, or both 
• Batch print all acknowledgments or print specific documents 

Returns Acknowledgment information includes: Item Number, Item Descriptions, Returned 
Quantity, Price and Unit of Measure, Extension, and Return disposition category. 

Customer Returns Inquiry (SOI810) is used to inquire into the status of any return document. 
The inquiry is especially useful for locating orders for a given warehouse, customer, or item. 
The actual document may be displayed in detail through this program. 

Summary Display 

The Customer Returns Inquiry is a display-only version of the Customer Returns Entry 
program. 

CRS Status Report (SOR820) is used to track returns currently on file in the CRS 
subsystem. It provides you with information from the return document, as well as, information 
from any related sales order document, credit memo, and/or vendor return when applicable. 

You specify: 

• print order by document, by customer or by item 
• beginning and ending order 
• returns by warehouse, reason, disposition, and status 
• Include price, memo, and VRS information 
• range of return dates 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, document line number, item and description, reason code, 
disposition code, return quantity, unit of measure, price and pricing unit of measure, price 
extension, line status, document total, and credit memo or sales order document number 
when applicable, or vendor number, name, vendor return document, line number and status 
when applicable. This report differs from the Returns Analysis Report in that it includes 
pricing information. 

Returns Analysis Report (SOR830) is used to obtain a report of all orders currently on file in 
the CRS subsystem. This report is designed to track returns. It provides you with both 
information from the return document and information from the sales order, credit memo, 
and/or vendor return when these entries are generated. 
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You can specify: 

• print order by customer or by item 
• beginning and ending order 
• returns by warehouse, reason and disposition 
• range of return dates 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, document line number, item and description, reason code, 
disposition code, return quantity, unit of measure, line status, and credit memo or sales order 
document number when applicable. 

Returns Reason Code F/M (SOF820) is used to create and maintain the reason codes for 
the CRS subsystem. The reason code is used to classify why merchandise is to be returned 
and to determine whether to charge a restocking fee based on that return. 

CRS Control F/M (SOF890) is used to provide you with static and non-static controls for the 
Customer Return Subsystem. The static controls are flags and default entries that affect 
certain fields in CRS Entry and Authorization print. The flags you set in this F/M should 
reflect your company’s return policy. FACTS updates the non-static data on a continual 
basis. 

Operating Tips and Suggestions 

Process overview 

Return documents are created in Customer Returns Entry using the Quick Entry screen and 
the Past Invoice Search or with the Customer Returns Line Entry screen. 

You can create the following types of documents: 

1. Returned Goods Document 

2. Return to Vendor PO 

3. Vendor Replacement PO 

4. Customer Replacement Order 

When you exit from Return Entry, the Return Authorization is printed. 

When the goods are received, you can access the Order Entry suite of programs and select 
the menu option “RMA” and enter the return document number to go to Returns Entry with 
the return document information loaded. 

In Returns Entry, enter the quantity that was received back from the customer for each item. 

When done, the return goods credit memo and customer replacement sales order are 
created and status flags for the vendor return and vendor replacement is set. 

As the return goods credit memo is processed through the Daily Sales Register, the status 
flags change for the vendor returns so the Buyer’s Control Center can then process the 
returns to the vendor and create the negative PO. The Buyer’s Control Center will also be 
aware of any vendor replacements that are indicated by a customer return and create the 
replacement PO. These will update back to the Customer Returns System files. 

As the return and replacement POs are processed through the Receipt Register, the status 
flags on the CRS lines are again updated. If the customer credit and customer replacement 
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were waiting on vendor action, the credit memo and sales order will be created. The DSR 
updating these documents will again update back to the CRS line. 

After the documents are initially created, you no longer need to go into Customer Returns 
Entry to complete the return document. As the supporting documents are processed lines will 
be marked as complete. When all lines on the return document are complete the document 
will be marked complete. 

Initial Setup Procedures 

The setup required to begin using the Customer Returns System is minimal; however, there 
are several questions that you should consider prior to setup. The answers to these 
questions will determine how you set up the system controls, in accordance with your 
company’s policies and procedures. 

• Do you allow the return of temporary items? 

• Will you require all returns to be tied to a specific past invoice? 

• Do you want to store customer returns history information? 

• Do you want to charge a standard restocking fee? If so, is the fee a flat dollar amount or 
percent based fee? 

• Do you want to track returns using separate GL accounts? 

• How many different ways does your business handle returns? 

Customer Returns Entry (SOE810) Program Concepts 

A number of additional features are available in the Customer Returns Entry Program: 

• Memo lines can be entered 

• Temporary items can be entered 

• Catalog items can be entered 

• Inquiries include Interchange, Catalog, Customer Item, and Past Sales 

• A Returns Authorization can be printed 

• A Returns Acknowledgment can be printed 

• Lost sales can be entered 

• Items can be added on the fly during line-item entry 

• During processing, the system automatically displays urgent notes for customers and items 
based on your settings on the Notes tab of SO Entry Options F/M. Refer to the 
Viewing/Entering Notes from Sales Order Programs topic for additional details. When the 
Customer Returns Entry program automatically creates purchase order such as for a direct 
ship sales order, FACTS determines if Vendor and Item notes should import into the PO, 
based on the export options setup on the note, and the Notes pop up functionality is 
disabled. If a note is set to export or required, then FACTS automatically imports the note 
onto the PO. 
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Returns Processing and Replenishment 
The Return document is created in Customer Returns Entry using the Quick Entry screen 
and the Invoice Search or with the regular line entry screen. 

When you exit from Returns Entry the Return Authorization is printed. 

When the goods are received, you can access the Order Entry suite of programs and select 
the menu option “CRS Entry” and enter the return document number. This will take the user 
to Returns Entry with the return document loaded. 

In Returns Entry, enter the quantity that was received back from the customer for each item. 

When done, the return goods credit memo and customer replacement sales order will be 
created and status flags for the vendor return and vendor replacement will be set. 

As the return goods credit memo is processed through the Daily Sales Register (DSR), the 
status flags for the vendor returns are updated so the Buyer’s Control Center can then 
process the returns to the vendor and create the negative PO. The Buyer’s Control Center 
also tracks any vendor replacements that are indicated by a customer return and creates the 
replacement PO. These purchase orders update back to the CRS files. 

As the return and replacement POs are processed through the PO Receipt Register, the 
status flags on the CRS lines will again be updated. If the customer credit and customer 
replacement were waiting on vendor action, the credit memo and sales order will be created. 
The DSR updating these documents will again update back to the CRS line. 

After the documents are initially created, you no longer need to access Customer Returns 
Entry to complete the return document. As the supporting documents are processed lines will 
be marked as complete. When all lines on the return document are complete the document 
will be marked complete. 

In Returns Entry, you can also create the credit dollars CM and customer replacement SO 
before the items are actually returned, when the received quantity is zero. This is not the 
standard so it can only be done on a line by line basis using the Create Documents button in 
line entry. The wait vendor action flag must be No. 

The Customer Returns Entry (SOE810) program also allows returns processing for 
temporary items.   

In Customer Returns Entry, you can enter temporary items for returns processing for the 
following return options:  

• Return to Warehouse 
• CRS temporary item returns may not have a consolidation warehouse that is different 

from the return warehouse. 
• Return to Vendor for Credit 
• Return to Vendor for Replacement 

• Note that the customer replacement option “Direct from vendor” is not allowed for 
temporary items. 

• Scrap 
• Repair 
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Temporary items created in CRS and passed through are not editable in the Buyers Control 
Center or the PO Entry Suite, but the temporary item flag is set to Y for them.  Temporary 
items created in SO, which are imported into PO from a suggested PO or by F1 entry in PO 
Entry or PO Receipt Entry do not have the temporary item flag set to Y in PO. 

The CRS Quick Entry program does not allow entry of Temporary Items. 

PO Returns Processing for Temporary Items 

You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs.  You can enter a temporary item having a negative quantity with no tie to any 
document. 

In the PO Entry Program Suite the entry of purchase orders for >0 quantities is not allowed 
for temporary items.  All quantities entered for temporary items must be negative quantities. 

PO document lines tied to CRS cannot be edited; this includes lines for temporary items tied 
to CRS as well. 

When processing a CRS temporary item that is a return action of “Repair” it is possible to 
enter a Unit of Measure that does not exist for the CRS Repair Item.  When that repair is 
processed from the BCC (creating a PO), if the Unit of Measure entered in CRS is not a valid 
Unit of Measure for the CRS repair item, you will be prompted in the PO Entry Program 
Suite, to enter that missing unit of measure in UM Code F/M (ICF910) and then in Item UM 
F/M for the CRS repair before being allowed to continue with the PO. 

Vendor Return type (V-Type) records 

Entry of a temporary item in the Buyers Control Center (POE400) program creates a CRS 
Vendor Return (“V”) type document/line record just like for IC Master table (ICMAST) items.  
Entering a temporary item in the Customer Returns System in the Sales Order module also 
creates CRS Vendor Return (“V”) type document/line records. 

However, temporary item entry in the PO Entry, Receipt Entry and Non-PO Receipt 
programs does not create V-type document/line records.  In order to track a temporary item 
return, it is necessary to create the return in Customer Returns Entry (SOE810) or via the 
Buyers Control Center (POE400). 

PO to GL Posting  

The Nonstocked field in the PO line files refers to the item being a temporary item tied to a 
sales order, and not that the item is in the ICMAST (IC Master) table as a non-stock item.  
This is so the PO to GL posting table uses the Temporary/Nonstocked GL # selection.  Truly 
temporary items entered in the PO Entry suite have the new Temporary_Item flag set to “Y” 
and use the Temporary/Nonstocked GL # selection too. 

Returned Goods Credit Memo Processing 

As the return goods credit memo is processed through the Daily Sales Register it will change 
the status flags for the vendor returns so the Buyer’s Control Center can then process the 
returns to the vendor and create the negative PO. The Buyer’s Control Center will also be 
aware of any vendor replacements that are indicated by a customer return and create the 
replacement PO. These will update back to the CRS files. 
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As the return goods credit memo is processed through the DSR it will change the status flags 
for the vendor returns so the Buyer’s Control Center can then process the returns to the 
vendor and create the negative PO. The Buyer’s Control Center will also be aware of any 
vendor replacements that are indicated by a customer return and create the replacement 
PO. These will update back to the CRS files. 

For Returned Goods Credit Memo (allowance for credit dollars) there is no updating to 
inventory quantities. For a Returned Goods Credit Memo (return), the inventory quantities for 
return warehouse will be updated and usage for the credit warehouse will be updated. The 
returned goods status is updated to complete. 

If the vendor return status is N/A the and the return action is return to vendor for credit 
(dollars) or item return and the return warehouse is same as consolidation warehouse, 
change vendor return status to Ready for return to vendor (Transfer has been updated 
through the Receiving Register or return warehouse is same as consolidation warehouse) 

If the vendor return status is N/A and the return action is return to vendor for credit (dollars) 
or item return and the return warehouse different from consolidation warehouse, the DSR will 
create a suggested transfer to the consolidation warehouse and change vendor return status 
to N/A. If this is also the Returned (for Credit) Credit Memo, the DSR also changes the 
returned credit status to complete and the Customer Replacement SO is changed to a 
customer replacement status of complete. 

Usage Updates from the Daily Sales Register 

If the Update Usage field in Customer Returns Entry (SOE810) is set to No (unchecked) then 
usage will not be updated. If Update Usage is Yes (selected) and the Usage Period is blank 
then the current period usage will be updated and set to the current period. If Update Usage 
is Yes and the Usage Period is not blank then the usage for the indicated period will be 
updated. 

MSDS Subsystem Work Flow and Program Concepts 
The Material Safety Data Sheet (MSDS) System allows you to maintain MSDS sheet 
information for hazardous items and to track which customers have received MSDS sheets 
and when the sheets were sent. 

The Occupational Safety and Health Administration (OSHA) of the U.S. Department of Labor 
stipulates that distributors must provide an MSDS sheet for hazardous items. Therefore, 
distributors of hazardous items must be able to do the following: 

• Keep track of MSDS sheets for hazardous items 

• Send MSDS sheets to customers when they purchase hazardous items for the first time 

• Send updated MSDS sheets when appropriate 

• Maintain records of customers who have received an MSDS sheet and dates. 

The MSDS subsystem contains the following programs: 
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MSDS On-Line Print (SOP350), which is used to print on-line MSDS sheets, summary 
sheets and optional cover letters. Use it to print on-line MSDS sheets, summary sheets and 
optional cover letters. 

A summary sheet contains: 

• customer number 

• ship-to or order number 

• MSDS IDs of sheets that were printed 

• MSDS IDs of sheets that did not print due to an error 

• general description of any errors that occurred. 

The cover letter is maintained in the MSDS Cover Letter F/M Program (SOF986). 

NOTE: This program is set to print in the following order: 1) cover letter, 2) MSDS sheet and 
3) summary sheet. However, due to third-party software print queuing, it is not guaranteed 
that the documents will come out in this order. 

A temporary file of MSDS sheets to print is generated during the SO Invoice Print program or 
the SO Pick Ticket program (whichever is defined in the MSDS Control F/M) and this 
program can be run after the appropriate SO print program. 

You can print all MSDS sheets that have not previously been printed and reprint any sheets 
that have been printed but have not been updated during DSR to the MSDS History File. 

  

MSDS On-Demand Print (SOP360), which is used to print MSDS sheets, cover letters and 
summary sheets on demand. You have three options for printing documents: by open Sales 
Order documents, by customer ship-to, by MSDS ID. If MSDS sheets for open SO 
documents or for a customer’s ship-to print, an optional cover letter will accompany the 
MSDS sheets. If MSDS sheets for open SO documents print, an MSDS sheet will print for 
every line item on the SO document that requires an MSDS sheet. 

MSDS ID Listing (SOR705), which is used to print a list of MSDS IDs with MSDS information 
and an optional list of items using each MSDS ID. The report may be run for any range of 
MSDS IDs. 

For each MSDS ID, the report lists: 

• the MSDS ID number and description 

• the MSDS sheet literature location (if applicable) 

• the electronic MSDS file name 

• the MSDS print macro code 

• the MSDS revision date 

• whether an MSDS sheet is required 

• items with this MSDS ID (optional). 

MSDS History Report/Reprint (SOR785), which is used to print a history report of MSDS 
sheets that have been sent to customers and reprint MSDS sheets previously sent (if the 
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MSDS on-line print process is used). You can run the history report in either customer or 
MSDS ID order. If the report is run in customer order and the same customer number is 
entered for the beginning and ending customer, the prompts for beginning and ending ship-to 
will be displayed. Also, if the user is printing MSDS sheets on-line, this report will ask the 
user whether to reprint MSDS sheets already sent. Summary sheets and cover letters (if 
used) will also print at this time. 

MSDS ID F/M (SOF905), which is used to maintain information for each MSDS ID. An MSDS 
ID must be assigned to each item in the IC Item F/M that requires an MSDS sheet as 
stipulated by OSHA standards. 

MSDS History F/M (SOF987), which is used to maintain the historical information for MSDS 
sheets sent. 

MSDS Cover Letter F/M (SOF986), which is used to enter and maintain an optional standard 
cover letter to be printed with a group of MSDS sheets. This program allows you to enter and 
maintain an optional standard cover letter to be printed with a group of MSDS sheets. Only 
one cover letter may be created. The printed cover letter includes the text entered through 
this program, with the customer and MSDS ID information needed to match the cover letter 
with the order/invoice and the MSDS sheets printed. 

MSDS Print Code F/M (SOF988), which is used to maintain the MSDS print codes. Print 
codes are only used if the method for printing MSDS sheets is on-line printing. Use the 
MSDS Print Code F/M program to maintain the MSDS print codes. Print codes are used 
during on-line printing to print sheets that are stored on the disk and were either typed or 
scanned into third-party software such as an imaging package or a word processor, e.g., 
WordPerfect. Print codes are established with a default directory path where the MSDS 
sheets are stored. Print commands (see the section on the MSDS Print Command F/M 
Program) are then assigned to each print code by warehouse to instruct the system how to 
print the MSDS sheets through the third-party software. These print codes are then assigned 
to MSDS IDs in the MSDS ID F/M to direct the system on print instructions for the MSDS 
sheets, summary sheets and cover letters (if used). These instructions are used by the 
MSDS On-line Print and On-demand Print Programs. 

MSDS Print Command F/M (SOF989), which is used to maintain the MSDS print commands 
for individual warehouses. Print commands are only used if the on-line print process is used 
for printing MSDS sheets. Use the MSDS Print Command F/M program to maintain the 
MSDS print commands for individual warehouses. Print commands are assigned to print 
codes by warehouse. Basically, a print command is a macro that initiates the third-party 
software and tells it which printer to use. 

MSDS Control F/M (SOF985), which is used to control records, by warehouse, for the MSDS 
System. These records contain information and flag settings that the MSDS programs 
reference to perform various operations. For example, when printing MSDS sheets, the 
system checks the MSDS On-line Cover Letter flag before printing the cover letter. One 
record is required for each warehouse. These records contain information and flag settings 
that the MSDS programs reference to perform various operations. For example, when 
printing MSDS sheets, the system checks the MSDS On-line Cover Letter flag before printing 
the cover letter. One record is required for each warehouse. 

MSDS History Removal (SOU930), which is used to delete MSDS history records for a 
specified range of customers and cut-off dates. 
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SO Inquiries Work Flow and Program Concepts 
The Sales Order Inquiry Menu allows you to view sales order information by customer, item 
and document. 

You can select the records for inquiry by using a filter in combination with an inquiry. The 
system then searches for records that match the conditions described by the filter settings 
and displays them for you to view. For example, you may want to view the records for 
customers that have made purchases from you after a specified date. For detailed 
instructions on setting up filters, see the FACTS Help file. 

Information for each record you select is displayed in multiple views. Each view is grouped to 
provide detailed information on a particular topic or type of information. For example, 
Customer Inquiry includes the following views: Quotes, Ship-to Addresses, Open Sales 
Orders, Blanket Sales Orders, Past Invoices, MSDS, Past Sales, Customer Notes, and 
Customer Pricing. 

Selections from the Inquiries menu are: 

The SO Customer Inquiry Program allows you to view sales order information by the 
customer selected. Available screens include: 

Quotes, which displays quote information including quote number, quote date, expiration 
date, warehouse, sales order number (if converted to a sale), the customer for whom the 
quote was made, who gave the quote and the quote total. 

Ship-to, which displays alternate ship-to information from the created in the Ship-To F/M for 
this customer. This view lists the alternate ship-to numbers, location names, contact 1, and 
phone number 1. 

Open Sales Orders, which displays sales order information including document number, 
document type (work order, invoice, credit memo, counter sale, etc.), document status (work 
order entered but not printed, work order printed, confirmed invoice, receipted invoice, 
deleted sales order, voided invoice), document origin, order priority, ship-complete status, 
invoice date, warehouse, amount, ship-to and reference number. 

Blanket Sales Orders, which displays information on blanket sales orders including 
document number, hold status, warehouse, entry date, expiration date, completion date, 
ship-to number and reference number. 

Past Invoices, which displays past invoices including SO document number, AR invoice 
number, order priority, ship-complete status, document type (work order, invoice, credit 
memo, counter sale, etc.), invoice date, warehouse, amount, ship-to and reference number. 
In the view area, select the line and choose the Line Detail button or double click on the icon 
at the beginning of that line. On the Line Detail screen for Past Invoices view of SO 
Customer Inquiry, there are 2 special buttons available above the line item browser. The GL 
Posting button is enabled when the transaction highlighted in the browser is one that allows 
for drill back from the source document to the GL posting that was created by the register. If 
the GL posting records can be found, then Journal Inquiry will display defaulting to showing 
transactions for this document only. The AR Detail button is available to view the AR 
document associated with the invoice if it is still on file. 

MSDS, which displays information on Material Safety Data Sheets (MSDS) that were sent to 
this customer. The information in the view consists of the MSDS ID and ID description, ship-
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to, date last sent, MSDS revision date and the invoice numbers with which the MSDS sheets 
were sent. 

Past Sales, which displays past sales information for each item number and description. 
Listed information consists of invoice number and date, quantity sold and the corresponding 
unit of measure, price and the pricing unit of measure. 

Customer Notes, which displays customer note information. 

Customer Pricing, which displays customer pricing information on items. Listed information 
consists of item number, item description, quantity break information, the customer’s default 
price, pricing unit of measure and item type. You can highlight an item line to and select Line 
Detail to access level pricing, contracts, and past sales information for the customer/item 
combination. 

General, which displays general customer information: name, address, customer’s price 
class, customer’s price level, commission %, off-invoice discount, ship via, UPS zone, 
contact information, and Sales Order processing options for such as payments, ledgercards, 
past sales and invoices, back orders, required POs for sales orders, and credit information. 
This information display here is entered in Customer F/M (ARF910). 

User-Defined, which displays data that appears on the User-Defined view Customer F/M 
(ARF910). 

Doc Routing, which displays the document routing information, Listed information includes 
the account, document type and description, routes, fax number and email address. 

The SO Document Inquiry program allows you to view quotes and sales order documents in 
detail by the type and status selected. The type options are: open work orders, backorders, 
invoices, credit memos, and counter sales. The various status codes include: work orders 
entered, but not printed, pick ticket printed, confirmed invoice, invoice printed, invoice 
released, deleted sales order, voided invoice. Inquiry information includes an overview of the 
document’s current status, the actual document as it appeared at time of entry (with updated 
amounts and units) and as sales orders are line-item salable, each sale per line may also be 
displayed. You can inquire by document number. Displayed information includes document 
number, type, status, and entry date, customer number and name, ship-to number, 
document total, and designated warehouse salesperson, and order priority. In Past Invoice 
mode, the AR Disputed indicator and memo also display on the main screen. In Quote mode, 
there are also a few slight differences in the screen display. 

The SO Items-in-Process Inquiry program allows you to inquire about the status of a sales 
order item. This inquiry displays in item order all the sales orders that contain the selected 
item. You choose the beginning item to view. Information includes item, document number, 
type, status, order amount, ship amount, backorder amount, unit of measure, cost and 
warehouse Inquiry information is displayed in item order and includes: item and description, 
document number, document type, status, entry date, customer number and name, 
warehouse, order quantity, shipped quantity, backordered quantity, inventory unit of 
measure, price and pricing unit of measure. 

This inquiry has a multitude of uses, but is especially useful for determining all orders and 
invoices containing a given item. By selecting the correct document types and status codes 
to display, this inquiry provides information similar to the Order Status Report by item. Of 
course, if more detailed document information is desired the actual document may be 
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displayed through the appropriate order entry program or through the Document Inquiry 
program. 

You can specify: 

• SO (sale order) or PO (purchase order) items in process for the inquiry. 

• document type(s) to display: -open orders, direct entries or confirmed orders, credit 
memos, backorders, counter sale invoices for SO documents and open purchase orders, 
backorders, and non-PO receipts for PO documents. 

• document status code(s) to display (stage in the sales orders or purchase order processing 
cycle). 

• beginning item to display. 

The SO Item Inquiry program allows you to display specific information for items in the 
Inventory File. Items may be displayed individually or sequentially. You have the option to 
display general information, packaging information, warehouse information, open purchase 
order information, , blanket sales order information, costing information, pricing information, 
interchange items, ledgercards, turn information for the past 12 periods, item notes, 
restocking, usage, receipt information, production, warehouse transfers, serial/lot 
information, vendor information, sales history information, item activity information, MSDS 
and DOT information. This inquiry is also found on the Inventory Control Inquiries Menu. 

The Rejected Lines Inquiry is only accessible if the multiple warehouses on an order feature 
is being used. This program allows you, from the initiating warehouse, to view information 
about all items on hold or rejected for shipment by the shipping warehouse. It also provides 
quick access to the document in Order Entry to change/delete the line on the order. This 
program provides information about all items on hold or rejected for shipment by the shipping 
warehouse. It also gives you quick access to the document in Order Entry to change/delete 
the line on the order. 

Use Catalog Item Inquiry to review information for catalog items within inventory. When you 
first access Catalog Item Inquiry, the upper portion of the screen contains a Go to field, 
which is used locate specific items. The Go to field is case sensitive. This means that if you 
enter i100 to lookup an item number when someone entered it as I100, the item record you 
are looking for will not appear in the browser. 

There are two views available in the lower portion of the screen: 

General--Displays the following information from the item’s master file: item class; item price 
class; vendor; vendor item; interchange item number, weight, model number and standard 
package size associated with this catalog item and the date the item was established 
(entered) in the system. 

Pricing--Displays pricing information including current and suggested list price and manual 
cost, the pricing unit of measure, the current and suggested standard price, current and 
suggested pricing for levels used by the system (1-6 as set in the IC Static Control F/M), and 
quantity break prices in both the default Pricing and Quantity Break UM (if available). 
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Document Inquiry (SOI620) Program Details 

If the View Description 1 option is "off", a memo will now display in the Full Description 
column (at the end of the browser). If the View Description 1 option is "on", the memo will 
now display in the Description column. 

For Past Documents, the line browser displays all lines that are in SOPIND table for the 
current document. Since a past document can be tied to several invoices, the browser does 
not display line (seq) numbers. You do not need to enter a line number to access line detail. 
For past documents, there is no Current mode in. 

For past invoices, you can select File>Print to access the past Invoice Print (SOC240) 
program, which allows you to print past invoices by route and warehouse. 

Sales Order Document Notes 

For open quotes and open sales order documents and past invoices, document and line 
notes are available to view or edit, based on your user security access. For past documents, 
notes are only available to view/edit (, based on your user security access) from the Invoice 
view (accessed by the Invoice button) of Document Inquiry. 

Disputed Document Indicator 

The SO Doc Inquiry in view-only Past Invoice mode provides an indicator for disputed 
documents. If any of the corresponding open invoice records in AROPEN are disputed, the 
text "*Disputed Invoice*" and memo are displayed in the upper portion of the SO Doc Inquiry 
screen.. For example, if you have an open invoice with split terms and only one of the terms 
is in dispute, the drill to SO Doc Inquiry will display the disputed indicator for both 
continuation lines. The disputed memo (50 characters) is the first encountered memo for that 
invoice (first disputed continuation). 

The AR Disputed indicator only appears in Past Invoice mode. 

Price Level Information for Line Details 

SO Doc Inquiry line detail contains a field labeled Price Origin. If Price Type is "P", the field 
contains the standard price description from the IC Static Control record. If Price Type is "L", 
the field contains the level price description from IC Static that corresponds to D3$(12,1) - 
Level field. 

Ordered Amount Column 

The Ordered amount column header displays as "Orig Ord" in Overview mode for Open 
Docs and Past Docs and displays the original ordered amount. In Current mode, the column 
displays as "Ordered’ and displays the current ordered amount. 

Source CRS/BSO Number Information 

The source CRS/BSO number appears above the Customer number on the main screen and 
in the title bar of Line Detail for Open Docs, Past Docs, and Past Invoices. The Last CRS 
appears to the right of Invoice number in Line Detail of Past Docs and Past Invoices. 

Searches 

You can search open sales order documents, past sales order documents, blanket sales 
orders, quotes or past invoices. 

Search quotes according to quote number. 
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When searching sales order documents: 

• Search open or past documents by document number. 

• Display documents in current or overview mode. 

• Search open documents by type(s) (open work orders, invoices, credit memos, backorders 
or counter sale invoices). 

• Search open documents by status code (stage in the sales orders processing cycle). 

• Search in document number or in customer number order and determine beginning order 
choice to display. 

When searching blanket sales order documents: 

• Search blanket order by document number. 

• Display documents in current or overview mode. 

• Search in document number or in customer number order and determine beginning order 
choice to display 

Note: In Blanket Orders mode only the Current view is available. 

When searching past invoices: 

• Search past documents by invoice number. 

• Display documents in actual or overview mode. 

• Search in document number or in customer number order and determine beginning order 
choice to display. 

Note: In Past Invoices mode only the Current view is available. 

UnForm Archiving Functionality 

Documents that are archived in UnForm are available for viewing from literally hundreds of 
programs throughout FACTS. Throughout the Document Inquiry view, look for buttons or 
hyperlinks that refer to Archived Doc, Archived Pick, Archived Inv, and Archived BSO to view 
the archived document that contains a line in the inquiry browser. 

SO Reports & Prints Work Flow and Program Concepts 
Most sales orders reports can be printed in different orders (depending on the information on 
the report). In addition to the order, you can choose the range to be printed. For example, on 
the Order Status Report, you may print in order number, item or customer order. If the order 
chosen is by item number, the beginning and ending item number is asked for. 

The programs available in this subsystem are: 

Quote Listing, which provides a report of quotes in quote, customer, or customer alpha order. 
You have the option to select: print order - quote number, customer number or alpha sort, 
beginning and ending order choice, beginning and ending quote date to print, warehouse(s) 
of quotes to print, route(s) of quotes to print. Information on this report is entered through the 
Quote Entry Program and can be removed through the Quote Removal Program. 
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Report totals include the total number of quotes on the report and the total dollar amount of 
quotes listed. 

Report information includes the following: 

• Summary: quote number, quote date, expiration date, customer number, customer name, 
ship-to name, quoted to, initiating warehouse code, total quote amount, and order number (if 
applicable). 

• Detail: summary plus the reference number, line-item number, item number and 
description, selling quantity and selling unit of measure, shipping warehouse, price and 
pricing unit of measure, and the line extension. 

• Detail with bill-of-material components: detail plus the items that make up each finished 
item on the quote, including the quantity per stocking unit of measure and any memo lines. 

Order Status Report, which provides a report of orders in order number, item number or 
customer number order. The user may also select a specific warehouse to print for and the 
types of orders to print (open, backorders or all). This report is especially useful in spotting 
inventory shortages and potential shortages, as well as allocating available stock. 

You can specify: print order - order number, customer number or item number, beginning 
and ending order choice and dates, item description(s) and warehouses to print, whether to 
print price information. You can print various order priorities, selecting any combination of 
normal, rush and service hold order priorities, print only open orders, back orders, or all 
orders, print the component items of bill-of-material (BOM) finished items, and print the 
report for a salesperson or all salespeople. 

The report includes the following: document number, requested date, customer number, 
customer name, item number, item description, available quantity, on order quantity, 
backordered quantity, sales order quantities, amount ordered, committed, shipped, and 
backordered, selling and pricing units of measure, price, shipping and initiating warehouse, 
order type, and an extension of the total dollar amount ordered. 

If the item is a special order then the PO/transfer information and status is printed. If you are 
printing component items for BOM finished items, they are denoted by an asterisk by the 
item number and include any memos. The order the information prints depends on the print 
order. 

Daily Shipping Report, which prints a list of backorders and work orders that have the 
requested ship date on or between the dates specified. This report should be run daily after 
the Daily Sales Register has been run. It is run prior to confirming orders for a new day to 
inform the user what should be shipped for the next day. Orders which contain no line-items 
that are available for shipment do not print. 

Important Note: In the Daily Shipping Report, even if a sales order line is tied to an open PO 
or transfer, if there is a quantity committed and the line is not ship complete, the sales order 
line prints on the report. The line is not excluded from the Daily Shipping Report if a PO or 
transfer is still open. 

You have the option to: 

• Select beginning and ending order number. 

• Select shipping warehouse(s) to print. 
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• Selected route(s) to print. 

• Select the item description(s) to print. 

• Select the beginning and ending dates. 

Report information includes the following: document number, document type, initiating and 
shipping warehouse, requested date, customer name and number, routing (if the user utilizes 
routing), whether the order is on hold, item and selected description, the document quantities 
(ordered, committed, and backordered) and the selling unit of measure, the inventory 
quantities (on hand, on order, committed, backordered) and the inventory unit of measure 
and purchase order or warehouse transfer information. The total number of documents listed 
is also included. 

Lost Sales Report, which lists lost sales by item. A lost sale is recorded when the ordered 
number is greater than the shipped number plus the backordered number; e.g., the sale was 
lost because the merchandise was not available. Lost sales are recorded when the 
backordered quantity was zero but the user did not ship all the items ordered. 

The Lost Sales Report is only available if the Use Lost Sales flag is set to Y in the SO Static 
Control Record. 

Report information includes the following: item number, item description, number of times the 
item was a lost sale (number of requests), the reason code for the lost sale, total lost quantity 
of sales, selling unit of measure, total dollar value of lost sales, and whether usage is 
updated from the lost sale for the item. Report totals include total dollar value of lost sales for 
all items in the selected warehouse and printed on the report. The total number of items 
listed is also included. 

Returns Report, which provides a listing of merchandise returns. The report prints the invoice 
number, returns code, items and cost of the items returned. This report is designed to track 
returns. It provides the user with the document information from the return, the item 
information and the return type. It also provides an optional removal. 

You can specify: order to print — item or item class, beginning and ending order choice and 
date, warehouse(s) and return code(s) to print. 

Report information includes the following: customer number and name, item number and 
description, shipping and initiating warehouse (item was returned to), returning document 
type, returns code, returning document number, return date, quantity returned and the 
corresponding unit of measure, the extended cost of the item(s) returned and whether the 
return was an allowance or return. If the return type and returns code is blank, this indicates 
the return was entered in an entry program other than the Credit Memo Entry, (i.e., Direct 
Invoice Entry, etc.). 

Outstanding Deposits report, which provides a list of documents with deposits that have not 
been applied on account or earned. An outstanding deposit is one that has not been applied 
to an account, transferred to another order, earned by your company or refunded to the 
customer. 

You can print a detailed report to see a breakdown of all the deposits customer orders or 
print a summary report if you just want know many deposits are outstanding on which 
documents and the value of those deposits. 



SO Reports & Prints Work Flow and Program Concepts  

66 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

After reviewing the report, you can determine whether you need to apply, transfer or earn the 
deposits so they can post to the Daily Sales Register. 

Direct Ship/Nonstock Report, which lists documents that contain direct shipped and/or non-
stocked items (i.e., items not in the inventory of the selected warehouse). You can specify: 
beginning and ending order date to print, warehouse and whether to print non-stocked and/or 
direct ship items. Report information includes the following: the document number, document 
type, date entered, date requested, warehouse code, order type (direct or warehouse), 
customer number, customer name, item number, description, committed, shipped and 
backordered quantities, unit of measure, and vendor number. 

Route Recap Report, which lists all the documents sold for the route, in route number order. 
This may be instrumental in approving routes so that they may be released. This report is 
only available if the Use Routes flag is set to Y in the Sales Orders Static Control Record. 

You can specify: route(s) and document type(s) to print - open orders, direct entries or 
confirmed orders, credit memos and/or backorders, and status codes to print - order entered 
not printed, work order printed, order confirmed or invoice/credit memo entered not printed, 
invoice/credit memo printed and/or invoice/credit memo released. Report information 
includes route number, route description, invoice number, type, status, customer number, 
customer name and cash and credit amounts. Report totals include cash and credit amounts 
for each route. The total number of documents listed is also included. 

Customer Price List, which prints a list of the least expensive prices of each item for the 
selected customer. The user may elect to print contract pricing only. You can specify: the 
order to print - item, alpha, vendor or item class, beginning and ending order choice, pricing 
unit of measure, customer, and whether to print contract prices only. Report information 
includes the following: the customer name, item number, item description, price, pricing unit 
of measure and basis (if selected). (If Q appears beside the price, it indicates that if pricing is 
set up by quantity breaks, the price is the best quantity break price.) 

Unbilled Freight Report, which provides a list of all invoices billed with the freight flag set to B 
for bill later. The listing displays the ship via, invoice number, and weight for each document. 
Unbilled freight is recorded during the Daily Sales Register update when the freight code is 
set to Bill later on an invoice. An optional update following printing of the report allows 
removal of all records just printed. Report information includes the following: the ship via, 
invoice number, invoice date, customer number, ship-to name and weight. 

Service Fill Report, which is used to measure your company’s level of service by evaluating 
what percentage of line items are completely filled on the first shipment to a customer or 
transfer to another warehouse. Use the Service Level Report to measure your company’s 
level of service by evaluating what percentage of line items are completely filled on the first 
shipment to a customer or transfer to another warehouse. Backorders are not considered by 
this report. 

The report can be run for one or all warehouses with a range of ship dates. It can be printed 
as warehouse totals only, in summary or with order and transfer ticket detail. The user can 
select to include orders, counter sales, transfers, or a combination orders and counter sales. 

You also can select to print the documents by customer, customer class, salesperson or ship 
date and include a beginning and ending range. For warehouse transfers, since customer, 
customer class, and salesperson do not apply, transfer tickets print in ticket number order 
unless you select to print in ship date order. For service level processing, the system 
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measures the request date against the shipping date entered in Order Confirmation to 
determine if the line item will fail for the report. This report is valid for item type S—stocking 
items only. 

Use the Past Invoice Report to retrieve sales information for as long as invoices are stored. 
You can sort invoices by Invoice, Document, Customer, Customer Class or 
Salesperson/Territory and narrow your selection with by a beginning and ending range, and 
date range. You can select an Item, Vendor, Item Class or any combination of the above to 
print only the information you desire. You can also include Ship-to-information for past 
invoices. 

Past Invoice Report Limitations/Exclusions:  

Only lines that have non-zero shipped quantities print on the report. Additionally, the 
"Restrict By" settings only apply to lines with non-zero shipped quantities. 

For this report to be useful, your system must store past invoices. Also, if past invoices were 
not stored previously but are turned on at a certain point in time, this report only displays 
information back to that point in time. 

Printing Ordered By information on past invoices 

Based on the value of Print Ordered By prompt on the Invoices tab of Document Print 
Control F/M (SOF950) and if and the ordered by field is not blank, the past invoice includes 
"Ordered by xxxxx" in the line region on the first page only. 

DOT Code Listing, which provides a list of all DOT Codes in the system. The listing contains 
the following information: DOT Code, whether the material is hazardous, hazardous material 
entry, hazardous class, UN/NA identification number, packing group, freight class, shipping 
name and optionally additional descriptions. You can specify: beginning and ending DOT 
Codes to print, whether to print only those DOT Codes that are hazardous and any additional 
descriptions of the material. The listing contains the following information about DOT Codes: 

• DOT Code • Packing group 

• Whether the material is hazardous • Freight class 

• Hazardous material entry (hazardous or reportable quantities) • Shipping name 

• Hazard class • Additional descriptions of the material (optional) 

• UN/NA identification number • 

SO Code List, which prints a listing of the various 50 codes including route and returns code. 
Each code above is entered into its own F/M program. Routes are assigned to each 
document in sales orders (if used). Returns codes are assigned to items when the 
merchandise is returned and defines why the merchandise is being returned. Return reason 
codes are assigned to items on a CR (Customer Return document) when the merchandise is 
returned and defines why the merchandise is being returned. Return disposition codes are 
also assigned to items on a CR when the merchandise is returned and defines what is to be 
done with the merchandise once it is returned. Report information includes each code and 
the information stored with the code. The total number of codes listed is also included. 

Ship Via Listing, which lists ship via codes, which are set up in the Ship Via F/M. The report 
consists of codes that meet the criteria entered in the program (see fields below), including 
whether the codes are active or inactive, whether the codes are tied to Clippership and 
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whether they are commercial or residential. The report also shows the freight GL number 
associated with the code and the handling charge amount, if any. All of the information 
provided in this list is derived from the Ship Via F/M. 

Order Activity Cost Code Listing, which lists all the different types of order cost activities. The 
report lists the cost code, the cost type, the document type, the warehouses the cost applies 
to, the cost dollars, and whether it applies to direct ships, if applicable. 

Customer Order Profitability Analysis Report, which applies the costs recorded in Order Cost 
Activity F/M to the customers by the volume of their orders. For backorders, the order level 
cost will not be applied. Backordered counter sales will be treated the same as backordered 
sales orders for calculating costs. 

Customer Order Profitability Analysis Report Details 

• BOM items will be handled as a single item if it updated the finished item, and will be 
treated as multiple items if it the components were entered/updated on the Sales Order. 

• Calculations for the report will include: gross profit, cost to serve (all document costs based 
on the cost codes defined above), and net profit contribution (gross profit less cost to serve). 
It is the net profit contribution that will be used to sort in descending order if selected. 

• Gross Profit will be calculated by taking price minus cost times quantity on each line that 
qualifies to be included in the report. Then order costs will be applied. Order type costs will 
only be applied if the initiating warehouse is included in the warehouses list. Warehouse and 
line type costs will only be applied if the shipping warehouse is included in the warehouses 
list. All flags in the cost type file will be considered before applying the cost. 

Order Booking Report, which is used to review booked orders and print them for tracking 
purposes of tracking. You must set the Order Booking flag on the Use tab of SO Static 
Control F/M to indicate how many months to store order booking information. To ensure 
additional accuracy, the Order Booking Report is based on the system date (not the FACTS 
date). The End-Of-Period Update (SOU890) program also uses the system date for Order 
Booking processing. 

Order Booking Process Description 

The system books orders in the following ways: 

• Orders are booked through SO Order Entry. 

• In Quote Entry, quotes can be converted to orders by setting the Conv Stat flag to "Y" for a 
line(s) and enter "Y" at the Convert quote to sales order prompt in the Order Entry footer. 

• Recurring documents are entered in Recurring Document Entry with posting dates. When 
you run the Post Recurring Documents program, it creates orders for those source 
documents that are within the posting range. 

• Blanket orders are entered in Blanket Order Entry. When you run the Blanket Order 
Release Register, it creates orders for the source documents that meet the specifications. 

The system considers an order as edited if the initiating warehouse, document total, total 
cost, or primary/secondary/inside salesperson contains a net change. If you change an order 
and then change the order again in manner that does results not result in a net change of 
information, the system does not consider the edit for order booking tracking. For example if 
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modify the document total, total cost, or primary/secondary/inside salesperson and then 
change the information back, the system does not record the change.. 

However, if an order is changed then deleted in the same session, the system tracks only the 
deletion. 

The program provides many report criteria options to allow for tailoring the report. You can 
print booked orders, orders that have been entered through various methods in the SO 
module (excluding direct invoices, credit memos, and counter sales) and edited orders, 
orders that have been changed and/or deleted. 

The information and report selection available pertaining to Salesperson is determined by the 
Inside/2nd Slsp flag set in SO Static Control F/M. Information prints for the inside 
salesperson only if the Inside/2nd Slsp flag in SO Static Control F/M is set to "I" or "B". 
Information on second salesperson prints on the report if the Inside/2nd Slsp flag is set to "2" 
or "B". In addition, the report selection based on a salesperson only applies to the current 
salesperson at the time the report is printed. 

Limitations/Exclusions 

• The Order Booking Report does not report on direct invoices, credit memos, or counter 
sales where items can be committed and not shipped. 

• The report does not reflect anything that takes place during or after confirmation of the 
original order. 

• Once an order is confirmed, order booking no longer tracks the order, so changes to or 
deletions of backordered documents are not tracked. 

• CRS-generated orders will not be included since they usually contain replacements and not 
new sales. 

• The system does not track the original (source) entry of blanket orders and recurring 
orders. However, each order created by a source blanket or recurring order is included in the 
report. 

• The report information is displayed by order, not by line-item. 

• If the Lifo/Fifo costing method is used, the cost and GM at the time of the original entry 
prints on the report. The report is not updated by final cost. 

• Order booking records will only be created for new documents. Changes made to orders 
that already existed before order booking was turned on will not be tracked. 

End of Period Work Flow and Program Concepts 
The End-of-Period Menu contains programs that should be run at the end of each Sales 
Orders period in order to close it correctly. 

You can access the following programs from the SO End of Period menu: 

The Period Sales Register prints a recap of all the Daily Sales Registers run for the period 
listing a total for the period at the bottom. If used, the Daily Sales Registers recaps are also 
listed by salesperson, terminal, terms code, warehouse and/or department. The optional 
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removal should be run to remove all registers for the start of the next period. An optional 
update following register the register print allows removal of all records just printed. The data 
for this program is the Daily Sales Register totals since the last Period Sales Register update 
was run. This data is stored in the Sales Orders Period Sales File. 

This program is only used if the Use pd sales register flag is set to Y in the Sales Orders 
Static Control F/M. 

Period sales register information by Daily Sales Register includes register date, register 
number, number of invoices, merchandise amount, miscellaneous amount, discount amount, 
cost, margin, tax, freight, cash sales and total register amount. Totals are included for all 
fields for all Daily Sales Registers appearing on the report. 

The End-of-Period Update zeros out the monthly recap figures and increments the current 
sales orders period by one. Use the End-Of-Period Update program to close the current 
sales orders period by resetting the current period and removing Daily Sales Register recap 
period-to-date information. 

Order Booking Processing: 

When determining if a document’s order booking records should be removed, the system 
only considers the document’s create date. In other words, if the create date is within the 
date range, the system removes all of that document’s order booking records–-even if the 
edit dates are not within the date range. However, the system first checks to see if the sales 
order is still open. If the order type is "O" or the status is "E" or "W", then the system does 
not remove the document’s order booking records 

If the Order Booking flag is set to "Not used" in SO Static Control F/M, the next time the end 
of period update is run, the system purges all order booking records for the current company. 

File Maintenances Work Flow and Program Concepts 
The File Maintenance programs allow you to enter, change and delete data. These programs 
are used to enter the initial data required to set up the system. You can also add, change 
and delete the records in a file. 

File maintenance programs create the foundation of the FACTS system. They enable users 
to enter file information (such as customer, item and vendor files) and control how the 
system processes information, as in SO Static Control. 

File Maintenance programs are also referred to as F/Ms for short, these programs often 
function the same way. 

You will use some file maintenance programs, such as Vendor/Item F/M, more often than 
you use others. In fact, some file maintenance programs, such as SO Static Control F/M, are 
only used during installation. These programs are accessible from the Infrequent File 
Maintenances menu. 

The following file maintenances can be accessed from this menu: 

Past Sales F/M (SOF910), which is used to maintain records in the Past Sales History File 
during initial installation and setup. If past sales history is stored, three records are stored for 
each customer/item combination. 
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You should enter data manually in this program only when setting up the original customer 
and item information. Thereafter, it is updated by the Daily Sales Register update. Any 
changes you make via this program after the system is operational may compromise data. 

NOTE: Entering original information into this file is optional. Past sales information may be 
displayed using the sales orders Customer Inquiry Program. Records may be removed from 
the Past Sale File using the Past Sales Removal Program. 

Before using this program, the Use Past Sales flag the SO Static Control Record must be set 
to Y. The Store SO Sales history flag in the Customer File must also be set to Y for the 
customer selected. 

Sales Register Recap F/M (SOF920), which is used to create and maintain records in the 
Sales Register Recap File. Initially, the system does not use this program, and the file is 
empty. Records are created depending on the recap settings in the SO Static Control 
Record. If the DSR Recap MTD flag is set to Y in the SO Static Control Record, information 
in this file is used to print the Period Sales Register and the period-to-date information on the 
Daily Sales Register. 

Lost Sales F/M (SOF930), which is used to enter lost sales information during initial 
installation and setup. Thereafter, it is updated by the Daily Sales Register update. Any 
changes you make via this program after the system is operational may compromise data. 

NOTE: Entering original information into this file is optional. 

Lost sales are recorded during the Daily Sales Register update when the backordered 
quantity was 0, but you did not ship all the items ordered. For example, if the customer 
ordered 5 and the shipped quantity was 3 and the backordered quantity was 0, then the lost 
sales would record 2. 

Lost sales information may be displayed by printing the Lost Sales Report. Records may be 
removed from the Lost Sales File using the optional removal at the end of the Lost Sales 
Report or through the delete option in this file maintenance. 

Before using this program, make sure the Use Lost Sales tracking flag is selected or set to Y 
in the SO Static Control F/M. 

Unbilled Freight F/M (SOF940), which is used to create records in the Unbilled Freight File 
during initial installation and setup. The program should only be used once to enter original 
start-up information. Thereafter, the Daily Sales Register updates this information. Any 
changes made to this program after live processing begins may compromise data. 

NOTE: Entering original information into this file is optional. 

Unbilled freight is recorded during the Daily Sales Register update when the freight code is 
set to B-bill later on an invoice. 

Unbilled freight information may be displayed by printing the Unbilled Freight Report. 
Records may be removed from the Unbilled Freight File using the optional removal at the 
end of the Unbilled Freight Report or through the delete option in this file maintenance. 

DOT Code F/M (SOF530), which is used to create and maintain Department of 
Transportation (DOT) Codes for hazardous materials. All materials that the DOT deems 
hazardous must have a DOT Code assigned to it. For more information on hazardous 
materials and regulations, please refer to the DOT’s Hazardous Materials Guide. 
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Each DOT Code can be assigned to an unlimited number of items in Item F/M. 

Remote Customer/User F/M (SOF540), which is used to maintain information of customers 
who use the Remote Order Entry System. This program provides crucial data identifying the 
remote user as a customer instead of a standard user as well as other information on the 
user. Enter all data relevant to your requirements for security and controlled access. 

Note: It is not the responsibility of Infor to support, maintain or recommend any software or 
hardware to be used to maintain the connection between you (the distributor) and your 
remote customer's computer. Please consult with your hardware/software supplier for 
specific recommendations for your installation. 

If you are inquiring on an existing remote customer, enter the customer’s number and select 
the Customer Activity tab to view the following information: 

• Month-to-date sales 

• Year-to-date sales 

• PYR sales 

• Last sign-on date 

• Last date an order was entered 

Resetting Failed Logins:  Remote user login attempts are tracked and processed using 
settings from System Control F/M just like all other user accounts. Select the Security tab of 
System Control F/M and set the Invalid Login Attempts field 0. Then select the General tab 
and deselect the Disable Login flag for this user. 

Customer Item F/M (SOF545), which is used to set up cross-references for the item numbers 
that customers use to ID items and the item codes used in FACTS. Both the customer item 
descriptions and the standard FACTS item descriptions print on pick tickets and invoices. 

eCatalog Note: When a customer item is added or the description is changed, the system 
adds a record to the eCatalog log file for the next update to the eCatalog database. There is 
currently no way to remove a Customer item record from eCatalog. However, when a 
Customer item record is deleted, any unprocessed records for this transaction will be 
removed from the log file. The system sends All customer items to eCatalog. 

Companion Item Entry (SOE150), which is used to designate item to import when a specified 
item is entered in Order Entry, Quotes, Confirmation, Direct Invoices or Counter Sales. You 
can indicate whether the import of items/memos is automatic or prompted for each Order 
Entry program type. 

Companion Item Processing 

In the Order Entry program suite when a line item is originally saved, the program checks to 
see if there is a Companion Item header record for the item number that has been saved. 

The Companion Item Entry (SOE150) program allows you to select whether the import of 
items/memos is automatic, prompted, or not applicable to the entry program. If any 
companion items/memos are flagged as "Y-Default to Y" or "N-Default to N," you have the 
option to select any of the companion items/memos available. If any companion 
items/memos are flagged as "A – Automatic Add" then if any additional companion 
items/memos are flagged as Y or N, then all items/memos that are A, Y and N will be 
displayed in the Companion Item Selection (SOE151) dialog box. A for Automatic Add will 
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always add automatically to the document. If all companions applicable for this order type 
are flagged as A and there are no Y or N flagged items/memos, then no dialog is displayed 
and those items/memos will be automatically imported into the document (unless there’s an 
exception that requires user attention, like the item not being setup in a warehouse). If any 
companion items/memos are flagged as "X – Not Applicable" then they will not be displayed 
in this dialog and will not allow import into the actual document. Once the companion 
items/memos are selected the items will be imported into the document. 

eCatalog Note: When a companion item is added and the Companions to eCatalog 
checkbox on Company Control F/M is selected, the system adds a record to the eCatalog log 
file for the next update to the eCatalog database. There is currently no way to remove a 
companion item record from eCatalog. However, when a companion item record is deleted, 
any unprocessed records for this transaction will be removed from the log file. Companion 
memo lines do not upload to eCatalog. 

Limitations and Exclusions 

• Companion items will not be searched for bill of material components. 

• Companion items will only be searched from Quote Entry, Sales Order Entry, Confirmation 
Entry, Direct Invoice Entry, and Counter Sales Entry. 

• In the event of a substitution, the companion items for the substituted item will be used, not 
the originally entered item. 

• Companion item selection will be single level only. If a companion item is selected and 
there are companion items for any of the selected companion items, the selection process 
will not include the companions to the companions. 

• Companion items will not be searched when negative quantities are entered on the 
document. 

• If companion items were selected on the save of a line item and the original line item is 
subsequently deleted, the companion items selected will not be automatically deleted. 

• Companion items will only be searched when initially adding or inserting a line. 

• Companion items or memos will not be able to be setup for memo lines. 

• Temporary items may not be setup as companions. 

Use Freight Schedule Entry to set up various freight rate schedules that can be used in 
FACTS to calculate the freight charges on an order. The freight rates can be calculated by 
total order weight, total order value or total item value 

Use the Ship Via F/M program to create and maintain ship via codes. Ship via codes are 
used throughout the system to indicate which carrier will ship an order. 

The codes are created according to warehouse to allow for the following: 

• different warehouses posting freight to different General Ledger numbers 

• different warehouses charging different handling fees or not charging them at all 

• not all of your warehouses use Clippership 



Infrequent File Maintenances Work Flow and Program Concepts  

74 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

Infrequent File Maintenances Work Flow and Program 
Concepts 
Infrequent file maintenance programs are used most often during initial system installation 
and setup; they primarily allow you to control overall operation of other programs in the Sales 
Orders Modules. Once set up, these programs are often maintained by the system and rarely 
require editing. However, if you are not getting the desired results from entry programs, 
reports or inquiries, certain file maintenance programs may need to be modified. 

You can access the following file maintenance programs from the Sales Orders Infrequent 
F/M subsystem: 

The Document Print Control F/M program allows you to set up and maintain the print 
parameters for quotes, pick tickets, invoices, counter sale slips and bills of lading. It should 
be set up prior to using the Sales Orders system. Defaults in this program are set to 
accommodate the preprinted FACTS forms, which users can purchase separately from Infor 
Forms division. (Sample forms were included with the FACTS New User Packet.) If your 
company uses its own preprinted forms, modifications may need to be made to the various 
programs that affect quote, pick ticket, invoice and counter sales printing. If this is the case, 
contact your Affiliate. Preprinted forms are not necessary, however. Samples of non-
preprinted outputs are included in the PDF Documentation Library. Also, contact your 
Affiliate to see if UnForm software meets your needs. 

Route F/M, which is used to maintain delivery route information for use in various order and 
invoice headers. This feature is helpful to users who offer delivery services. If you offer 
delivery services, the Route F/M program enables you to create and maintain delivery route 
codes and corresponding descriptions. If routing is not used, (the Use Routes flag in the SO 
Static Control F/M is set to unselected), this program may be skipped. 

If your system is set up for routing, each customer is assigned a default route based on the 
information set up in this file maintenance. That customer’s default route appears on all 
quotes, orders and invoices created for that customer. Orders and invoices may then be 
printed according to routes. These orders or invoices are usually sent out with the 
merchandise on delivery trucks. 

NOTE: Invoices sent out with deliveries do not print on the Daily Sales Register (that is, post 
to the Accounts Receivable File) until the route has been released (or approved) in the Route 
Release program (SOU310) under the Invoices menu. For example, on Tuesday, a truck 
goes out with TUE route invoices. When the Daily Sales Register is printed on Tuesday, TUE 
invoices do not appear because the Route Release Program has not been run for route TUE. 
This is because the TUE invoices are still on the delivery truck and some merchandise might 
be refused; some corrections may have to be made to the TUE invoices before updating 
them to Accounts Receivable. Only after the truck has returned with the invoice slips and the 
corrections have been made to these invoices should the TUE route be released. Once 
released, the Tuesday invoices will print on the next Daily Sales Register and post to AR. 

Use the Deposit Earned Reason Code FM program to set up one or more two-character 
reason codes, their descriptions and corresponding General Ledger numbers to handle 
instances in which deposits are earned (e.g., a customer cancels a special order after the 
order arrives). Reason codes work something like terms codes in that they provide a 
description of the transaction and indicate to which GL account the transaction should be 
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posted. Deposit Earned Reason Codes are used in SO deposit entries, which can be 
accessed from several of SO entry programs. 

Returns Code F/M, which is used to manage codes used in Credit Memo entries that 
determine whether goods sent back by the customer, should be entered as returns or 
allowances. Use the Returns Code F/M program to create and maintain a list of returns 
codes that the systems uses to determine if goods returned should be categorized as returns 
or allowances. Returns codes are entered in the Credit Memo Entry program. 

If the goods are a return, then on-hand quantities are updated in the Credit Memo Entry 
program. If the goods are an allowance, no inventory quantities are updated. Both returns 
and allowances are posted to the General Ledger based on the GL numbers assigned to 
them in the SO to GL Posting F/M. 

Package F/M, which is used to calculate and maintain dimensional measurements of 
shipping containers, based on UPS definitions (not used in systems integrated with 
Clippership). Use the Package F/M program to calculate and maintain dimensional 
measurements of shipping containers if your system is not integrated with the Clippership 
shipping software. The dimensional weight, as defined by UPS, is used when shipping 
packages measuring more one cubic foot via UPS Next Day Air or 2nd Day Air. If the 
dimensional weight is greater than the actual weight, the dimensional weight is used to 
calculate shipping charges. 

The calculation used to determine dimensional weight is 

length x width x height 

194 (dimensional weight factor) 

NOTE: If a package is a non-rectangular shape (such as a drum or sphere), use the 
dimensions of the smallest rectangular box in which the object can fit. 

If calculated dimensional weight applies, it displays on screen. 

Shipping Control F/M, which is used to set up the defaults used in Freight Entry and contains 
flags that affect C.O.D. label printing and UPS Weight F/M (not used in systems integrated 
with Clippership). The Shipping Control F/M program allows you to create and maintain the 
Shipping Control Record, which consists of UPS rates and weight limits. If your system is 
integrated with Clippership, you will not need to edit this program. 

The Shipping Control Record stores the defaults used in Freight Entry, the flags for the 
C.O.D. label printing and the UPS Weight F/M. 

As UPS changes its rates and weight limits, use this enter the new amounts in this program. 

If you have a package configuration (weight and value) that is used often, its information can 
be set up in this program as the defaults for weight and declared value in the Freight Entry. 

NOTE: The Freight Subsystem has been approved by UPS as a host computerized manifest 
system. However, each user will have to contact the appropriate UPS representatives and 
get their approval as well. Also, FACTS can use other carriers/freight companies; just enter 
their information instead of the information from UPS. 

UPS Weight F/M, which is used to store UPS weight tables for users who wish to add UPS 
charges into freight (not used in systems integrated with Clippership). Use this program to 
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create, maintain and view the UPS weight tables (if applicable). If UPS charges are not to be 
implemented into the freight, then this program may be skipped. 

The weights table chart is given to the user by UPS. The user is responsible for creating and 
maintaining the UPS weight tables with this program by entering the charge assigned by 
UPS for the selected zone and displayed weight. The weight tables should be entered 
directly from the UPS weights table. Charges for air letters are also entered in this program. 

FACTS ships with the weights and zones for the 48 contiguous states current as of February 
8, 1999. Users outside the 48 contiguous states must enter the rates that apply to them. 

UPS Zone F/M , which is used to set up UPS zones by warehouse for users who wish to add 
UPS charges into freight (not used in systems integrated with Clippership). The UPS Zone 
F/M program allows you to create and maintain the UPS zones (if applicable) by warehouse 
location. The UPS zone determines the cost of shipping a package from the warehouse to 
the desired location. You can skip this program if you use the Clippership software package 
or if you do not include UPS charges in the freight. 

To create zones in this program, enter the beginning and ending zip code (first three 
characters) and the zone for the codes as assigned by UPS. The zones should be entered 
directly from the zone chart provided by UPS. 

Entries are only applicable for ground and 2nd day air zones in the domestic United States 
(2-8, 12, 14, 15, and 16). A note displays at the bottom of the screen indicating the proper 
setup for Alaska, rural Alaska, Hawaii and Puerto Rico. 

Lost Sales Reasons Code F/M, which is used to manage user-defined reason codes used in 
order entry to track lost sales. Use the Lost Sales Reason Codes F/M program to enter, 
change, and delete lost sales reason codes. A Lost Sales Reason Code is a three-character 
code that indicates why merchandise was not sold (e.g., out of stock, extended lead time, 
found better price, etc.). The purpose of this code is mostly informational. It does not affect 
the General Ledger. 

Warehouse Code F/M, which is used to indicate which users can access the initiating or 
shipping warehouse in the Order Entry Program. The Warehouse Code F/M is a security 
program that gives warehouse managers control over who has access to their warehouse 
stock. It is one of several programs used to set up multi-warehousing capabilities and 
controls. See also Warehouse F/M and Warehouse/Item F/M. 

By default, the approval process for releasing an item so that it can be shipped from a 
warehouse is enabled for all users, unless the option to allow items shipped from other 
warehouses is set to unselected or the SO Static F/M flag Use Multiple Warehouses in SO is 
set to unselected. 

Users can be authorized to initiate orders from a warehouse, and they can be given rights to 
ship from warehouses. Users without initiating rights in a warehouse will not be able to 
create orders, invoices or perform counter sales from that warehouse. Users without 
shipping rights in a warehouse will not be able to confirm orders in that warehouse. 

Once line items have been entered in a sales order, the initiating warehouse may not be 
changed regardless of authorization level. You can access this program from the Users 
button in Warehouse F/M (ICF970) or from SO Infrequent File Maintenances menu. 

Terms Code Order Setup, which is used to manage the display of multiple terms codes in the 
ending routines of direct invoice and counter sale entries. Many of the SO Entry programs 
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allow you to enter multiple payments. The Terms Code Order Setup program allows you to 
create and organize the list of terms that you want to appear in the footer of invoice, counter 
sale, order confirmation, service order and credit memo documents. 

The six two-character terms codes must already be set up in the Accounts Receivable Terms 
Code F/M program (Accounts Receivable > Infrequent F/M > Terms Code F/M). The 
descriptions that follow the codes are user defined (up to 10 characters). Once entered, 
terms codes and their descriptions can be inserted, moved or deleted. Press F3 to save 
changes and exit, or press F4 to abandon changes before you exit the program. 

Order Activity Cost Code Entry (SOE620), which is used to enter cost codes; you can use 
cost codes to associate cost activities with orders, shipping warehouses, or order lines. The 
Order Activity Cost Code Entry program allows you to enter cost codes. You can use cost 
codes to associate cost activities with orders, shipping warehouses, or order lines. A cost 
activity is an activity that requires the resources of the company and is not included in the 
cost of goods. Examples of cost activities are picking orders, expediting orders, collection 
calls, and so on. 

After you enter cost code, use the Order Cost Activity Report to list all the different types of 
order cost activities and the Customer Order Profitability Analysis report to identify and rank 
customers by cost activities to examine the net profit contribution each customer is 
associated with. 

SO Entry Options F/M, which is used to define which header prompts users can edit in SO 
Order, Credit Memo, Invoice and Confirmation Entry programs. This file maintenance builds 
on flags formerly available in the SO Static Control F/M in FACTS 6.06 and earlier. SO Entry 
Option settings are not user-specific; they affect all SO Order Management Suite users. 

In this program, you define whether header, line item entry and footer inputs are: 

• required to complete a document and whether they should appear on the main screen. 

• not required. 

• can be initially skipped, but can be edited later if necessary. 

You can also select which totals appear on the entry screen, set item browser flags to 
indicate backordered items, temporary items, non-stock items, as well as direct ships and 
items shipping from alternate warehouses, and set the notes pop-up display for item and 
customer notes. 

Programs that can be modified through this file maintenance are 

• Quote Entry 

• Order Entry (also modifies Service Order Entry) 

• Credit Memo Entry 

• Order Confirmation 

• Direct Invoice Entry 

• Counter Sales 

The Quote Entry option to recalculate user-overridden costs for items when a quote is 
imported to another quote or converted to a sale order is controlled through the SO Static 
Control F/M 
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Ship Via F/M, which is used to create and maintain ship via codes and link those codes to 
Clippership carrier codes if FACTS is integrated with the shipping package. 

Document Import Control F/M program, which is used to set up and maintain a record for 
each importable document type, including Quote, Open Order, and Past Documents. 

SO to GL Posting F/M, which is used to determine how the Daily Sales Register posts to the 
General Ledger? The SO to GL Posting F/M program enables you to determine how sales 
orders, via the Daily Sales Register (DSR), post to general ledger (GL), if at all. It contains 
information (such as journal and account numbers) that the system references in performing 
the automatic posting of SO Daily Sales Register data to the General Ledger during the Daily 
Sales Register Update. This program only allows you to use General Ledger numbers that 
are already set up in the General Ledger Account F/M program. Do not make changes to this 
program without the approval of your company’s Accounting Manager or Controller. 

Static Control F/M, which is used to control how Sales Order programs process information 
for you. For example, you can set up or disable the system’s ability to use contract pricing, 
invoice history or line discounts, or allow backorders in order entry programs. The 
information in the Static Control F/M stays the same. The Static Control F/M consists of 
many flags and entries that activate or deactivate many of the features available in the Sales 
Order module. For instance, from this program you can determine whether or not to use job 
costing, past sales, cash drawer handling and quick customer creation, just to name a few of 
the possibilities. This program also enables you to show or hide certain header and line-item 
entry prompts for during entry in Blanket Sales Orders, Recurring Invoices, and the 
Customer Returns System. 

CAUTION! It is strongly advised that a password be employed on the Nonstatic Control F/M 
and Static Control F/M programs. Changes should be made only with extreme caution and 
under the supervision of your Affiliate. 

Nonstatic Control F/M, which is used to maintain flags that the system updates periodically, 
such as the current Sales Order period, last quote number and date of last release register. 
The SO Nonstatic Control Record is critical to the proper functioning of the SO System. The 
record contains information that the SO System references in performing various functions. 

Rebuild SO Sort Files, which is used to clean out faulty data in the sort files that may have 
been caused by system crashes. FACTS Affiliates should run this program, rather than the 
end user. Sort files are an alternate sort order of another file and used throughout FACTS so 
users can report or retrieve information in an order other than the order in which the main file 
is stored. For example, the records of the Customer File (ARCUST) are stored in customer 
number order. To access this file in alphabetical order requires a sort file (ARCALX), which is 
stored in customer number by alpha lookup order. The corresponding record in the main file 
may then be accessed for the needed information. The Rebuild SO Sort Files Program offers 
a way to "clean up" these alternate files, but it should only be run under the supervision of 
your Affiliate. 

Remote Order System Work Flow and Program Concepts 
The Remote Order Entry (ROE) subsystem is an optional feature of the FACTS system. The 
ROE subsystem provides a way to allow customers to log onto the system and enter their 
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own orders directly, using their own item numbers. Remote users can also inquire upon the 
status of their quotes, open orders, past invoices, and other historical sales information when 
applicable. 

You can access the following programs from the Remote Order Entry menu: 

Remote Order Entry, which is used to enter new sales orders and edit pending orders. Note: 
Orders that have been accessed by the distributor cannot be changed or deleted. You must 
call your distributor (system administrator) to have these orders changed or deleted. 

The Remote Order Entry screen consists of three sections: 

• header, containing order number, request date, etc. 

• line-item detail, containing the items, quantities, etc. 

• footer, which consists of the final fields prior to completion of the order. 

Remote Customer/Item File Maintenance., which is used to create and maintain item 
numbers to be used in the Remote Order System. Use the Remote Customer/Item File 
Maintenance program to create and maintain links between the standard system item 
numbers and the item numbers to be used in Remote Order Entry. Linking the customer item 
numbers to a standard system number makes it easier to search for items by using item 
numbers that are easily recognizable versus item numbers that the distributor uses. 

• Customer Inquiry, which is used to perform system inquiries for quotes, open sales orders, 
past invoices, past purchases, pricing, ship-to’s, notes, and MSDS information (when 
applicable). 

• Sales Analysis Customer Inquiry, which is used to perform system inquires into sales 
analysis information for customer/item numbers month-to-date and year-to-date activity. 

General Message Entry, which is used to send messages to your distributor’s contact. 
Remote users can use the General Message Entry program to communicate to with the 
distributor via the mail message system. Accessibility to this system may be restricted 
depending on how your distributor set up its system. 

Note: It is not the responsibility of Infor to support, maintain or recommend any software or 
hardware to be used to maintain the connection between the host system (the distributor’s 
computer) and the remote user. 

Signing onto the ROE system 

From the Sign-On Screen, follow these steps to sign on to the system and access the 
Remote Order Entry Menu. 

1. User Code 

Enter your user code or press F4-Exit to exit the system. If an incorrect entry is made, press 
CR to reenter the code. 

Password 

Enter your password or press F4-Backup/Exit to backup/exit the system. The password will 
not display on screen. If a remote user makes an incorrect entry, press Enter (CR) to reenter 
the password. 
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Note: If at any time during the sign-on process you see the message Contact the system 
administrator - code XX, please make note of the code number and contact your distributor. 

Signing off of the ROE system 

From the menu system, type "OFF" and press Enter (CR). 
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Chapter 3 Sales Orders Transaction 
Procedures 3 

 

 

General Procedures  

Creating document numbers 
The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the customer’s name. 
You can also assign a document number manually if you prefer. 

To assign document numbers manually: 

1  Open the Sales Order Entry program. 

3  Choose File>New Document Number from the menu.  

4  Enter up to six characters to create a document number. Choose OK or press CR. 

5  Begin entering the order, starting with the Customer Number. 

Opening existing documents 
Access an existing document before you begin entering a new one. Once you begin entering 
header information, the system does not allow to you open a document in the same window. 
You can also start another session of FACTS if you need to open a document while you are 
in the middle of entering one. 

To open an existing order: 

1 Enter the document number in the Customer Number field and press Enter (CR). If the 
document number is on file, the customer number appears in the field and the document 
number appears in the title bar. 

OR 

6 Choose File>Open Existing Document.  

7 Use the Document Search window to find the document you want to edit or review. 
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8 Choose OK in the search window to select the document and return to the main entry 
window. 

Deleting an order 
When you delete a sales order document, the document is not technically deleted from the 
system until the next Daily Sales Register Update. Until then, the header status changes to 
Deleted and the system removes all line items. This procedure enables the system to keep 
an audit trail of all the order numbers used.  

To delete an order before the header is complete: 

Press F4 to back up to the Customer Field. 

To delete an order after the header is complete: 

With the document open on screen, 

Choose File>Delete Document from the menu. 

To edit an existing line item 

Use your mouse or arrow keys to highlight the line in the item browser and press Enter (CR).  

OR 

Highlight the line and press Line Detail to access fields that do not appear in the line-item 
entry section.  

To delete a line 

Use the mouse or arrow keys to highlight the line in the item browser.  

Press the Delete key on the keyboard, or choose Edit>Delete Item from the menu. 

Inserting a line item or memo line 
Use the mouse or arrow keys to highlight a line. The program inserts the new line item above 
the selected one. 

Press the Insert key or choose Edit>Insert Line from the menu. 

The program stays in Insert mode until you press F4 from the Item Number field or choose 
the Cancel button at the right of the screen 

Finding an item in the item browser 
This feature may be helpful when you need to find an item you entered on a long order. It 
eliminates the need to scroll up and down in the list browser. 
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Choose Edit>Find Line Item from the menu.  

Enter the item number you want to locate. Press CR to go to the first occurrence of that item 
in the item browser on the main screen. Press F2 to find a different item or F4 to exit the Find 
Item window. 

Adding a line item (Using the Line-Item Entry fields) 
1 Select add in the line item browser or choose the Add button at the right of the screen. 

2 The program automatically switches to add mode once you complete the header. This 
means the cursor appears in the Item Number field after you exit the last header field. 

3 The program stays in add mode until you press F4 to back out of the line-item entry 
section or press the Cancel button at the right of the screen. 

4 Quick entry tip: Enter the item number, the ordered quantity and then press the down 
arrow key (ê).  

5 The program inserts the default information in the rest of the line-item entry fields and 
returns to the Item Number field. 

Warehouse Enter the shipping warehouse for the line item. The default will be the 
initiating warehouse of the order.  

Press F2 to search for available warehouses for the item. The Search 
Warehouses window displays the warehouses that have the item, along 
with the available, on hand and on order quantities for the unit of 
measure selected.  

Item number Enter an item number manually or press F2 to select one from the Item 
Search.  

Enter M to enter a memo line. 

Choose the Options menu to access Catalog Item Search, Customer 
Item Search, Past Sales Search, and several other searches. 

Choose the View menu to access Item Interchanges. 

Ordered Enter the customer's requested quantity.  

Press F2 to change the unit of measure on the ordered quantity. 

Press F3 to indicate this item is a direct ship. Enter or search for a 
vendor code. Later in the order you can press F3 again to toggle back 
to a warehouse ship. 

If the quantity entered exceeds the available inventory in the selected 
warehouse, the program gives you the option to accept the quantity 
anyway by pressing Enter (CR) or F4 to return to the Ordered quantity 
field.  

Committed Enter a quantity to commit in the warehouse or accept the default. 
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This field defaults to the quantity ordered, if that quantity is available in 
the selected warehouse.  

Backordered Enter a backordered quantity if the quantity ordered is greater than the 
available quantity in the selected warehouse.  

When you enter a backordered quantity, Sales Order Entry programs 
base suggested document creation on the Stock, NonStocked, 
Uninventoried, and Temporary prompts in Sugg PO/TR by Type 
section on the Line Options tab of SO Entry Options F/M (SOF915). 
Use these settings to indicate whether you want to have the system ask 
to create suggested purchase orders or suggested transfers by item 
type during Order Entry line processing. Refer to the Suggested 
Transfer/Purchase Order Creation from Sales Order Entry Programs 
topic for detailed information about creating suggested warehouse 
transfer or purchase orders for backordered quantities. 

The program skips this field if: 

The customer does not allow backorders (Allow backorders flag not 
selected in AR Customer F/M). 

Your company does not allow backorders (Allow backorders flag not 
selected in SO Static Control F/M). 

The item is a direct ship. 

The selected warehouse has enough inventory to fill the order. 

If the backordered and committed quantities do not add up to the 
ordered quantity, the entry program forces an adjustment. 

Price Enter a price or press F3 to select one from the Price Search window.  

A letter appears after the pricing UM to indicate which pricing option you 
selected. S-Standard, C-Contract, D-Default, T-List, L-Last, L#-Price 
level, Q#-Quantity break, U-user override – you keyed in a price. 

Press F2 to change the pricing unit of measure. 

Standard Sales Orders Procedures 
This section covers standard procedures to be followed for Sales Orders. These procedures 
may vary depending on how the company’s business is conducted. The following three 
sections of standard procedures are provided as a guideline: 

Recommended Operating Procedures for Sales Orders 
An outline is provided of routine procedures on a daily, weekly, period (month, if 12 periods 
are used) and yearly basis. 
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* indicates the procedure is required and must be performed in the time period designated 

Daily Procedures (or as needed) 

1. Print Daily Shipping Report 

2. Run Commit Backordered Quantities Program or run whenever new inventory is 
received into the system. 

3.  Enter/print quotes 

4.  Enter/print blanket sales orders 

5.  Print/update BSO Release Register 

6.  Enter/print work orders (picking tickets, packing lists) 

7.  Confirm orders 

8.  Enter/print invoices, credit memos 

9.  Enter/print counter sales 

10. Enter shipping information through Freight Entry/Print necessary shipping labels/ 
Print/ Manifest update after packages have been shipped. 

11. Run Route Release Program 

12. Maintain contract prices 

13. Run Post Recurring Documents Program 

14. Print/update Daily Sales Register. 

Weekly Procedures (or as needed) 

1. Print Unbilled Freight Report 

2. Print Order Status Report 

Period Procedures (or as needed) 

1. *Post Recurring Documents through last day of period (if applicable) 

2. *Print/update last Daily Sales Register 

3. Print/update Period Sales Register 

4. *Run End-of-Period Update 

Yearly Procedures 

1. *Run the End-of-Period Update (already covered in period procedures - do NOT run 
twice 

 



Entering Lost Sales  

86 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

Entering Lost Sales 
Use the Lost Sales Entry (SOC320) program to track lost sales on items and update usage. 
Lost Sales functionality is only available if the Lost Sales checkbox is selected on the Use 
Features tab of SO Static Control F/M (SOF930). 

Accessing Lost Sale Entry (SOC320) 
1 You can access the Lost Sale Entry (SOC320) program three ways.  

2 From Order Entry Quote Entry, Direct Invoice Entry, Counter Sale Entry, Confirmation 
Entry, Purchase Order Entry, and Contract Item Entry you can select Options>Lost Sales 
Entry, if the Lost Sales checkbox is selected on the Use Features tab of SO Static 
Control F/M (SOF930). 
-OR- 

3 You can right-click to access Lost Sale Entry from the same entry screens listed above 
except, providing you have the proper security and the system has Lost Sale ability 
enables in SO Static Control F/M. 
-OR-    

4 The Lost Sale Entry option can be triggered automatically. If you reset the ordered 
quantity from the original order quantity entered, but the shipped, backordered and 
committed quantities do not equal the new order quantity. The program prompts you to 
indicate whether to post the difference (original order quantity minus new reset order 
quantity) to lost sales. Select R-Review to display the Lost Sales Entry (SOC320) screen 
and modify the lost date, update usage, quantity, price, cost, reason, and/or notes. Note 
that you must have the proper security code clearance as entered for SO Static Control 
F/M (SOF930) to select the R-Review option and display this program. If a password is 
required for SO Static Control F/M (SOF930) then the password prompt will display 
before allowing you to continue. If you select Cancel on the Password prompt, a lost sale 
will automatically be recorded. 

Posting lost sales 
1 Access Lost Sale Entry (SOC320) using one of the methods listed in Accessing Lost 

Sale Entry (SOC320). 

2 (Optional) In the Customer, Ship-To, and Slsp/Terr fields enter the information.  Default 
values are available when Lost Sale Entry is called from SO Entry programs. 

3 Enter the item, quantity, price, and cost values in the Quantity, Price, and Cost (if cost is 
shown) field.  Default values are available when Lost Sale Entry is called from SO Entry 
programs. Note: The Cost field does not display if you do not have the cost security 
code, and the Cost column in the list box will also be hidden. Items not on file can be 
entered. 

4 The Warehouse field value defaults from the user profile. 

5 (Optional) In the Description 1 and 2 fields, enter the description for only items not on file.  
(Only items-not-on-file can have their description entered/changed.) 
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6 After you enter information in the above fields, matching or near matching records 
already on file are displayed in the lower list box. 

7 Update the Reason Code as needed.  The Reason Code will default to the SO Static 
value entered for default reason code.  

8 Specify whether to Update Usage. The default setting is based on the value for the 
Reason Code in Lost Sale Reason Code F/M.  

9 (Optional) In the Notes field, specify any notes for the lost sale entry. 

10  Click Save to record the lost sale. 

11 (Optional) Select the Reset Filter button to clear the list box of any values and reset the 
header field values on the screen to enter more lost sales information.  

12 Select Done to exit the program.   

Processing Deposits or Payments 
Use Deposit/Payment Entry (SOC718) to enter customer deposits or payments on SO 
documents. You can access this feature from any of the SO Order Management programs 
(Order Entry, Service Order Entry, Confirmation, Direct Invoice Entry, Credit Memo or 
Counter Sale Entry) by selecting the Deposits or Payments buttons. 

Tips: 

If an invoice contains a zero balance payment or deposit with a transaction (i.e., transfers, 
apply on account, refund, etc.) against it and you attempt to delete the document, the system 
displays a message indicating that the financial transaction will remain in effect. You can 
delete this document, or, you can back up to the Payment dialog box and delete the 
transaction if necessary.  

When a deposit is transferred to another order, the system applies the same deposit settings 
from the Daily Sales Register to the order that receives the deposit.  

Entering deposits and payments 
1 Select Deposits or Payments from the main screen of the entry program or from the 

footer window. This opens the Deposit/Payment Entry window. 

2 In the browser, press Enter or choose the Add button to the right side of the screen. 

3 Choose Deposit or Payment from the drop down list in the popup window. 
 
In Order Entry, Deposit is the only option. Payments cannot be entered on sales orders 
until they are converted to invoices. 
 
In Credit Memo Entry, Payment is the only option.  

4 Enter the cash type terms code.  
Deposits and payments must use AR terms codes types 1, 2, 3 or 4. These should be 
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set up in the AR Terms Code F/M. Press F2 to search terms codes. Tip: Refer to the 
Type column to see which codes are type 1, 2, 3 or 4. 

5 Enter the amount of the deposit or payment.  
Credit Card Processing users: If you entered a credit card terms code, the credit card 
transaction pop-up window appears after you choose Save.  
Deposits and payments cannot exceed their document totals. If FACTS detects an 
overage, it asks to either refund the overage or apply it to the customer’s account before 
it lets you complete the document. 

6 If applicable, enter the check number or credit card number.  
If the Use Last 4 Digit Security flag is selected in the Credit Card Control F/M, the 
system displays only the last four digits of the customer’s credit card number in this 
prompt. 

7 Add any notes about the payment or deposit. Notes are optional. Notes can include 
check numbers, short memos, etc. 

8 Choose Save. 
Credit Card Processing users: Swipe the credit card or manually enter credit card 
information. 
Cash Drawer users: When you complete the deposit or payment entry, the system 
checks to see if you are signed into a cash draw. If you did not sign in through the 
Update Shift program, the system prompts you for a drawer ID. Press F2 to search for 
available cash draws. 

Editing deposits and payments 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the payment or deposit in the browser. 

3 Press Enter (CR) or choose the Edit button to the right. You can make changes to terms 
codes, amounts, notes.  

4 Credit card transactions that have been forced or have been approved by the processing 
company cannot be changed. You must void the credit card transaction or perform a 
refund back to the credit card and then enter a new deposit or payment.  
 
Transferred deposits cannot be modified. Cash payments, meaning payments made with 
a type C cash terms code from the footer window, cannot be edited in the 
Deposit/Payment Entry window. If you need to make a change to a cash payment, delete 
it or refund it first and then add another payment. 

5 Choose Save to return to the Deposit/Payment Entry window. 

Deleting deposits and payments 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the deposit or payment in the browser. 



Processing Deposits or Payments  

Infor Distribution FACTS 7.9.0 Sales Orders Users Guide  | 89 

3 Press the Delete key on the keyboard or choose the Delete button on the right side of 
the window.  

4 If the deposit or payment has been acted on — applied, earned, transferred, etc. — you 
must delete the transaction first and then delete the original deposit or payment.  

5 Transferred deposits cannot be deleted.  

6 If a deposit or payment was made by a credit card, you cannot delete it. You must void 
the transaction or refund the payment. 

7 Choose OK to confirm. 

Clearing Outstanding Deposits from SO Documents 
You cannot complete a Confirmation, Direct Invoice or Counter Sale document with an 
outstanding deposit. A deposit entered on a document is considered an outstanding deposit 
until you perform one of the following actions: 

Earn the deposit (in the event that a customer forfeits the deposit) 

Refund the deposit to the customer 

Apply the deposit to the customer’s account 

Transfer the deposit to another of the customer’s documents 

Deposits cannot be applied to a sales order document until the document is converted to an 
invoice. 

Use the Outstanding Deposits Report (Sales Orders>Reports>Outstanding Deposits Report) 
to generate a list of outstanding deposits. You can run this report at any time during the 
Sales Order process. It does not affect the DSR. 

To apply a deposit to a customer’s account: 

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the deposit in the browser. Choose the Apply Trx button. 

3 In the popup window, select O-On Account in the Transaction Type dropdown list. 

4 Press F1 or choose the Balance button to apply the total amount of the deposit to the 
customer’s account. Apply part of the deposit by manually entering an amount. If you 
enter a partial amount, you must clear the remainder of the deposit before you complete 
the order, invoice, counter sale or credit memo. 

5 Choose Save to return to the Deposit/Payment entry window. 

To earn a deposit: 

1 Before you can earn deposits, reason codes must be set up in the Deposit Earned 
Reason Code F/M (Sales Orders>File Maintenances>Infrequent File 
Maintenances>Deposit Earned Reason Code F/M). 

2 Access the Deposit/Payment Entry window from an entry program. 
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3 Select the deposit in the browser and choose Apply Trx. 

4 In the popup window, choose E-Earn from the Transaction Type dropdown list.  

5 Enter the reason code. Press F2 to find a reason code. The reason codes enable you to 
track why the customer forfeited the deposit and indicate to which GL number the earned 
deposit should post.  

6 Enter the amount being earned. Press F1 or choose the Balance button to earn the 
entire amount. 

7 Choose Save to return to the Deposit/Payment entry window. 

To refund a deposit: 

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the deposit in the browser and choose Apply Trx. 

3 In the popup window, choose R-Refund from the Transaction Type dropdown list. 

4 In the Terms Code field, indicate how the payment is being refunded – cash, check, 
credit card, etc. The terms code must be a cash type 1-4. Press F2 to search terms 
codes.  

5 Check refunds must be processed through the AP Manual Check Entry program. A note 
to this effect appears in the Daily Sale Register, but the amount does not affect the 
register totals. 

6 Enter the amount of the refund. Press F1 or choose the Balance button to refund the 
entire amount. 

7 If applicable, enter the AP check number, if you are refunding the payment by check, or 
enter the customer’s credit card number.  

8 Choose Save to return to the Deposit/Payment Entry window. 

To apply a deposit to the same document (create a payment): 

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the deposit in the browser and choose Apply Trx. 

3 In the popup window, choose A-Apply from the Transaction Type dropdown list. This 
option is not available if you’re in Order Entry. Applied deposits are the same as 
payments, which can only be made on invoices, counter sales and credit memos.  

4 Enter the amount to apply on the customer’s account. Press F1 or choose the Balance 
button to apply the entire amount.  

5 Choose Save to return to the Deposit/Payment Entry window. 

To transfer a deposit to another document for the same customer: 

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the deposit in the browser and choose Apply Trx. 
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3 In the popup window, choose T-Transfer from the Transaction Type dropdown list.  

4 Enter the document to which you want to transfer. Press F2 to find the document. It must 
belong to the same customer. The document number appears under the Notes column 
header in the browser on the main Deposit/Payment Entry screen. 

5 Enter the amount to apply on the customer’s account. Press F1 or choose the Balance 
button to apply the entire amount. 

6 Choose Save to return to the Deposit/Payment Entry window. 

Using payment options 
Payments made on a document are automatically applied against the document’s total 
unless you apply the payment to the customer’s account or refund the payment back to the 
customer. 

To apply a payment to a customer’s account:  

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the payment in the browser and choose Apply Trx. 

3 In the popup window, choose O-Apply on Account from the Transaction Type dropdown 
list. 

4 Enter the amount to apply on the customer’s account. Press F1 or choose the Balance 
button to apply the entire amount. 

5 Check refunds must be processed through the AP Manual Check Entry program. A note 
to this effect appears in the Daily Sale Register, but the amount does not affect the 
register totals. 

6 Choose Save to return to the Deposit/Payment Entry window. 

To refund a payment to the customer: 

1 Access the Deposit/Payment Entry window from an entry program. 

2 Select the payment in the browser and choose Apply Trx. 

3 In the popup window, choose R-Refund from the Transaction Type dropdown list. 

4 In the Terms Code field, indicate how the payment is being refunded – cash, check, 
credit card, etc. The terms code must be a cash type currency (type 1-4) or cash. Press 
F2 to search terms codes.  

5 Enter the amount to refund. Press F1 or choose the Balance button to apply the entire 
amount. 

6 If applicable, enter the AP check number, if you are refunding the payment by check, or 
enter the customer’s credit card number. 

7 Choose Save to return to the Deposit/Payment Entry window. 
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Using the multiple payments section (Sales Orders) 
The multiple payments section is part of the SO Entry document footer and enables you to 
enter more than one type of payment on a document, if for example, a customer wants to 
pay for part of the order by credit card and part of it by check.  

It also serves as a shortcut since it enables you to set up the six most frequently used cash-
type payments on SO Entry footers so you don’t have to access the Deposit/Payment Entry 
window. 

Order Confirmation, Direct Invoice Entry and Counter Sales Entry each provides a multiple 
payment section. You can define up to six payment options and determine the order in which 
they appear. 

Defining the multiple payment options 
1 Use the Terms Code Order Setup program (Sales Orders>File Maintenance>Infrequent 

File Maintenance>Terms Code Order Setup) to determine which payment types appear 
and in which order they appear.  

2 Terms codes must be defined in this program before you can use Order Confirmation, 
Direct Invoice Entry or Counter Sale Entry. 

Entering a payment through the multiple payments section 
1 Enter that payment on the appropriate line or lines. If you press F2 or select the Balance 

button, the program automatically enters the document balance.  

2 Use the Notes field to the right of the Balance button to enter check numbers, notes, 
etc. In credit card transactions, the last four digits of the credit card number appear in the 
Notes field. 

3 Choose OK when the document balance is zero. 

4 Choose whether to print the invoice now or print it later. 

Entering payments with payment options that don’t appear in multiple 
payments section 
1 Select the Payment button while the cursor is in any of the payment lines to access the 

Deposits/Payment Entry program.  

2 Payments and deposits can only be made with cash type terms codes 1-4, such as credit 
cards, checks, debit cards, etc. Press F2 to search the available terms codes and look 
for those with Type 1, 2, 3 or 4. Type C terms codes cannot be used in the 
Deposits/Payment Entry window. 

3 The payment amount that you enter in the Deposits/Payment Entry window appears on 
the OTHER PAYMENTS line when you exit the payment entry program.  
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F4-Backup takes you back to the Tax $ field after you exit the Deposits/Payment Entry 
window. You cannot edit entries in the multiple payments section.  

Editing payments from the multiple payments section 
Once you enter payments 

1 Press the Payments button to return to the Deposit/Payment Entry window. 

2 Using your mouse or the arrow keys, highlight the line you want to edit and press Enter 
or choose the Edit button to the right of the screen. 

Note:  You cannot change the terms code while you are in edit mode. Instead, delete the 
transaction and start over. 

Deleting payments from the multiple payments section 
1 Press the Payments button to return to the Deposit/Payment Entry window. 

2 Use the mouse or the arrow keys to select the payment you want delete. 

3 Press the Delete key on the keyboard or choose the Delete button on the right side of 
the screen. 

Credit Card Handling Procedures 
FACTS offers two methods for processing credit card transactions: manual and automatic. 
FACTS by itself allows you to process these transactions manually via voice authorization. 
Automatic credit card processing is possible by integrating the FACTS system with 
ICVERIFY, CenPOS or PayflowPro software and magnetic stripe devices, which are 
purchased separately from ICVERIFY, Inc, CenPOS or PayPal. (See www.icverify.com, 
www.cenpos.com, or www.PayPal.com for more information.)  

With either method, FACTS users can perform sales, credits and voids. 

Setting up credit card handling for manual processing  
1 Set up a cash type terms code in the Accounts Receivable Terms Code F/M program. 

Credit cards must be cash type payments, not an A/R type. The General Ledger Number 
you choose must be a cash G/L account number. 

2 Navigate to the Company Control F/M in System Management File Maintenances. 
Choose "Manual" or "Manual do not collect information". 

http://www.icverify.com/
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Processing Credit Cards Manually  
1 If you chose Manual in Company Control F/M, when you enter a credit card payment, 

FACTS opens a pop-up window, which displays the amount of the purchase and whether 
the transaction is a sale, void sale, credit or void credit.  

2 In this window, enter the customer’s credit card number and the expiration date.  

3 The system then asks whether it is OK to process a sale.  

4 The credit card will be checked by FACTS to ensure it is a valid credit card number but 
will not communicate to a credit card processor to validate whether the card is authorized 
for the amount charged or even if the account is active. 

5 If you chose "Manual do not collect information" in Company Control F/M, credit card 
payment types will not display a window to collect the credit card information. 

Processing Credit Cards with PayflowPro  
When processing for PayPal using the PayflowPro client, FACTS uses the credit card 
VeriSign Processing (SOC611) program to gather all information (according to the selections 
chosen in SM Credit Card Control F/M). 

1 The system displays the amount, but it cannot be changed on this screen.  

2 You can enter the Credit Card Number manually, or by a swipe by pressing the Swipe 
button, or F1. When you press the Swipe Card button, FACTS displays a message 
indicating that it is waiting for the card to be swiped. You can press F4 to cancel.  
The system remembers the last mode the system was in when the credit card 
information was successfully gathered (swiped or manually entered), and stores this in 
the SMT record so that the next time you access the Credit Card Information screen, it is 
in the same mode as last time. Note: This only applies to "Sale" type transactions.  

3 The program displays the credit card number in the Credit Card Number field, and other 
track data into the appropriate fields.  

4 The system disables the Credit Card Number and Expiration Date fields after you swipe 
the credit card.  

Configuring FACTS to work with PayflowPro 
1 Navigate to System Management>File Maintenances>Company Control F/M. Choose 

PayflowPro in the Credit Card Processor field. 

2 Set up a credit card terms code in the Accounts Receivable Terms Code F/M (Accounts 
Receivable>File Maintenances>Infrequent File Maintenances>Terms Code F/M) if you 
have not already done so. Credit cards must be set up as a cash type —that is, Type 1-4 
— so the General Ledger number you choose must be a cash G/L account number.  

3 Edit the Credit Card Control F/M . (System Management>File Maintenances>Infrequent 
File Maintenances). 
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4 Choose TCP/IP Manager for the PayflowPro Communication Agent. This is the only 
choice available at this time. 

5 Enter the Host Address (the IP address or the host name) and Port number of the 
communication agent (where the TCP/IP manager is located). Also enter the desired 
timeout in seconds. 

6 Enter the Host Address, Port, and Response Timeout (in seconds) for the machine that 
has the PayflowPro client.  

7 Enter the Vendor, Partner, and Password for PayPal. This will be assigned to you when 
you register for a PayPal account. The default verbosity is "Low". The verbosity level 
dictates the amount of information that is received from PayPal. "Medium" verbosity 
returns the same information as "Low", but also includes bank specific responses not 
normalized by PayPal.  

8 Set the Use Address Verification flag to Y or N. If this flag is set to Y, then anyone 
running a credit card transaction will be required to enter the customer’s address after 
swiping their card. Many CPCs give discounts to companies that use this security 
feature. Note: This only applies to "Sale" type transactions. 

9 If the system is set to Use Address Verification, set the Automatically Decline on AVS 
Failure Flag. If Automatically Decline on AVS Failure is set to Y and the address is not 
correct, FACTS will tell you the card was declined. If set to N, the user will be given the 
message that the address is incorrect and be asked if they want to process the 
transaction anyway. If the cardholder’s bank does not support AVS Verification, you will 
be told and given the chance to decline the transaction regardless of this setting. 

10 If you want to require entry of the Card Security Code, set the Use Card Security Code 
flag to Y.  

11 If Automatically Decline on CSC Failure is set to Y and the CSC is not correct, FACTS 
will tell you the card was declined. If set to N, you will be given the message that the 
CSC is incorrect and be asked if they want to process the transaction anyway. If the 
cardholder’s bank does not support CSC Verification, you will be told and given the 
chance to decline the transaction regardless of this setting. 

12 Set the Use Voice Authorization flag to N. Set the Transmit to PayflowPro flag to Y.  

13 Enter the number of columns over which you want the credit card receipts to print. The 
available range is between 30 to 80 (30 columns will produce a 2½-inch wide receipt). 

14 Enter the message you would like printed on the receipts. This entry is optional. 

15 (Optional) To print credit card receipts, set up SOP610 in Program F/M. Then select the 
printer usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) 
so credit card receipts will print. This allows you to have one credit card receipt printer for 
all terminals, or a different printer for some terminals, as necessary. 

16 The Test Settings option allows you to communicate with PayPal without having to 
create a transaction to ensure the communications are set up properly. If the settings fail, 
the machine that has the TCP/IP Manager installed on it may have a more descriptive 
message regarding the failure. 
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Setting up credit card handling for voice authorization  
1  Set up a cash type terms code in the. Credit cards must be cash type payments, not an 

A/R type. The General Ledger Number you choose must be a cash GL account number. 

2 Go to the (System Management>File Maintenances>Infrequent File 
Maintenances>Credit Card Control F/M). 

3 Select the Use Voice Authorization Only flag. 

4 Select the User Address Verification flag (optional). If set to Y, the system requires that 
you enter the customer’s address and Zip code on all transactions. 

5 Select the Use Last 4 Digit Security flag (optional). Credit card transactions work with 
this flag set to N;  

6 Enter the number of columns over which you want the credit card receipts to print. The 
available range is between 30 and 80 columns (30 gives you a 2½-inch wide receipt).  

7 Enter the message you would like printed on the receipts. This entry is optional. 

Processing Credit Cards with ICVERIFY 
ICVERIFY is a third-party credit card processing software package that can be integrated 
with FACTS to provide automatic credit card processing capabilities. The company also 
offers several types of magnetic card stripe readers that interface with FACTS terminals. 
Since the card readers are recognized as keyboard devices, no device drivers or link files 
are needed. 

When processing for ICVerify, FACTS uses the credit card processing (SOC611) program to 
gather all information (according to the selections chosen in Credit Card Control F/M 
(SOF957)). 

1 The system displays the amount, but it cannot be changed on this screen.  

2 You can enter the Credit Card Number manually, or by a swipe by pressing the "Swipe" 
button, or F1. 
When you press the "Swipe Card" button, FACTS displays a message indicating that it is 
waiting for the card to be swiped. You can press F4 to cancel.  
The system remembers the last mode system was in when the credit card information 
was successfully gathered (swiped or manually entered), and stores this in the SMT 
record so that the next time you access the Credit Card Information screen, it is in the 
same mode as last time. Note: This only applies to "Sale" type transactions.  

3 The program displays the credit card number in the Credit Card Number field, and other 
track data into the appropriate fields. The system disables the Credit Card Number and 
Expiration Date fields after you swipe the credit card.  

Configuring FACTS to work with ICVERIFY 
1 Navigate to System Management>File Maintenances>System Control F/M. Enter the 

number of ICVERIFY licenses your company purchased. FACTS supports up to 999 
licenses. 
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2 Set up a credit card terms code in the Accounts Receivable Terms Code F/M (Accounts 
Receivable>File Maintenances>Infrequent File Maintenances>Terms Code F/M) if you 
have not already done so. Credit cards must be set up as a cash type —that is, Type 1-4 
— so the General Ledger number you choose must be a cash G/L account number.  

3 Edit the Credit Card Control F/M (Sales Orders>File Maintenances>Infrequent File 
Maintenances). 

4 Enter the Transaction Polling Directory. This is the path to the server acting as your 
ICVERIFY "master station" (see the ICVERIFY user manual for more information on its 
setup). The path must be 60 characters or less. 

5 Set the Recognition Timeout value. A recognition timeout occurs when the card 
processing company (CPC) does not answer the transmission within the designated time 
frame. FACTS supports up to 999 seconds.  

6 Set the Response Timeout value. A response timeout occurs when the CPC answers 
the transmission but does not respond in the time allowed. 

7 Set the Use Address Verification flag to Y or N. If this flag is set to Y, then anyone 
running a credit card transaction will be required to enter the customer’s address after 
swiping their card. Many CPCs give discounts to companies that use this security 
feature. 

8 Set the Use Voice Authorization Only flag to N.  

9 Set the Use Last 4 Digit Security to Y or N.  

10 Set the Transmit to ICVERIFY flag to Y.  

11 Enter the number of columns over which you want the credit card receipts to print. The 
available range is between 30 to 80 (30 columns will produce a 2½-inch wide receipt). 

12 Enter the message you would like printed on the receipts. This entry is optional. 

13 (Optional) To print credit card receipts, set up SOP610 in Program F/M. Then select the 
printer usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) 
so credit card receipts will print. This allows you to have one credit card receipt printer for 
all terminals, or a different printer for some terminals, as necessary. 

Working with automatic credit card transactions 
1 After entering the terms code and the purchase amount, you can choose F1 to swipe the 

card or enter the card information manually. 

2 Choose Process when you are ready to process the sale.  

3 A mini dialog box will appear, telling you the system is waiting for recognition and then a 
response.  

4 If the credit card processing company does not answer or respond within the time set in 
the Credit Card Control F/M, the system gives you either a recognition timeout (if the 
card processing card cannot connect to the provider’s system) or a response timeout (if 
the provider’s system answers but does not approve or decline within the established 
response time). 
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Recognition timeouts. You can wait again or cancel the transaction. Canceling a 
document after a recognition timeout creates no problems because the processing 
company is not aware of the transaction.  
 
Response timeouts. You have the option to wait or hold the document. If you choose to 
hold, you must call the processing company to determine whether the transaction has 
been approved or declined. 

5 If for some reason the swipe device is not working, the CPC is offline or the Voice 
Authorization flag in the Credit Card Control F/M is set to Y, the person entering the 
credit card transaction will need to call the processing company and enter the provided 
authorization code. 

6 At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not it asks you to do so. Press F2 to search. 

Processing Pending Transactions 
In cases where the processing company is offline or ICVERIFY or PayflowPro client is 
unavailable, you can still force sales and reconcile the transactions later.  

At the end of the shift or day: 

1 Switch the Transmit to ICVERIFY/PayflowPro Y flag back to ‘on’ in the Credit Card 
Control F/M. 

2 Enter the Process Pending Transactions program from the Invoices menu (Sales 
Orders>Invoices>Process Pending Transactions). If transactions are pending, press CR 
to begin processing. This program must be run before the Daily Sales Register is 
updated. 

3 If the CPC accepts all transactions, the system tells you the "Batch Processing of 
Pending Transactions Is Complete," and you can press CR to return to the Invoices 
menu. 

4 If a transaction in the batch is declined, it must be resolved (e.g. with another method of 
payment), and the Process Pending Transactions program must be run again. 

5 As with single credit card transactions, recognition and response timeouts sometimes 
occur. If you get a recognition timeout, you can wait or press F3 to stop processing. 

6 If you are faced with a response timeout, you can either wait or abort the process. Be 
advised that when you abort the process, you will need to call your processing company 
and verify which transactions they received. Those they did not receive will have to be 
settled through the ICVERIFY/PayflowPro software.  

Configuring FACTS to use CenPOS 
1 Navigate to System Management>File Maintenances>Company Control F/M.  
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13 Choose CenPOS in the Credit Card Processor field. 

14 Set up a credit card terms code in the Accounts Receivable Terms Code F/M (Accounts 
Receivable>File Maintenances>Infrequent File Maintenances>Terms Code F/M) if you 
have not already done so. Credit cards must be set up as a cash type —that is, Type 1-4 
— so the General Ledger number you choose must be a cash G/L account number.  

15 Edit the Credit Card Control F/M. (System Management>File Maintenances>Infrequent 
File Maintenances). 

• Specify the URL for the CenPOS interface as the  Base URL   
• The default is https://www3.cenpos.net/POSintegration/posintegration/default.aspx. 
• Specify the Merchant account ID for CenPOS and the CenPOS password. 
• Enter the user id used with cookies to allow processing without logging in each time. 
• Select Validate Cookies to allow connecting to CenPOS without requiring logging in 

each time. If checked, CenPOS ignores any stored cookie and uses login info 
provided in the request. If no info is provided, the user will be prompted to log in. 

• Select Use Last Four Digit Security to require the entry of the last 4 digits of the 
credit card when swiping a card. If unchecked, the last four digits field is disabled and 
does not require the last four digits to be entered when swiping a card. 

• The last credit card receipt number used will display in this field, once the CenPOS 
credit card processor is operational. (display-only) 

• Specify the number of columns over which you want the credit card receipts to print 
in Columns for Credit Card Receipt.  The available range is between 30 to 80 (30 
columns will give you a 2½-inch wide receipt).  This sets the width of your credit card 
receipts, which can range from 30 to 80 columns wide. Enter 0 if you do not want a 
receipt to print.  

16 (Optional) To print credit card receipts, set up SOP610 in Program F/M.  Then select the 
printer usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) 
so credit card receipts will print. This allows you to have one credit card receipt printer for 
all terminals, or a different printer for some terminals, as necessary. 

Processing Credit Cards with FACTS and CenPOS 
After entering the credit card amount, the CenPOS Credit Card Entry pop-up window 
appears with the Amount and document number from FACTS: 

Note: The required fields on the screen are marked with an asterisk *and highlighted in red.  

1 Enter the credit card number or swipe the card through the reader. 

2 Enter the expiration date. If you swiped the card, the system automatically enters this 
data. 

3 Enter additional information as needed based on your settings in CenPOS.  

4 Click Submit to process the transaction. 
 
A mini dialog box will appear, telling you the system is waiting for a response.  
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If there is no internet connection, the system will give a recognition timeout. If the card 
processing company does not answer or respond within the time set in CenPOS, the 
system gives you a response timeout. In both cases, the transaction is cancelled and 
nothing will have been charged on the user’s credit card.  
 
Voice Authorization is not supported at this time.  

5 At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not it asks you to do so. Press F2 to search. 

Importing Notes 
The system displays the Importing Notes screen when SO document header or line notes 
are available for addition to the sales order, purchase order or item transfer document. SO, 
PO and TR Document and line notes are available to view/edit (according to the user’s 
security) for all open documents.  

You also have the option to print the note on the sales order (for order or backorder type 
documents only), credit memo, counter sale or invoice, purchase order or transfer. When you 
run the Daily Sales Register, the system copies SO document notes to the past invoice.  

You can export sales order line notes to associated purchase orders or inventory transfers 
and print the exported sales order line notes on the PO or transfer ticket. When an Order 
Entry program automatically creates purchase order such as for a direct ship sales order, 
FACTS determines if Vendor and Item notes should import into the PO, based on the export 
options setup on the note. If a note is set to export or required, then FACTS automatically 
imports the note onto the PO. 

1 At the top of the screen, the system displays the Note Type, document number, and Note 
Category for the note displayed for import.  

2 You can modify the following fields: 

Subject  

Enter or modify the subject for the note.  

Urgent 

Indicates the note should be classed as urgent. Notes marked urgent automatically 
display in Sales Order Entry programs for customers, document header records, 
document line records, and items.  

Note 

Enter or modify the text for the note.  

Print on [PO/SO Document] 

This field depends on the document type being entered or edited. 

Print on Pick Ticket 

For sales orders, indicate whether to print this note on the pick ticket.  
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Print on Purchase Order? 

For purchase orders, indicate whether to print this note on the PO.  

Print on quote? 

For quotes, indicate whether to print this note on the quote.  

Print on pick ticket when quote is converted? 

During quote entry, indicate whether this note should print on the pick ticket.  

Print on invoice when quote is converted? 

For invoices, indicate whether to print this note on the invoice when the quote 
converted to a sales order is confirmed.  

 Print on PO/transfer when quote is converted? 

For sales orders, indicate whether to print this note on the PO or warehouse transfer 
when the quote is converted to a sales order.  

17 You can: 

Select the OK button to import the note to the current sales document or the Skip 
button to stop the note import. You can select the Export button to export the SO 
document note to the purchase order to which it is tied.  

Designating items for direct ship 
Direct ships, or drop ships, are items that are sent directly to the customer from the 
manufacturer. You may need to flag an item as a direct ship if the item is:  currently out of 
stock, a temporary item, which is an item you don’t normally stock but are willing to order for 
the customer, or a catalog item  

To flag an item as a direct ship: 

1 Select the DS box in the line item entry section.  

2 Enter or choose the vendor from which this item should ship in the popup box. F2 allows 
a search. 

3 Direct ships automatically set the ordered quantity to backordered. 

Entering Freight and Handling (Sales Orders) 
1 To enter freight and handling charges in the document footer, choose Done in the main 

Order Confirmation screen. 

2 Select the Freight $ field in the document footer to enter or update freight and handling 
charges for the selected order. Press F2 to access the Freight Totals Display window. 
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3 You can enter freight and handling manually in the Freight $ field or you can import 
freight and handling charges from another shipping software system, such as Clippership 
or UPS software.  

4 Automatic Freight Calculations and Quoted Freight: In Order Entry, Confirmation 
Entry and Direct Invoice Entry, FACTS provides automatic freight calculations using 
freight schedules or quoted freight, based on control settings in Ship Via F/M, AR 
Customer Maintenance and SO Static Control F/M (SOF980). Refer to the Automatic 
Freight Calculations and Quoted topic for details. 

5 To charge freight in SO entry programs, the Charge Freight flag in the Sales Order 
Static Control F/M (Sales Orders>File Maintenances>Infrequent File Maintenances>SO 
Static Control F/M) must be selected (set to Y).  

6 If the system does not allow manual entry in this prompt, the Allow Manual Freight flag 
in IC Warehouse F/M may be deselected (set to N). 

Quoted Freight Processing 
1 Press F2 in the Freight $ field to open the Quoted Freight Entry Dialog box.  

2 During Confirmation Entry and Direct Invoice Entry, you can modify the Quoted Freight 
Amount and the Invoice Billed Freight Amount. The system also displays the Calculated 
Order Freight Amount and the Calculated Invoice Freight Amount in the Quoted Freight 
Entry Dialog box. When a new invoice is added in Direct Invoice Entry and the customer 
is set to use Quoted freight and the Quoted Freight is not set to be automatically filled 
with the calculated freight and the Billed Freight is set to default to the Order Quoted 
Freight in SO Static Control F/M, then when the Quoted Freight Entry (SOC504) window 
is opened and an amount is entered in the Order Quoted Freight field, this amount will 
then also default into the Invoice Billed Freight field. 

3 You can select the Freight icon on the Quoted Freight Amount field to access the Freight 
Totals Display window to review and calculate freight. 

Reviewing and Calculating Freight 
1 Press F2 in the Freight $ field to open the Freight Totals Display window. 

2 In the browser the system displays the warehouse code and name, ship via and freight 
and handing charges.  

3 Highlight a warehouse line and select Process Frt and the system calculates freight per 
warehouse based on the shipped quantity on the order document lines. 
Automatic Freight Calculation Details: 
Freight will be calculated per warehouse based on the shipped quantity on the lines. This 
value is accumulated and stored in the Invoice Calculated Freight Amount field of the 
header. The system sets the Invoice Billed Freight Amount based on the "How to Default 
Billed Freight in Confirmation" setting in SO Static Control F/M. It will either be the Order 
Quoted Freight Amount (charge all on first shipment) or the Invoice Calculated Freight 
Amount (recalculate for every invoice). This is calculated when you click the Done button 
to advance to the footer in Confirmation. If you back up to the document lines and then 
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return to the footer the field will again be set based on the How to Default Billed Freight 
in Confirmation" setting in SO Static Control F/M. If you changed the invoice billed freight 
amount manually when you first accessed on the footer you must re-enter the value. The 
Invoice Billed Amount cannot be greater than the Order Quoted Freight Amount. You 
must also change the Order Quoted Freight Amount you add document lines and then 
return to the footer in order to bill for those lines.   

4 You can select Chg Frt/Hdlg to modify freight and handling charges. 

 Changing freight and handling:  
1 Choose Chg Freight. 

2  Enter the freight amount, and if applicable the handling amount, and press OK to return 
to the document footer. 

3    The program skips directly to the handling field if the Allow Manual Freight flag is not 
selected (set to N) on the Main tab of Warehouse F/M  (Inventory Control>File 
Maintenances>Infrequent File Maintenances>Warehouse F/M). 

4  Using default handling charges: To import a default handling charge from SO Ship Via 
F/M, press F1 or choose the Import button. 

5 Complete the footer and choose OK. 

6 Indicate whether you want to print an invoice at this time or batch print it from the Invoice 
& Credit Memo Print program later. 

Assigning freight with the FACTS Shipping System 
If you use the FACTS Shipping System (Sales Orders>Shipping) you can get freight totals 
based on the information entered in the UPS Weight Table F/M, UPS Zone F/M and 
Package F/M. 

These totals are only as accurate as the annual February UPS rate updates. 

For carriers other than UPS, enter freight totals manually. The FACTS Shipping System is 
based on UPS rates. 

The FACTS Shipping System is not UPS approved. This means the manifests and labels 
cannot be used.  

To assign freight totals from the FACTS Shipping System: 

1 Access the footer and tab to the Freight $ field. 

2 Press F2 to access the Freight Totals Display.  

3 Press F3 and enter the following information: 

 UPS Zone. UPS Zone codes, which are related to zip codes, are maintained in the UPS 
Zone F/M. The program defaults to the zone entered in the Accounts Receivable Ship-To 
profile for this customer. 
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 Com/Res. If the UPS Zone entered in the previous field is greater than 8, this field is not 
accessible and defaults to NA. Enter whether this delivery is a C - commercial or R - 
residential UPS ground delivery. UPS charges different rates for commercial and 
residential deliveries. Press Enter to accept the default value for this ship-to address. 

 Weight: The program defaults to the next highest whole pound from the weight entered 
in the Inventory Control Item F/M for this item. A different weight can be entered if 
necessary. 

 Freight: The program defaults to the freight calculation derived from the information 
entered in the previous three prompts. You may enter a number (+/-9999.99) if you need 
to override the system’s calculation. 

If the item is designated as having companion items, the system displays the Companion 
Item Selection (SOE151) screen. Refer to the Companion Item Selection (SOE151) topic for 
details.  

18 Save your changes. 

Using the Job Costing Entry window 
1 If there is a job number in the header, the Job Posting Entry window appears after you 

finish editing or adding a line to a document. 

2 Complete the following: 

Price 
message 

If the job is a fixed contract or time and materials contract, this field 
is skipped. If the job is a cost plus (+) contract or a no charge 
contract, a message is displayed indicating the price that must be 
billed for the item on this job.  

Press Enter (CR) to continue. Then press F4 to backup to the price 
field to enter the correct price. 

Cost code Enter a valid cost code (up to 4 characters). Entering a valid cost 
code displays the cost code description and the cost type. F2 
enables to search for a cost code. 

Memo Enter the memo to post to job cost (not used for printing purposes). 
The memo can contain up to 30 characters. The program initially 
defaults to blanks. 

Print 
Memo 

This field is skipped in Sales Orders. (When billing through Sales 
Orders the billing, i.e., invoices printed, does not take place in Job 
Cost.) 
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Using the Price Search feature 
Use the price search program to find an item’s default price as well as alternate prices, which 
may include customer contract prices, pricing levels, quantity breaks and prices from past 
sales. The price search is available in Order Entry, Order Confirmation, Direct Invoice Entry, 
Credit Memo Entry, Counter Sale Entry and Service Order Entry. 

Administrators can turn off the price search feature in the SO Entry Options F/M (on the Line 
Prompts tab). 

1 Access the price search in one of the following ways: 
Press F3 while the cursor is in the Price field 
Use your mouse to select the Price Search button next to the Price field 
Select View>Price Search from the menu bar 

2 The Price Search window displays available pricing information for the selected item, 
quantity and customer, if a customer is selected. An asterisk denotes the default price for 
a select item and customer. 

3 When you select a price for a line item, the system returns the pricing UM to line item 
price in Order Entry.  

Quote Entry Transaction Procedures 

Converting a quote to sale  
1 From the Quote Header section of quote entry, select the Bring in Another Quote 

checkbox to bring in another quote, then enter the quote number. Press F2 to search. 
You can establish some standard quotes so that there is no need to enter them each 
time. By using the Bring in Another Quote function, the line-items automatically transfer 
from the quote selected to the quote being entered. The quote selected to be brought in 
is not affected by the transfer. It stays in its original form. If you enter No, the system 
continues without additional quote information.  
 

 When you import a quote into a new quote, the system recalculates the cost of each 
item to the current cost. For items that contain a user-overridden cost, the system 
recalculates the cost based on a setting on the Quotes tab of the SO Static Control F/M. 
The setting allows you to indicate whether you want the system to recalculate a user-
entered item cost when the quote is imported to a new quote or converted to a sales 
order.  

2 When you convert a quote to a sale when using source document pricing all prices come 
in as user override prices. The system sets the price’s commission % to "No Priority" and 
calculates the default commission. Refer to the Calculating Commissions topic for 
processing details about commission percentages. 

3 If multiple warehouses on an order are being used: 
If the initiating warehouse of the line-item being transferred is different than that of the 
quote, the line-item’s initiating warehouse is automatically changed to match that of the 
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quote’s. 
The system verifies the security on the shipping warehouse and if you do not have 
security, the system displays the message: "QUOTE LINES SKIPPED BECAUSE USER 
CANNOT SHIP FROM WAREHOUSE XX" where "XX" is the shipping warehouse. 

Creating BOM items (Kitting, On-the-fly) for Quotes 
You can create Bill of Material (BOM) items in Quote Entry if: 

• You purchased and activated the Manufacturing Control module. 
• You set the Update in SO option in the Manufacturing Control BOM Entry program 

to C, A or O. 

Creating finished items 
1 At the Bill of Material (BOM) field that appears when you enter a BOM item, select from 

the following options: Y-Update and Change Components, A - Update Components 
automatically and initially skip change, or F- Update the finished item. The options Y-
Update and Change Components and A - Update Components automatically and initially 
skip change, available if the Update in SO option for this BOM item is set to C (Update 
Components, Entry and Change of Components Allowed) or A - Update Components 
automatically and initially skip change) in the BOM Entry program. To simply update the 
finished item and not modify or update its components, select F- Update the finished 
item. 

2 The Y-Update and Change Components option provides access to the Component Entry 
window, which displays the component items and descriptions and asks for the number 
of units needed to complete one finished item.   

3 The Create/Review  component lines one at a time option provides access to the BOM 
Component Entry window, which displays the components and asks for the number of 
units needed to complete one finished item. 

4 In the Units/ea field, enter the number of units — in stocking units of measure — 
required to make the one finished item. You can accept the default from the BOM Entry 
program by pressing OK. Press Skip to skip the item. Press Accept All to accept the 
default entries for the remaining components on this BOM item.  

5 The program uses the number of units needed to build one finished item and determines 
the quantity that should be shipped or backordered.  
 For example, a customer orders 5 units of BOM Item 1, which requires two units of 
Component A and 1 unit of Component B to make one finished unit.  

6 When you choose to create component lines automatically, the system "ships" 10 units 
of Component A and 5 units of Component B (assuming all quantities are available). 
 
If you changed the ordered quantity for the finished item in the main window, the system 
automatically updates the quantities of components needed. 

7 The program defaults to the component descriptions entered in the BOM Entry 
program. 
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8 Enter the number of units — in stocking units of measure — required to make one 
finished item. You can accept the default from the BOM Entry program by pressing Enter 
(CR). Press F2 or Skip to skip the item. Press F3 or Accept All to accept the default 
entries for the remaining components on this BOM item.  
 
The program uses the number of units needed to build one finished item and determines 
the quantity that should be shipped or backordered. For example, a customer orders 5 
units of BOM Item 1, which requires two units of Component A and 1 unit of Component 
B to make one finished unit. When you choose to create component lines automatically, 
the system "ships" 10 units of Component A and 5 units of Component B (assuming all 
quantities are available). 
 
If you change ordered quantity for the finished item in the main window, the system 
automatically updates the quantities of components needed. 

9 The program defaults to the component descriptions entered in the BOM Entry 
program. 

10  Press OK to accept the line. 

11 When the system displays the Memo screen for the component, edit memo lines 
associated with the component item, if necessary and select the Print on Invoice 
checkbox to indicate you want to include the memo on the invoice. You can select Skip 
to not add a memo, Acpt Memos to select and include memos for all components, or 
OK to accept the memo for the current component only.   

12 Repeat these steps for each component line. 

13 When the system displays the message, Create component lines automatically, FACTS 
looks at the stocking units required to make one finished item (defined in the BOM Entry 
program) and multiplies that number by the quantity ordered. Note that the Component 
Entry for Quote (SOE113) screen does not automatically appear when you select this 
option. 

14 When all component lines are created, the system displays the Component Entry for 
Quote (SOE113) screen, where you can change components, as long as the BOM item 
allows editing. The Component Entry for Quote (SOE113) screen also displays if you 
choose to edit the components after the line item has been saved. 

15 You can select:  
Edit - to make changes for the highlighted component item and modify the Description or 
Units fields.  
Add a component line. Then enter the item number and units for the component. 
Delete the highlighted component line.  

16 Save your changes (when editing a line).  
 
Press Stop to stop working with component lines. 

17 Press Done when you are ready to return to Quote Entry. 
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Entering or changing quotes information 
1 Open the Order Entry program. You can access this program by selecting Sales 

Orders>Quotes>Quote Entry. 

2 In the Doc/Cust field, you can: 
 
Enter the quote # to assign to this document or the customer for the quote. You can also 
press Enter to automatically assign the quote number when you complete your header 
information. 
Tip: The system automatically creates a document number once you complete the 
header. At that point, the document number appears in the title bar along with the 
customer’s name. You can also assign a document number manually if you prefer. You 
can access the Add New Document dialog box, where you can manually enter the new 
quote number. 

3 To use automatic quote numbers, select File>New Document Number to access the 
Assign Quote Number dialog box and click the Assign Next Doc icon. The system 
assigns the next available number. When you complete your header information, the 
system displays the assigned quote number at the top of the screen. 

4 When you complete your header information, the system displays the assigned quote 
number at the top of the screen.  
To Search:  Press F2 to perform a document search by customer. You can also search 
by quote number and warehouse. When searching, you can press F1 to set your search 
filters.  

5 You can also enter the customer for the quote. You can press F1 to access the Quick 
Customer Add dialog box, which is used to add customers on-the-fly. Enter the customer 
number for this quote. Entering NEW as the customer number allows you to enter a 
customer who is not yet in the Customer File. This allows you to send quotes to potential 
customers without continually expanding the Customer File (if the quote is not converted 
to a sale). However, quotes with NEW customer numbers cannot be converted to a sale. 
You must assign the new customer a valid customer number and assign it to the quote 
before it may be converted. Press F1 to add a new customer to the system to assign to a 
quote. This option is only available for use if the Customer Creation flag in the SO 
Static Control Record is set to Y. When used, the system calls the Customer F/M screen 
and allows you to add a new customer. If you press F1 from the Customer F/M, you can 
assign the next available customer number automatically to the customer being created.  
 
Press F2 to perform a customer search. 

6 Entering a valid customer number displays the customer's price level, address, balance, 
credit limit, date of last sale, phone number, contact 1, and message if on file. A credit 
check is performed if the number of Credit Check Days on the Accounting tab of 
Customer F/M is less than 999.  

7 In the Ship-to field, modify the ship-to code (this code displays from the customer’s 
default information) where the order should be shipped. The system displays the full 
ship-to address. You can press F4 to back up and enter the ship-to number for the 
selected customer. Press F2 to a search. 
 
If a customer requests to have an order shipped to an address other than its usual 



Quote Entry Transaction Procedures  

Infor Distribution FACTS 7.9.0 Sales Orders Users Guide  | 109 

shipping address, select F3 to use the Temporary Ship-to feature to enter a temporary 
address that is not to be kept on file permanently.  
 
The system displays the message: Do You Wish To Add As New Permanent Ship-To?  if 
a ship-to number that is not on file was added in the previous field. Enter N or Y to add 
the ship-to number permanently to the AR Ship-To File. Press Enter (CR) to default to N. 
If you enter Y, the Ship-To Address Window appears so you can add ship-to information.  

8 In the Warehouse/Init Warehouse field (for multiple warehouses on an order, this field 
displays as Init Warehouse), the system displays the warehouse assigned to this 
terminal  
 
You can enter the warehouse code from which the items are to be depleted. Press Enter 
(CR) to accept the default warehouse. Press F2 to search. The entry must be a valid 
warehouse. 
 
At this point, you can (via the View menu) display Aging information, such as the 
customer's credit limit and outstanding balance for the last number of periods (set in the 
Accounts Receivable Aging Control Record). You can also access customer notes. 

9 In the Purchase Order field, enter the purchase order number, if applicable (up to 12 
characters). Press Enter (CR) to default to blanks. Press F2 to perform an item price 
search.  

10 In the Quote Date field, the system displays the current date as the default; you can 
modify this field. 

11 In the Expiration Date field, the system displays NONE as the default. You can enter the 
date this quote expires or press Enter (CR) to default to the value already displayed. You 
can select F1 to change a date in this field to None. 

12 The system displays a dialog box of additional fields.  
 
 Tip: When you press Enter or Tab, the additional fields that appear, such as Ship Via 
Code, an inside salesperson code, etc., depend on the settings selected in SO Entry 
Options F/M. This procedure details all possible entries. Most of these entries already 
display default information. 
 
You can enter or modify the following information: 
Ship Via--- Enter the ship via or carrier (up to 15 characters) for the initiating warehouse. 
This code is maintained in the Ship Via F/M. Press Enter (CR) to default to the value 
already displayed (initially the ship via assigned to the ship-to number). If using multiple 
warehouses on an order, the value at this field may change. Press F2 to search. If a rate 
shop is highlighted in the search, press F1 to view the carriers that comprise the rate 
shop. 
Freight code---Indicate how the customer will pay for freight if this quote becomes an 
order. The options are P-Prepaid, C-Collect freight, B-Bill later, or A Prepay/Add. The 
program defaults to the freight code selected in the customer’s file. 

13 Date Accepted—Enter the date the quote was accepted. 
-OR- 
Date Declined—Enter the date the quote was declined. 
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Reason Declined—Enter the standard Facts lost sale reason code and set up in sales 
order file maintenances. When you enter a declined date the system prompts you for the 
SO lost sales reason code.  

14 Select the OK button. 
 
 TIP: Once the header is complete, the program automatically goes into Add mode, 
which means the cursor jumps to the Item Number prompt in the line entry section 
where you can begin entering line-item information. Use the line entry section to enter 
the item numbers, the quantities ordered, committed and/or backordered; the price; and 
the extension (prices multiplied by the quantity ordered). More prompts may appear 
depending on the settings in SO Entry Options F/M. 

Complete Steps 15-25 to enter line items on a quote 

15 In the Item field, enter the item number for the quote line. You can select the  icon or 
F2 to search for items. For Catalog or temporary items numbers refer to the Fields For 
Temporary and Catalog Item Entry section. 

16 After you enter an item, the program displays the item class, package size, item weight 
and its unit of measure, available quantity, on hand quantity, on-order quantity, and bin 
location. 
 
The following options are also available from the item number prompt. 
Memo - Select M to enter a memo line. If the order is a multiple warehouse or combined 
warehouse/direct order, a memo line will have special attributes. 
End entries - Press F3 to end line-item entries and proceed to the ending routine. 
 
From the Options menu, you can select: Quick Item Add if you need to quickly enter an 
item in the Quick Item Add program (ICF020).  
Import Items—Allows you import items from existing documents (quotes, orders or past 
invoices) This feature allows you to easily duplicate on one document (a quote, order or 
invoice) the line items on another document (quote, order or past invoice). Policy flags 
set in the Document Import Control F/M (SOF972) indicate whether or not you can 
duplicate lines from a document for a different customer and how the pricing gets 
updated when the import occurs. The system allows you to select the document type, 
reference number and default pricing option (if applicable) and then displays the Import 
Item Selection dialog box, so you can select the items to import to the new document.  
Interchange –to display items and their corresponding interchange. 
Catalog—to search catalog items. 
Lost Sales Entry--to enter a lost sales entry. 
Past Sales –This option displays the past sales of all items for this customer. Enter the 
beginning item number to list if the Use Past Sales flag in the SO Static Control Record 
is set to Y.  
Customer Item Search --to search customer/item numbers. 

17 Select the Ship Direct check box or press F3 to indicate, that this item is shipped directly 
to the customer ship-to address.  

18 In the Whse field, the system displays the default warehouse for the item. You can 
modify this value or search for a different warehouse.   
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19 In the Quantity field, enter the quantity to quote or select a display code. If this item is a 
temporary item, enter the quantity to quote. If this is a BOM finished item that can be 
assembled in SO, you may be able to enter component items. If the item has multiple 
selling units of measure you can press F2 to change the unit of measure on the ordered 
quantity. Press F3 to change the shipping warehouse if you are using multiple 
warehouses.  
 TIP: If the quantity entered exceeds the available inventory in the selected warehouse, 
the program gives you the option to accept the quantity anyway or press F2 to search 
other warehouses. The Search Warehouses window displays the warehouses that have 
the item, along with the available, on hand, committed, on order, backordered and 
surplus quantities for the unit of measure selected. Select a warehouse. This creates a 
suggested warehouse transfer. Make sure you backorder the item. 

20 The Cost field is available if the Change by Ln Cost flag in the SO Static Control 
Record is set to Y or B. If the Change by Ln Cost flag is set to B, you can press F4 to 
back up to this field. This field is also available if the item is temporary. Enter the cost per 
displayed costing unit of measure. enter a backordered quantity if the quantity ordered is 
greater than the available quantity in the selected warehouse.  

21 In the Price field, enter the price per displayed pricing unit of measure. Enter L and a 
level number for a price level if applicable. Press F2 to change the unit of measure for 
pricing if more than one is set up for this item. Press F3 to select another price. This field 
defaults to the pricing default UM for this item.  
The T column in the browser refers to the price type for the item. 
The values in this column represent the following price types: 
List Price: T, 
Level Price: L#, 
Qty Break Price: Q#, 
Standard Price: S, 
Contract Price: C, 
User Override Price: U,  
where # gets replaced by the level number or the quantity break level number.  

22 The fields described below are available only if the flag indicated was selected in SO 
Static Control or an error condition occurs.  
 
At this point, headings for the line-item fields used are displayed, and if the Display 
G.M.% flag in the Sales Orders Static Control Record is set to Q or A, the gross margin 
percentage is also displayed. If the calculated gross margin percentage is below the 
minimum or above the maximum, a message is displayed. 
 Note:  If the item is designated as having companion items, the system displays the 
Companion Item Selection (SOE151) screen. Refer to the Companion Item Selection 
(SOE151) topic for details.  

23 Press F3 (End Entries) to complete an entry in the line-item portion of the Quote Entry 
program. 
 
Select Stop to stop entering line items. 

24 The system updates and displays the running total. The line number is incremented by 
one, displayed, and the program returns to the item field for the next line-item entry. 
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(Optional) You have the following options: 
 
Select the Header button to access the Header Detail for Documents screen, which is 
used to view and/or modify warehouse, shipping information, quote and expiration dates, 
and salesperson, freight, terms and ship via codes.  
 
Highlight a line item and select the Line Detail button to access the Line Detail for 
Documents screen, which is used to view and/or modify item descriptions, quantity and 
shipping information, costing, and PO information.  
 
(Optional)  You can also: 
access Note Entry (SME710) for the customer, item, quote header or line record 
specified in the program. Edit - to make changes for the highlighted line item.  
 
Add a quote line. 
 
Delete the highlighted quote line.  
 
Insert a line item above the highlighted item in the browser. 
 
Save your changes. 

25 Select the Done button to access the Footer for Document dialog box 

26 The system displays Footer for Document dialog box; complete the following fields: 
Disc % or Disc %--Enter the discount percent (maximum of 100) or dollar discount 
(maximum equals merchandise total) of the merchandise total for the document. This 
field only appears if % or $ was entered at the Use Invoice Discounts flag in the SO 
Static Control Record. 
Freight $--Enter the freight amount (+/-9999.99). Press Enter (CR) to default to 0 or, if 
this ship via is UPS, to the freight calculated for the UPS zone. 
 
If the Ship Via code is UPS, refer to the UPS Ship Via Information topic for additional 
fields. 
Tax Code-- Enter the tax code for this ship-to customer. The entry must be a valid tax 
code. This field is not available if the Charge Tax flag in the SO Static Control Record is 
set to N. Press Enter (CR) to default to the currently displayed value (initially the 
customer's ship-to tax code). Press F2 to a search. 
NOTE: If the user backs up to this prompt and does not press F1 - skip after changing 
the tax rate or the tax amount, the system recalculates the charges to reflect the tax code 
and the changes to the Tax Rate and Amount fields are lost. 
 
Tax $ (Amount)-- This field is only available if the Charge Tax flag in the SO Static 
Control Record is set to O. Enter tax amount. 
 
The system displays the total amount for the quote that is taxable, quote subtotal, 
discount amount, freight, tax and document totals. 
 
Memo-- Enter the memo to print on the quote. Press Enter (CR) to default to the 
displayed value, initially the standard memo set up in the Document Print Control 
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Record. If no memo is needed, you can press the space bar before pressing Enter (CR). 
Press F4 or the Backup button to return to the selection prompt. 
 
Select the OK button to accept your entries.  

27 The system displays the message: Print Quote Now? 
 
If the quote has been printed once, this field is skipped. Select this checkbox to indicate 
to print the quote immediately. If do not select the checkbox or if the quote has already 
been printed, you can print/reprint the quote through the Quote Print program. Select the 
OK button. You can select the Backup button to return to the previous footer screen. 
 
 The system still prompts you to print quotes even if the customer fails the credit check 
and your system is set in AR Static Control to place the document to Hold status. The 
system uses the credit check to determine whether the quote will be converted into a 
sales order. 

28 The system displays the message: Convert quote to a sale? 
 
Enter N - do not convert and skip to the end of the ending routine, A - convert all line-
items to a sale or contract, or F - convert the flagged line-items to a sale or contract. 
Press Enter (CR) to default to N. 

29  (Optional) If you selected A or F for the Convert quote to a sale? option, complete the 
Convert Quote Lines screen. 
 
Note: When an Order Entry program automatically creates purchase order such as for a 
direct ship sales order, FACTS determines if Vendor and Item notes should import into 
the PO, based on the export options setup on the note, and the Notes pop up 
functionality is disabled. If a note is set to export or required, then FACTS automatically 
imports the note onto the PO. 

30 The system returns you to the Doc/Cust field, where you can enter another quote or 
select the Done to exit the program. 

Sales Orders Transaction Procedures 

Entering a new sales order 
1 Open the Order Entry program. You can access this program by selecting Sales 

Orders>Orders>Order Entry. 

2 In the Doc/Cust field, enter the sales order # to assign to this document or the customer 
for the sales order.  
Tip: The system automatically creates a document number once you complete the 
header. At that point, the document number appears in the title bar along with the 
customer’s name. You can also assign a document number manually if you prefer. You 
can select the File>New Document to access the Add New Document dialog box, where 
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you can manually enter the new sales order number.  
 Search Tips:  Press F2 to perform a document search by customer.  
 
To enter the customer for the sales order, you can access the Quick Customer Add 
dialog box, which is used add customers on-the-fly. After you finishing information in the 
Quick Customer Add dialog box, the system asks if you would like to add a FaxLink 
record. Select Yes to access the Quick Fax Record Entry dialog box and add faxing 
information. 

3 In the Ship-to field, modify the ship-to code (this code displays from the customer’s 
default information) where the order should be shipped. The system displays the full 
ship-to address. If a customer requests to have an order shipped to an address other 
than its usual shipping address, use the Temporary Ship-to feature to facilitate this 
request. 

4 In the Ordered field, the system displays the current date as the default for the date on 
which the order was placed; you can modify this field.  

5 In the Requested field, the system displays ASAP as the default for the date on which 
the customer wants the order to arrive. You can change the value in this field to ASAP. 
 
Tip: When you press Enter or Tab, the additional fields that appear, such as Customer 
Reference Number, Ship Via Code, an inside salesperson code, etc., depend on the 
settings selected in SO Entry Options F/M. This procedure details all possible entries. 
Most of these entries already display default information; you can modify these values. 

6 The system displays a dialog box of additional fields. You can enter or modify the 
following information: 
Ship Via---The ship via code indicating the method of shipment the customer requested. 
You can enter a ship via code in the customer’s master file so it automatically appears 
when you enter the customer’s code. Changing the ship via in the header on a document 
with existing lines will not change the ship via values on existing line items. To globally 
change ship vias on all existing lines for a particular warehouse: Choose 
View>Shipping Warehouses.  You can edit the warehouse by selecting the Edit icon and 
entering a new warehouse to change the ship vias for all existing lines for a particular 
warehouse. You can select Ship Complete to enter a new ship complete status for the 
specified warehouse. You can select Ship Complete to enter a new ship complete 
status for the specified warehouse. 
Processing Note for Orders Imported from eStorefront   When the order comes into 
FACTS with the ship-to name starting as "PICK UP:" the ship via that is sent from 
eStorefront is replaced with the pickup location ship via from the initiating warehouse of 
the order (eStorefront currently only allows for a single shipping warehouse). The system 
creates a temporary ship-to using the ship-to information from eStorefront and uses the 
tax code from the warehouse record on the order. 

7 If either the ship via or the tax code are invalid, the order is rejected and the system does 
not attempt to determine some other values for these fields. 

8 When a pickup location is selected, the warehouse’s name and address are put into the 
ship-to name and address fields on the order. The name is preceded by "PICK UP", and 
the ship-to name and address fields are then not able to be changed by the user. The 
ship via field is removed from the checkout screen. 
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9 Complete the following: 
Ordered By---The name of the person who placed the order. 
Terms---The code representing the payment terms extended to this customer. This field 
defaults to the terms code entered in the customer’s master file. Press F2 or choose the 
button to view the list of terms codes available in the system. 
Freight code---Indicate how the customer will pay for freight on this order. The options 
are P-Prepaid, C-Collect freight, B-Bill later, or A Prepay/Add. The program defaults to 
the freight code selected in the customer’s file. 
Salesperson---The salesperson code assigned to this customer. The program defaults 
to the salesperson/territory code assigned to the Ship-to code (Accounts Receivable>File 
Maintenances>Ship-to F/M). Press F2 to see a list of salesperson/territories in the 
system. 
Inside Salesperson---The salesperson code to indicate who is entering the order on the 
primary salesperson’s behalf. To access this field, the Inside/2nd slsp flag in SO Static 
Control must be set to I-Inside Salesperson or B-Both. Commission cannot be split with 
an inside salesperson in FACTS. 

10 Select the OK button. If this customer requires a reference number for the sales order, 
the system displays a message Reference # required for this customer. Select the OK 
button to display the Header Detail screen to enter the reference number. At this time 
you can also modify values for many of the available fields. Refer to the Header Detail 
topic for field description information. 
 
TIP: Once the header is complete, the program automatically goes into Add mode, which 
means the cursor jumps to the Item Number prompt in the line entry section where you 
can begin entering line-item information. Use the line entry section to enter the item 
numbers, the quantities ordered, committed and/or backordered; the price; and the 
extension (prices multiplied by the quantity ordered). More prompts may appear 
depending on the settings in SO Entry Options F/M. 

11 In the Item field, enter the item number for the sales order line. You can enter M to enter 
a memo line. 
 
If you enter a temporary item or a catalog item, the system displays additional field fields. 
Refer to the Temporary and Catalog Item Entry topic for field details. 
TIP: For detailed information about entering serial/lot items refer to the Entering serial/lot 
items topic. 
Over Commitment of serial/lot items: The over-commitment of serial/lot items is not 
allowed in Order Entry and Confirmation Entry. If the OE Serial/Lot# Entry flag in SO 
Static Control is set to "M" or "N" then you can under commit serial/lot items. Refer to the 
Over Commitment of Serial/Lot Items topic for more information.  

12 Select the Ship Direct check box or press F3 to indicate, that this item is shipped directly 
to the customer ship-to address.  

13 In the Wh field, the system displays the default warehouse for the item. You can modify 
this value or select F2 to search for a different warehouse.   

14 In the Ordered field, enter the customer's requested quantity. You can select the UM 
icon or press F2 to change the unit of measure on the ordered quantity.  
 
TIP: If the quantity entered exceeds the available inventory in the selected warehouse, 
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the program gives you the option to accept the quantity anyway or to search other 
warehouses. The Search Warehouses window displays the warehouses that have the 
item, along with the available, on hand, committed, on order, backordered and surplus 
quantities for the unit of measure selected. Select a warehouse. This creates a 
suggested warehouse transfer. Make sure you backorder the item. 

15 1In the Committed field, enter a quantity to commit in the warehouse or accept the 
default. This field defaults to the quantity ordered, if that quantity is available in the 
selected warehouse. 

16 1In the Backordered field, enter a backordered quantity if the quantity ordered is greater 
than the available quantity in the selected warehouse.  
 
When you enter a backordered quantity, Sales Order Entry programs base suggested 
document creation on the Stock, NonStocked, Uninventoried, and Temporary 
prompts in Sugg PO/TR by Type section on the Line Options tab of SO Entry Options 
F/M (SOF915). Use these settings to indicate whether you want to have the system ask 
to create suggested purchase orders or suggested transfers by item type during Order 
Entry line processing. Refer to the Suggested Transfer/Purchase Order Creation from 
Sales Order Entry Programs topic for detailed information about creating suggested 
warehouse transfer or purchase orders for backordered quantities. 
 
The program skips this field if:  
 
The customer does not allow backorders (Allow backorders flag not selected in AR 
Customer F/M).  
 
Your company does not allow backorders (Allow backorders flag not selected in SO 
Static Control F/M).  
 
The item is a direct ship. 
 
The selected warehouse has enough inventory to fill the order. 

17 If the backordered and committed quantities do not add up to the ordered quantity, the 
entry program forces an adjustment. 

18 1As you finish entering a line item, the cursor returns to the Item Number prompt. Press 
F4 at the Item Number field to exit out of Add mode. 
 
 Quick entry tip: Enter the item number, the ordered quantity and then press the down 
arrow key.   
If the item is designated as having companion items, the system displays the Companion 
Item Selection (SOE151) screen. Refer to the Companion Item Selection (SOE151) topic 
for details.  

19 Press F3 (End Entries) to complete entries in the line-item portion of the Order Entry 
program.  

20 (Optional) You can : 
access Note Entry (SME710) for the customer, item, quote header or line record 
specified in the program. Edit - to make changes for the highlighted line item.  
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Add a quote line. 
 
Delete the highlighted quote line.  
 
Insert a line item above the highlighted item in the browser. 
 
Save your changes. 
 
Select the Deposits button to access to the Deposit/Payment Entry window. 
 
Select the Header button to access the Header Detail for Documents screen, which is 
used to view (inquiry-mode) and/or modify warehouse, shipping information, request and 
order dates, and salesperson, freight, terms and ship via codes.  
 
Highlight a line item and select the Line Detail button to access the Line Detail for 
Documents screen, which is used to view and/or modify item descriptions, quantity and 
shipping information, costing, and PO information.  

21 (Optional) Choose the Options menu for additional item searches, Quick Item Add and 
Service & Repair options (if used). 
 
Select the Deposits button to access to the Deposit/Payment Entry window. 

22 Select Stop to stop entering line items. 

23 When you select F3 or the Done button, the system displays Footer for Document dialog 
box; in the Memo field, enter the memo line that prints on the pick ticket. Select the 
Backup button if you need to change any items or header information. Select the 
Deposits button to access to the Deposit/Payment Entry window.  

24 Choose OK in the Footer window to finish the order.  

25 In the Frt Method field, the system displays the Document Freight Method (Q/C) for this 
customer– this value defaults from AR Customer Maintenance and is modifiable based 
on the Allow Method Change checkbox on the Invoicing tab of AR Customer 
Maintenance. Based on the setting, you can select from:  Quoted Freight or Calculated 
Freight.  

26 In the Freight $ field, the freight value can be entered freight, quoted freight or 
automatically-calculated freight, based on control settings in Ship Via F/M, AR Customer 
Maintenance and SO Static Control F/M (SOF980). You can modify the entered freight, 
quoted freight amount but the calculated freight is determined by the system--You cannot 
modify this value  from within Sales Order Entry.   

27 The Discount Percentage, Tax Code and Rate display and are not modifiable.  

28 Select the Deposits button to access to the Deposit/Payment Entry window. 
Select Back to return to the Order Entry Items screen. 

29 Select OK to access the Print Ticket Window. 
You can select: 
Print Pick Ticket – choose to print the pick ticket now, print it later from the Pick Ticket 
Print program or place the document on hold, which may be necessary if the order put 
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the selected customer over its credit limit. Documents put on hold can be released in the 
SO Hold Selection program (Sales Orders>Orders>Hold Selection). Press F1 to make 
your Print Pick Ticket response the default answer for the next pick ticket you create. 
 
 Multiple warehouse users: If you select Y-Print pick ticket now and no print ticket 
exists for the initiating warehouse, a message appears to the effect. Items shipping from 
other warehouses are added to the Item Ship Approval File for those shipping 
warehouses.  
You must approve the items in Item Shipment Approval before the ticket can print. 
 
Orders with direct ships: The program asks you if you create or update a purchase order 
if the Create POs for Direct Ships control in SO Static Control F/M is set to Y-Create 
POs or M-Operator Selection of PO Creation. 

30 1The system returns you to the Doc/Cust field, where you can enter another sales order 
or exit the program. 

Converting Quote Lines 
1 Use the Convert Quote Lines program to convert a quote to a contract or sales order.  

2 For Contracts: If all lines on the contract have been converted to a sales order or to a 
contract then that option (either sales order or contract) will not be available in the drop 
down box. If all lines have been converted to both, then the conversion window will not 
display. If the SO Static Use Contracts check box is not selected then the conversion 
window will remain unchanged. If a contract has been created from a line on the quote 
and there are no conflicts with other lines and no conflicts with the contract's settings 
since the contract was created (for example the contract is still active and not expired) 
then a prompt will appear allowing the user to merge any quotes lines being converted 
now to that existing contract --selecting the check box will add the new line (or lines) to 
the existing contract, otherwise the quote lines will create a new contract. If the merge 
check box is selected all other field for contract conversion are disabled and ignored 
during the conversion. If the user does not have the ability to review contracts then a 
check box for creating the contract as approved will not be available. Such a user will 
also not be presented the option to copy a quote line to a contract that has already been 
reviewed. Any contract created by such a user will be created as not approved. The 
possible description will default to the customer number, name, and the quote number. 
This can be changed.  

3 Clicking the OK button will process the request. If a contract is created then that contract 
number will display. If merging lines to a contract then this alert will not show. A tally of 
lines that were converted will display. If no lines were created then the following will tell 
the user: (This can happen when selecting to convert only flagged quote lines and no 
quote lines in fact were flagged.) 

Approving the shipment of on-hold document lines 
1 Open the Item Shipment Approval program. You can access this program by selecting 

Sales Orders > Orders >Item Shipment Approval. 
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2 Enter the shipping warehouse code. F2 allows a warehouse search.  

3 In the Enter Password field, enter the password, as necessary. This field is skipped if the 
user is set up in the Warehouse Codes F/M as the approval user.  

4 Enter the initiating warehouse. Press F2 to search warehouses or F3 to default to ALL.  

5 In the Display output, enter whether to display by D - document or I - item. The program 
defaults to D.  

6 Enter the beginning document or item to display. Press F1 to default to FIRST or F2 to 
access an item search or document search. Note: This field appears as DOCUMENT if D 
is entered in the previous selection prompt and ITEM if I is entered. Complete step 7 or 8 
depending on the display output type you selected in step 5.  

7 (Optional) Display by Document: If displaying by document, information about each 
document is displayed including number, type, status code, date created, initiating 
warehouse, customer number and name, salesperson, number of lines rejected and 
number of lines on hold. Enter the line number to display or use the arrow keys to 
highlight then press Enter (CR) to display document line items. If there are no rejected or 
on-hold line for a document, the system displays a message. You can select from the 
following: 

H Place all items on hold for the selected document. Once a line is placed on hold, the 
shipment status displays 'On Hold'. 

A-Approve lines on the highlighted document. Once a line is approved, the shipment 
status displays 'APPROVED' and the line cannot be placed on hold or rejected.  

R-Reject lines on the highlighted document. Once a line is rejected, the shipment status 
displays 'REJECTED'.  

F3-End  

#, press Enter (CR) Display details for a document. Enter the line number and press 
Enter (CR).  

8 Document Detail Screen  
Once the document's details are displayed, use the arrow keys to highlight and select a 
line. The system displays the available, on-hand, backordered, and committed quantities 
for this item and warehouse are displayed. The user has the following options for the 
highlighted line:  

D Display line details Information on the line is displayed including item number, 
descriptions 1 and 2, shipping warehouse, ship via, shipment status, original order 
amount, invoiced ordered, committed, shipped and backordered amounts, total amount 
shipped, selling unit of measure (UM), picking status, price, pricing UM, cost, costing 
UM, discount, location, commission percentage, whether the item is taxed, GL 
department number, weight and vendor. Press CR to exit.  

Once a line has been selected, the following options are available:  

H Place line on hold. Once a line is placed on hold, the shipment status displays 'On 
Hold'. 

A Approve the line on the highlighted document. Once a line is approved, the shipment 
status displays 'APPROVED' and the line cannot be placed on hold or rejected.  
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R Reject the line on the highlighted document. Once a line is rejected, the shipment 
status displays 'REJECTED'.  

F3 End  

9 (Optional) Display by Item: If displaying by item, each item is displayed with the item 
number, description, committed amount, selling UM, number of line-items rejected and 
number of line-items on hold. Also displayed are the available, on-hand, on order, 
backordered, and committed amounts for this item and warehouse.  

10 Use the arrow keys to highlight and select a line. Once a line is selected, you have the 
following options:  

A-Approve all items. Once lines have been approved, the numbers in the rejected and/or 
on-hold columns become 0.  

R Reject all items  

F2 Search warehouses for this item 

#, press Enter (CR) To display a details for an item on the document line, enter the line 
number and press Enter (CR). Select a line number to display document information 
including the item number, document number, type, status, date, line number, initiating 
warehouse, customer number and name, number committed, selling UM and shipping 
status are displayed.  

Item Detail Screen 

Once the item's details are displayed, use the arrow keys to highlight and select a line. 
Once a line has been selected, the following options are available:  

D-Display detail  

H-Place the line on hold  

A-Approve the line  

R-Reject the line  

#-Select a line number to display detail  

F2-Search warehouses for this item  

F3-End  

11 After you approve/reject a line on a document or view details, the system returns you to 
the command prompt so that you can repeat this process or press F4 to exit the 
program.  

Committing backordered quantities 
1 Open the Commit Backordered Quantities program. You can access this program by 

selecting Sales Orders > Orders >Commit Backordered Quantities.  

2 At the Include prompt indicate whether to commit stock for S-sales orders, T-transfers or 
B-both. Press F4 to backup  
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3 Select the order in which to print the report. The Order prompt information varies, 
depending on the include option you selected above:  
 
If you selected S-sales orders for the Include prompt, indicate what order to use to 
commit backordered quantities where stock is available. You can select from: O-order 
number, I-item number, C-customer, or D-request date. 
 
If you selected T-transfer only for the Include prompt, indicate what order to use to 
commit backordered quantities where stock is available. You can select from: T-ticket 
number, I-item number, W-to warehouse, or D-request date. 
 
If you selected B-both sales orders and transfer for the Include prompt, indicate what 
order to use to commit backordered quantities where stock is available. You can select 
from: I-item number or D-request date. 

4 At the Beginning and Ending prompts, select the beginning and ending orders choices to 
update. F1 defaults to FIRST. F2 allows a search.  The Beginning prompt information 
varies, depending on the order option you selected above: 
 
If the Order prompt is "D" for request date, the Beginning and Ending prompts are 
disabled, and you can enter the range in the Beginning Date and Ending Date fields in 
the Properties section of the screen.    
 
All orders choices with the exception of request date have request date as the secondary 
sort option. For example if you select customer order, the documents commit and print in 
request date order within each customer. 

5 In the Properties section of the screen, complete the following fields: 
Warehouse--  The Warehouse prompt information varies, depending on the include 
option you selected above: 
If you selected S-sales orders for the Include prompt, enter the shipping warehouse to 
update for. 
If you selected T-transfer only for the Include prompt, enter the from warehouse to 
update for. 
If you selected B-both sales orders and transfer for the Include prompt, enter the 
shipping warehouse or from warehouse to update for. 
Beginning Date--The beginning date to update.  
Ending Date--The ending date to update.  
Route--The three-character route codes (entered side by side) for which orders are to be 
updated.  If the Include prompt is not "S" for sales orders or "B" for both, the Route 
prompt will be disabled. Of course the existing check for Use Routes from the SO Static 
will be maintained. 
Doc Type--Indicate whether to commit O-open orders, B-backorders or A-all orders. 
Priority--The priority to use when committing items: N-normal, R-rush and/or H-service 
hold orders. Press F3 to default to All.  
Print Status--Enter the print status to use for the commit quantities scope: Commit 
quantities on documents that have Not been printed, commit quantities on documents 
that are Ready for reprinting, commit quantities on documents that are TR-already 
printed, commit quantities on documents that are Ready for reprinting, or commit 
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quantities on All order/backorder documents that are ready for reprinting. The program 
defaults to N-documents that have not been printed. 

6 In the Pick Ticket, section of the screen, complete the following fields: 
Print Pick Tickets--Indicate whether to print pick tickets for orders being committed. 
Printer--Enter the code for the printer to use. Press F2 to search. If the Print Pick Tickets 
prompt is set to "No", this prompt is disabled. A printer is the only valid option for this 
field; you cannot select viewer, fax or file for printing. 
Note: If the Print Pick Tickets prompt is "No", this prompt is disabled. If the pick ticket 
quantity is "Ordered" in the SO Static Control file, this prompt is not displayed. If the new 
"Allow Print if not Complete" field from SO Static Control file is "No", this field is set to "N" 
and disabled. 
Print if Not Ready--Indicate whether to print orders that are not yet available to ship.  

7 In the Transfer Ticket, section of the screen, complete the following fields: 
Print Transfer Tickets--Indicate whether to print pick tickets for orders being committed. 
Printer--Enter the code for the printer to use. Press F2 to search. If the Print Pick Tickets 
prompt is set to "No", this prompt is disabled. A printer is the only valid option for this 
field; you cannot select viewer, fax or file for printing. 

8 You can press: 
Enter (CR) to run this program using the defaults.F1 to access template information for 
this program.F3 to change the default field values listed in steps 2 and 3.F4 to exit 
without running the program and committing any quantities.  

Processing Blanket Sales Orders (Overview) 
1 Enter the Blanket Sales Order. Generate the blanket order document number and 

complete the customer information in the header section document entry. Add line items, 
memo lines, release request dates and complete the Blanket order by entering the 
document memo. 

2 Acknowledge the customer’s order.  From within BSO document entry or from the 
BSO menu, print the order acknowledgment for the customer to use as confirmation of 
the order. 

3 BSO Document Inquiry and/or Report Analysis: Check the status of current and 
completed BSO documents through SO Customer Inquiry, SO Quick-Look Inquiry, Item 
Inquiry, and Blanket Sales Order Inquiry. Use the BSO Inquiry to obtain the associated 
Sales Order Document # as releases are processed. Use the SO Inquiry to check the 
status of individual Sales Orders.  

4 Run the Blanket Order Report to list release requests on open blanket orders and 
determine if any releases need to be processed. This report can also be used to 
determine which Sales Order documents are related to BSO release requests and the 
status of those releases.  

5 Run the Blanket Order Release Register. The release register will print a list of items 
ready for processing. If you choose to update the Blanket Order Release Register, sales 
order(s) will be created for each BSO, containing all items scheduled to be released. As 
the order is shipped, the Daily Sales Register will update the BSO document.  
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6 Remove the Completed Blanket Order Document. Run Blanket Order Removal as 
needed to remove completed BSO documents that do not need to remain on the system. 

Entering or modifying blanket order header information 
1 Open the Blanket Order Entry program. You can access this program by selecting Sales 

Orders> Orders >Blanket Sales Orders>Blanket Order Entry.  

2 In the Doc/Cust field, enter an existing blanket order document number (up to 6 digits) or 
press Enter (CR) to have the system assign a new document number or the customer 
for the blanket sales order.   
Tip: When you press Enter (CR) or Tab, the additional fields that appear, such as Ship 
to code, an inside salesperson code, etc., depend on the settings selected in SO Static 
Control F/M SOF980, the AR customer record, and the Ship Via F/M. This procedure 
details all possible entries. Most of these entries already display default information.  
 
You can press F3 or the Defaults button to accept the default values for the remaining 
fields. If the program stops at an entry field, this means that the system could not find a 
valid default for the required field and a valid value must be entered before continuing. 

3 In the Ship-to entry field, modify the ship-to code (this code displays from the customer's 
default information) where the order should be shipped. The system displays the full 
ship-to address. You can press F4 or the Backup button to back up and enter the ship-to 
number for the selected customer. Press F2 or the Search button to search. (Note that 
Temporary Ship-Tos are not allowed on BSO documents.)  

4 The Initiating Warehouse field displays the warehouse that is initiating the order. The 
system defaults initiating warehouse from Terminal F/M for the user. If you are using 
multiple warehouses on an order, you must have the authority to initiate from this 
warehouse.  

5 The current system date when the blanket document was initially created displays in the 
Entered field. This field cannot be edited. 

6 The system displays the date the order expires in the Expires field. After the expiration 
date has passed, releases will not be processed by the BSO Release Register. Press 
Enter (CR) or F1-None to default to NONE. 

7  In the Completion field, enter the date all releases on the order have been completed. 
Press Enter (CR) or F1-None to default to NONE. When all line-items are released and 
shipped this field is updated by the Daily Sales Register. Enter a date to manually cancel 
an order. All documents which contain a completion date are considered complete and 
will not be processed any further. 

8 Select Blanket Order On Hold to indicate you want to place the document on Hold 
status. The system does not process releases for any document placed on hold.  
 
You cannot access the Customer Notes feature (View>Customer Notes) while you are 
working in the line-item portion of the screen. When you finish with line items, place the 
cursor in the header portion of the screen and then select View>Customer Notes.  
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9 In the Release Basis entry field, the system defaults to SO Static control value for 
Release Basis. The basis is used to determine when a sales order will be created for 
specific release requests per BSO document, by the item which has the Longest lead 
time, a Fixed number of days, or whichever represents the Greater of, longest lead time 
and fixed number of days.  

10 In the Fixed Days entry field, enter the predetermined number of days to be used in the 
release calculation.  
 
Sales Orders will be created this number of days prior to the request date. For example, 
to meet customer service standards, you always commit goods two weeks prior to the 
request date. Fourteen days have been allocated to special order or transfer goods into 
the warehouse. Fixed days would be set to 14 days. This entry field is valid only if the 
Release Basis is Fixed Days or the Greater of Longest Lead Time and Fixed Number of 
Days.  

11 In the Add Days entry field, enter the number of days to allow adding pad to the longest 
lead-time for an additional margin of safety, or to cover the order processing and 
shipping time. Sales orders will be processed this number of days plus the lead-time, 
prior to the request date. For example, if the lead time for this item is 3 days and 2 is 
entered in the add days field, the sales order will be processed 5 days prior to the 
requested release date. This entry field is valid if the Release Basis is Fixed Days or the 
Greater of Longest Lead Time and Fixed Number of Days.  

12 When you complete the blanket order header information, the system displays the 
system displays the line-item detail screen. Refer to the How to enter line items on 
blanket sales orders procedure for step-by-step instructions. 

Entering line items on blanket sales orders 
Once the required header information is complete, the system displays the line-item detail 
screen. The line-item portion of the program allows entry of up to 999 line item and message 
lines to complete the order.  

1 In the Item Number entry field, enter the item number (up to 20 characters). After 
entering a valid item the program displays item description 1 and 2, the item class, 
package size, item weight and its unit of measure, available quantity, on hand quantity, 
on order quantity and bin location.  

19 Enter the memo in the Memo field. 
Memo Line Information 
Memo lines are a special feature of sales orders. The first line (up to 30 characters) is 
displayed in the BSO detail screen as a line-item memo. Subsequent line entries are 
acknowledged on the screen by a plus sign (+). Memo lines may be included anywhere 
within the line-item detail screen and can be printed on order acknowledgments, sales 
orders, and/or invoices. Memo lines are up to 30 characters in length and can be up to 
999 lines long. Can be attached to a line item or to the document.  For example, the 
customer places a blanket order, requesting two particular items arrive at the same time. 
Simply add a memo after each of these items, stating that they should be shipped 
together. The memo lines can print on the acknowledgment so that the customer is 
reminded you are aware of the special request; the memo lines can be exported to the 
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Sales Order so that your order handlers are aware of the request; the memo lines can 
also print on the resulting Invoice to verify that the items arrived at the customer site as 
requested.  

2 The following checkboxes become available to change the default memo print settings. 

Print on Acknowledgment to include the memo on the Blanket Order 
Acknowledgement.  

Export to SO to export the memo hen the blanket order becomes a sales order.  

Print on Invoice to include the memo on the invoice when the blanket order after 
processing occurs.  

Export to PO to export the memo to any purchase order  associated with the blanket 
order. Valid for direct ship lines.  

F3-Defaults 

Use this option to accept the system defaults on file for the remaining fields. If the 
program stops at an entry field, this means that the system could not find a valid 
default for the required field and a valid value must be entered before continuing. For 
example, you are entering blanket order detail and you choose F3 at the Add Days 
field. The system enters all default information until it reaches the Sugg PO field. At 
this point, you must decide whether or not to create suggested PO when 
insufficient available to commit? (Y/N).  

TIP: F3-Defaults Option Use this option to accept the system defaults on file for the 
remaining fields (after you enter the item number). If the program stops at an entry 
field, this means that the system could not find a valid default for the required field 
and a valid value must be entered before continuing. For example, you are entering 
blanket order detail and you choose F3 at the Add Days entry field. The system 
enters all default information until it reaches the Sugg PO entry field. At this point, 
you must decide whether or not to create suggested PO when insufficient available 
to commit? (Y/N).  

3 (Optional) If the system determines that the item number entered is not in standard 
inventory, it will prompt you to enter temporary and/or catalog information for the item 
number. Refer to the Temporary or Catalog Item Entry section for field descriptions.  

4 In the Desc entry field, the item description (up to 30 characters) defaults to the 
description from Item F/M, or Catalog F/M. The description defaults to Temporary if the 
item is not found on file. The warehouse code for the item also displays in the Wh entry 
field. 

5 In the Total Qty entry field, enter the total quantity to release over the life span of this 
BSO, up to 11 digits. Options available from this entry field include: Direct Ship - Use this 
option to ship the item directly from the vendor. If the item is a temporary item, then enter 
the vendor number from whom you wish to order this item. The warehouse entry field 
changes to F3-Change Whse Ship and enter the new warehouse.  

6 The system displays the default price from file, or accepts a manually entered price. You 
can enter a cost plus percentage in the Cost + % field. Cost plus pricing allows price to 
be set as a percentage over cost. Price will then be determined from the cost at the time 
of the release register. An asterisk (*) displayed to the right of the extended amount 



Sales Orders Transaction Procedures  

126 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

denotes a line-item price that contains a cost plus percentage. Press F2-Change UM to 
change the pricing unit of measure.   

7 In the Price field, the system will display the default price from file, or accept a manually 
entered price. Price will then be determined from the cost at the time of the release 
register. An asterisk (*) displayed to the right of the extended amount denotes a line-item 
price that contains a cost plus percentage. Press F2-Change UM to change the pricing 
unit of measure. Press F3-Price Search to activate the price search feature. 

8 The line-item extension is calculated (price less any discounts multiplied by the quantity 
ordered multiplied by the conversion factor) and displayed in the Extension field. If the 
extension is greater than $999,999.99 the message EXTENSION TOO LARGE is 
displayed and the field is not accepted. If the user has a line-item with sales up to one 
million dollars, enter the item on more than one line. At this point, headings for the line-
item fields used are displayed, and if the Display G.M.% flag in the Sales Orders Static 
Control Record is set to Q or A, the gross margin percentage is also displayed. If the 
calculated gross margin percentage is below the minimum or above the maximum, a 
message is displayed. 

9 The system displays a message asking: Enter release requests now for this item? Select 
yes to access the Blanket Sales Order Entry Release Requests (SOE711) to release 
requests for an item on the blanket sales order.   

10 (Optional) In the Commission % entry field, the commission percentage default is 
based on the Commission Flag (set to X-calculate) and the Commission Basis flag 
(item, customer, salesperson, contract pricing) priority setting in SM Company Control 
F/M and the (Change by Ln Comm%) SO Static Control F/M. The default commission 
percentage will display based on priority. This percentage can be changed, if necessary. 
For example, commission % defaults to 5% for Salesperson. You can increase or 
decrease the percentage, but you cannot change the setting to Item or Customer.  
 
Press F1 to set this field to Use Default when the user override flag is set.  
Calculating Commissions: There are five commission percent sources: customer, 
salesperson, item, price and current line commission. The system contains a user 
override flag and a price type to designate if the user overrode the line’s commission 
during order entry. Refer to the Calculating Commissions topic for processing details. 

11 (Optional) The Update Usage entry field accessible only if the BSO Override Usage flag 
in the SO Static Control is set to Yes or Password. Usage can be optionally entered by 
line-item and is used for restocking purposes.  

12 At the Create Suggested purchase order? prompt, press Enter (CR) to default to Yes. 
If you enter Yes, the system will commit available, backorder remaining and create a 
suggested PO; If you enter No, the system will commit available, backorder remaining 
but do not create a suggested PO. If you enter Always, the system will backorder the 
entire amount and create a suggested PO. All Temporary items are handled by this last 
method. This option is used to determine how inventory commitment and suggested 
PO's will be handled for each stocked item at the time of release.  

13 (Optional for BOM items) In the BOM Update entry field, press Enter (CR) to default to 
Finished.  
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14 In the Discount entry field, enter the discount (percentage or dollars) given to the 
customer for this line item. Accessibility to this field is allowed if the Use Line Discount 
flag in the SO Static Control file is set to % or $.  

15 Press Enter (CR) to accept the line item you entered, F2 to view release requests for the 
line item, or F4 to backup to the prior entry field. Release dates can be entered for each 
line item or generated for the entire blanket order after line-item detail entry is complete.  

16 (Optional--Release Requests by Line Item) If you press F2, the system displays the 
Release Requests for the selected line item; you can add or change request dates. The 
Release dates and item quantity distribution can be calculated flexibly and automatically 
by document or by line item. Press F3 to flag items for immediate release, regardless of 
release dates. Items flagged for immediate release will be processed during the next 
BSO Release Register. All items with the same release date will be processed at the 
same time on the next BSO Release Register. Press F4 to Exit. Release quantity is 
checked for distribution; the following prompt will display: Item is over distributed. 
Change total requested quantity for the item from XX to NN? (where XX is the original 
distributed quantity and NN is the distributed quantity equal to the current quantities). 
Enter Yes to change the requested quantity; enter No to correct the distributed quantity. 
The undistributed quantity must equal zero to exit this screen.  

17 The system displays a message asking: Enter release requests now for this item? Select 
yes to access the Blanket Sales Order Entry Release Requests (SOE711) to release 
requests for an item on the blanket sales order and repeat this process for each line item 
you want to add to the blanket order, then press F3-End Entries to end line-item entry. 
The system updates the line items on the blanket order. The line number is incremented 
by one, displayed, and the program returns to the item entry field for the next line-item 
entry. 
Select Stop to stop entering line items.  

18 You have the following options:  

Select the Archived BSO button to access to the UnForm Archive window to review 
archived blanket sales order documents. 

Select the Doc Distrib button to access to the Change Document Distribution window. 

Select the Release Req button to access to the Blanket Sales Order Entry Release 
Requests (SOE711) to release blanket sales order requests for an individual line item or 
all line items on a document.  

Select the Header button to access the Header Detail for Documents screen, which is 
used to view and/or modify warehouse, shipping information, request and order dates, 
and salesperson, freight, terms and ship via codes.  

Highlight a line item and select the Line Detail button to access the Line Detail for 
Documents screen, which is used to view and/or modify item descriptions, quantity and 
shipping information, costing, and PO information.  

19 (Optional) You can: 
access Note Entry (SME710) for the customer, item, quote header or line record 
specified in the program. Edit - to make changes for the highlighted line item.  
 
Add a line. 
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Delete the highlighted line.  
 
Insert a line item above the highlighted item in the browser. 
 
Save your changes. 

20 Press Done to access the footer screen for Blanket Sales Orders. 

21 When you have completed adding/modifying line items and request dates, press F3-End. 
Refer to the procedure, How to enter blanket order footer information for step-by-step 
instructions. 

How to enter blanket order footer information 
1 Once the blanket order item information is complete and you press Done, the system 

displays the Blanket Sales Order Footer screen. 

2 In the Document Memo entry field, enter the memo to be added to the pick ticket and 
the sales order. Press Enter (CR) to default to the standard memo set in the Document 
Print Control Record.) If no memo is needed, press the space bar before pressing Enter 
(CR).  

3 This system performs an initial credit limit check. You can enter a blanket order 
document for a customer who has exceeded their credit limit, however, the system 
performs another credit limit check on the sales order document that is generated from 
the blanket order.  

4 Select the Print Blanket Order Acknowledgement Now?  checkbox to indicate you 
want to print the blanket order acknowledgement at this time.  

5 Press OK, and the system completes the blanket order processing and returns you to the 
BSO Doc entry field so you can enter or modify another blanket order. 

Printing the Blanket Order Release Register 
1 Access this program by choosing Sales Orders > Orders >Blanket Sales Orders>Blanket 

Order Release Register.  

2 In the Date entry field, enter the date from which the system will calculate the scheduled 
releases. The date must be on or after the current system date. Press F1 to default to the 
system date.  

3 In the Scope entry field, select whether to process Printed documents only or All 
documents. The program defaults to Printed 

4 In the Memo entry field, select whether to include memo lines on the report. The 
program defaults to No.  

5 Enter Yes to print the register, or press F4 to backup. The system prints the register for 
the selected documents.  
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Automatically removing completed BSO documents 
1 Open the Blanket Order Removal program. You can access this program by selecting 

Sales Orders > Orders >Blanket Sales Orders>Blanket Order Removal.    

2 The Blanket Order Removal program displays the following default field values: 

 Order--Customer 

 Beginning--First 

 Ending--Last 

 Warehouse--The warehouse assigned to the current terminal 

 Cutoff Date--The date stored in GL: Company Periods and Ending Dates F/M, Last 
Period 

20 You can press: 

 Enter (CR) to run this program using the defaults. 

 F1 to access template information for this program. 

 F3 to change the default field values listed in step 2. 

 F4 to exit without running the removal program.   

Invoices Transaction Procedures 

Confirming an order  
1 Open Order Confirmation by selecting Sales Orders>Invoices>Order Confirmation. 

2 Open an order: In the Document field, enter the number of the order you want to 
confirm.  
 
You can Press F2 to search for documents. 
Refer to the How to open a document in Order Confirmation procedure for details.  

3 If multiple warehouses exist on the order, you must select the warehouse or warehouses 
to confirm before you can select a confirmation method. Select a warehouse to confirm if 
more than one warehouse appears on the order.  
The Assume Shipment window appears after you open a document in Order 
Confirmation. Select the shipping options for confirmation. Refer to the Choosing a 
confirmation method topic for details. Choose a confirmation method: 

Assume shipment all committed quantities 

Backorder all committed quantities 

Leave all committed quantities as committed 

Confirm the order line by line. 
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4 (Optional) Based on settings for Confirmation in SO Entry Options F/M, the system 
displays a window for entry of the invoice date and ship date for the order you are 
confirming.  
 
In the Invoice field enter the confirmation date, usually the system date.  
 
In the Shipped field enter the date the order ships, usually the system date. 

5 In the Ship-to field, the system displays the ship-to code entered on the sales order 
along with the full ship-to address. Edit the ship-to code, if necessary. If a customer 
requests to have an order shipped to an address other than its usual shipping address, 
use the Temporary Ship-to feature to facilitate this request. You can Press F2 to search.  

6 Based on the shipping option for confirmation, confirm the individual line items as 
necessary.  

7 (Optional) You can: 
 
Change quantity information by highlighting a line item then selecting the Edit icon. Refer 
to the Editing line items in entry programs topic for details.  
 
Edit lines on the order as necessary by highlighting them in the item browser, and 
selecting the Line Detail button to make changes in the Line-item Detail Entry window.  
 
Edit header information on the order as necessary by highlighting them in the item 
browser, and selecting the Header Detail button to make changes in the Header Detail 
Entry window.  
 
Add line items or insert line items above the highlighted line in the browser.  
Refer to Adding line items in Order Confirmation Entry topic for details.  
Access Note Entry (SME710) for the customer, item, sales order header or line record 
specified in the program. 
 
Delete a line item by highlighting it and selecting Delete.  
 
You can choose Stop Conf to perform a partial confirmation – in other words leave some 
items unconfirmed, as in a multiple warehouse order – or to interrupt confirmation on a 
document. Refer to the Stopping confirmation topic for details.  

8 Choose Done to access the footer and enter freight. Select Payments if you need to 
place a deposit on the order or enter a payment. The Deposit/Payment Entry window can 
also be accessed from the footer.  

9 (Optional) In the Memo field, enter a memo for the invoice.  

10 Unless the Freight Type is prepaid, enter or update freight and handling charges in the 
Freight $ field. Press F2 to access the Freight Totals Display window Enter freight and 
handling, if applicable, in the document footer. Refer to the Entering Freight and 
Handling (Sales Orders) topic for details.  

11 You can modify values for the following fields: Ship To, Freight Code, Tax Code, and Tax 
Rate. You can also enter payment information. Refer to the Order Confirmation Footer 
Information topic for specific field descriptions. 
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12 Choose whether to print the invoice immediately or batch print it through Invoice & Credit 
Memo Print program later.  
 
You may want to batch print invoices at a later time if: 
 
You are partially confirming a multiple warehouse order and want to confirm additional 
warehouses. Once you print an invoice in documentation, the document is then closed 
for further confirmation. You must wait until the invoice is updated by the DSR until you 
can confirm the rest of lines for the other warehouses. 
 

13  If you choose to print the invoice now, select a printer in the dialog box.  
 
The system displays the Sort by Shipping Whse prompt. (This prompt is also available in 
the Print option from the menu.) The Sort by Shipping Whse prompt defaults to Yes 
when printing from the Order Confirmation, Direct Invoice Entry or Credit Memo Entry 
programs. 

14 At this point, you can confirm another document, exit the Order Confirmation program by 
selecting the Done button, or switch to another Sales Order entry document from the Go 
To menu. 

Choosing a confirmation method 
1 The Assume Shipment window appears after you open a document in Order 

Confirmation. If multiple warehouses exist on the order, you must select the warehouse 
or warehouses to confirm before you can select a confirmation method. 

2 Several options are available in this window: 

Y-Assume shipment of all committed quantities. This option sets all committed 
quantities to shipped. This is the default option and the most likely choice if the order 
was completely filled or almost completely filled.  

For instance, say you receive a pick ticket with 15 items listed, but one of the items 
could not be picked. You can select the Assume shipment option to auto confirm and 
then change the one line item to backordered. 

If the program asks How should the committed quantity for this line be handled? It 
means: 

A line is on hold or is rejected 

Negative on-hand quantities are not allowed, and a BOM component in a line creates 
a negative on-hand quantity. 

 Enter B to backorder the committed quantity or C to leave the quantity committed. 
The program defaults to backorder. 

 This prompt only appears if you select the Y- assume shipment of all committed 
quantities and the Commit in Confirmation flag in the SO Static Control F/M is 
selected (or set to Y).  
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N - do not assume shipment of all committed quantities, instead backorder all 
committed quantities. This may be helpful for orders that may not be able to ship 
the same day the customer ordered the items. 

Backordered quantities must be committed through the Commit Backordered 
Quantities program. 

B - confirm shipment of committed quantities line by line. Use this option for 
orders that have a mixed bag of items that can ship or that need to be backordered, 
you may want to confirm line by line to ensure accuracy. 

3 A dialog box asks "Confirm Shipment for this line?" for each line on the document. 
Choose one of the following options: 

 Y -  Ship committed quantity for this line. This option is only available if shipment 
of this line is allowed. 

N -  Do not ship the committed quantity, backorder this line. This option is only 
available if backorders are allowed. 

C -  Do not ship, leave quantity committed for this line. This option is only 
available if commitment in confirmation is allowed. 

S -  Ship the committed quantity for this and all remaining lines. This option is 
only available if shipment of this line is allowed. 

B -  Backorder committed quantity for this and all remaining lines. This option is 
only available if backorders are allowed. 

L -  Leave this line and remaining lines committed. This option is only available if 
commitment in confirmation is allowed. 

In some cases, only one of these options is available in a confirm-line-by-line 
situation. If so, a message appears to this effect. 

If none of these options are allowed (i.e., cannot ship this line, cannot leave quantity 
committed and cannot backorder) the system forces the quantity to remain 
committed regardless of how the Commit in Confirmation flag is set.  

C - do not assume shipment, leave all lines committed. This option only appears 
if the Commit in Confirmation flag is selected or set to Y in the SO Static Control 
F/M. 

Use this option to set the shipped, committed and backordered quantities manually 
by editing each line on the main Order Confirmation screen. With this option, the 
system assumes nothing. You enter all quantities for each line. 

Entering a new direct invoice (process overview) 
In many respects, entering a direct invoice is similar to entering a sales order; however, the 
footer of a direct invoice is the same as the one used in Order Confirmation. 

1 Open Direct Invoice Entry (Sales Orders>Invoices>Direct Invoices; access code DI). 

2 To enter a direct invoice: 
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Enter a customer number or press F2 to search for a customer number.  
 
To enter the customer for the direct invoice, you can press F1 to access the Quick 
Customer Add dialog box, which is used add customers on-the-fly. 

Tip: The system automatically creates a document number once you complete the 
header. At that point, the document number appears in the title bar along with the 
customer’s name. You can also assign a document number manually if you prefer. You 
can access the Add New Document dialog box, where you can manually enter the new 
sales order number. 
 
Refer to the Creating document numbers in Direct Invoice Entry topic for details.  
 
To open an order: In the Doc/Cust field, enter the number of the confirmed order you 
want to modify or the customer for whom you are entering direct invoices or modifying 
confirmed orders.  

3 In the Ship-to field, the system displays the ship-to code entered on the sales order 
along with the full ship-to address or the default ship-to code for the customer. Edit the 
ship-to code, if necessary. If a customer requests to have an order shipped to an 
address other than its usual shipping address, use the Temporary Ship-to feature to 
facilitate this request. You can Press F2 to search. 

4 In the Invoice field enter the confirmation date, usually the system date. 

5 In the Shipped field enter the date the order ships, usually the system date. 

6 Select a warehouse to confirm if more than one warehouse appears on the order. 

7 (Optional) The program automatically switches to add mode once you complete the 
header. This means the cursor appears in the Item Number field after you exit the last 
header field. 
 
You can: 
 
Change quantity information by highlighting a line item, selecting Edit. Refer to the 
Editing line items in entry programs topic for details.  
 
Edit lines on the order as necessary by highlighting them in the item browser, and 
selecting the Line Detail button to make changes in the Line-item Detail Entry window.  
 
Edit header information on the order as necessary by highlighting them in the item 
browser, and selecting the Header Detail button to make changes in the Header Detail 
Entry window.  
 
Add or insert line items above the highlighted line in the browser.  
Refer to Adding line items in Direct Invoice Entry topic for details.  
 Access Note Entry (SME710) for the customer, item, direct invoice header or line record 
specified in the program. 
Delete a line item by highlighting it and selecting Delete.  
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8 Choose Done to access the footer and enter freight. Select Payments if you need to 
place a deposit on the order or enter a payment. The Deposit/Payment Entry window can 
also be accessed from the footer.  

9 (Optional) In the Memo field, enter a memo for the invoice.  

10 Unless the Freight Type is prepaid, enter or update freight and handling charges in the 
Freight $ field. Enter freight and handling, if applicable, in the document footer. Press F2 
to access the Freight Totals Display window; if you are using quoted freight, the system 
displays the Quoted Freight Entry window instead. Refer to the Entering Freight and 
Handling (Sales Orders) topic for details.  

11 You can modify values for the following fields: Ship To, Freight Code, Tax Code, and Tax 
Rate. You can also enter payment information. Refer to the Direct Invoice Footer 
Information topic for specific field descriptions. 

12 Choose whether to print the invoice immediately or batch print it through Invoice & Credit 
Memo Print program later. You may want to batch print invoices at a later time if: 
 
You are partially confirming a multiple warehouse order and want to confirm additional 
warehouses. Once you print an invoice in documentation, the document is then closed 
for further confirmation. You must wait until the invoice is updated by the DSR until you 
can confirm the rest of lines for the other warehouses. 
 
You use Clippership and have not closed out carriers for day or shift. Tracking numbers 
do not appear on the invoice until the carriers have been closed out in Clippership. If you 
print invoices before the carriers are closed out, you will have to reprint the invoices to 
get tracking numbers on the invoice.  
 
You use Clippership and UNDEFINED appears in the Freight Totals window for shipping 
charges (attended/polling systems). If you print invoices on these documents, they 
appear on the DSR as invoices that need to be reprinted because "shipping has not 
been completed."  

13 If you choose to print the invoice now, select a printer in the dialog box.  
 
The system displays the Sort by Shipping Whse prompt. (This prompt is also available in 
the Print option from the menu.) The Sort by Shipping Whse prompt defaults to Yes 
when printing from the Order Confirmation, Direct Invoice Entry or Credit Memo Entry 
programs. 

14 At this point, you can modify another confirmed order or enter/modify another direct 
invoice, exit the Direct Invoice Entry program by selecting the Done button, or switch to 
another Sales Order entry document from the Go To menu. 

Creating document numbers in Direct Invoice Entry 
Invoice numbers (not to be confused with document numbers) are assigned just before 
each document is printed. Invoice numbers are not affected by reprinting. 
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The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the customer’s name. 
You can also assign a document number manually if you prefer. 

To create document numbers manually: 

1 Open Direct Invoice Entry by choosing Sales Orders>Invoices>Direct Invoice or by 
entering the access code DI. 

2 Choose File>New Document Number from the menu.  

3 Enter up to six characters to create a document number. Choose OK or press Enter 
(CR). The document number appears in the title bar. 

4 Begin entering the invoice, starting with the Customer Number. 

Entering a new credit memo 
Entering a credit memo is not unlike entering orders or invoices. However, the quantities 
appear and print as negative numbers and you enter returns codes to indicate why items are 
being returned.  

To enter a credit memo: 

1 Open Credit Memo Entry (Sales Orders>Invoices>Credit Memo Entry; access code CM). 

2 To enter credit memo information: 
 
Enter a customer number or press F3 to search for a customer number.  
 
To enter the customer for the credit memo, you can press F1 to access the Quick 
Customer Add dialog box, which is used add customers on-the-fly. 
Tip: The system automatically creates a document number once you complete the 
header. At that point, the document number appears in the title bar along with the 
customer’s name. You can also assign a document number manually if you prefer. You 
can access the Add New Document dialog box, where you can manually enter the new 
credit memo number. 
 
 
To open a credit memo: In the Doc/Cust field, enter the number of the credit memo 
you want to modify or the customer for whom you are entering or modifying credit 
memos.  
Refer to the Opening existing credit memos topic for details. 

3 In the Ship-to field, the system displays the default ship-to code for the customer. Edit 
the ship-to code, if necessary. If a customer requests to have an order shipped to an 
address other than its usual shipping address, use the Temporary Ship-to feature to 
facilitate this request. You can Press F2 to search. 

4 (Optional) In the Invoice field, enter the invoice number against which you are entering 
the credit memo. 
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5 In the Memo Date field enter the date the you created the credit memo, usually the 
system date. 

6 In the Invoice Date field enter the date you invoiced the credit memo, usually the system 
date. 

7 Select a warehouse to confirm if more than one warehouse appears on the order. 

8 (Optional) The program automatically switches to add mode once you complete the 
header. This means the cursor appears in the Item Number field after you exit the last 
header field. 
 
You can: 
 
Change quantity information by highlighting a line item, selecting Edit. Refer to the 
Editing line items in entry programs topic for details.  
 
Edit lines on the order as necessary by highlighting them in the item browser, and 
selecting the Line Detail button to make changes in the Line-item Detail Entry window.  
 
Edit header information on the order as necessary by highlighting them in the item 
browser, and selecting the Header Detail button to make changes in the Credit Memo 
header detail window.  
 
Add line items or insert line items above the highlighted line in the browser.  
Refer to Adding line items in Credit Memo Entry topic for details.  
Delete a line item by highlighting it and selecting the Delete icon.   
 
Select to access Note Entry (SME710) for the credit memo header or line records 
specified in the program, or for the item highlighted in line item browser.  

9 Choose Done to access the footer and enter freight. Select Payments if you need to 
place a deposit on the order or enter a payment. The Deposit/Payment Entry window can 
also be accessed from the footer.  

10 (Optional) In the Memo field, enter a memo for the invoice.  

11 In the Frt Method field the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
checkbox on the Invoicing tab of AR Customer Maintenance and is not a backorder. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  
Unless the Freight Type is prepaid, enter or update freight and handling charges in the 
Freight $ field. Enter freight and handling, if applicable, in the document footer. Press F2 
to access the Freight Totals Display window; if you are using quoted freight, the system 
displays the Quoted Freight Entry window instead. Refer to the Entering Freight and 
Handling (Sales Orders) topic for details.  

12 You can modify values for the following fields: Ship To, Freight Code, Tax Code, and Tax 
Rate. You can also enter payment information. Refer to the Credit Memo Footer 
Information topic for specific field descriptions. 

13 Choose whether to print the invoice immediately or batch print it through Invoice & Credit 
Memo Print program later. If choose to print the document now, select the printer from 
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the dialog box. You can press F2 to search the list of printers. 
You may want to batch print invoices at a later time if you are partially confirming a 
multiple warehouse order and want to confirm additional warehouses. Once you print an 
invoice in documentation, the document is then closed for further confirmation. You must 
wait until the invoice is updated by the DSR until you can confirm the rest of lines for the 
other warehouses. 

14  If you choose to print the invoice now, select a printer in the dialog box.  
 
The system displays the Sort by Shipping Whse prompt. (This prompt is also available in 
the Print option from the menu.) The Sort by Shipping Whse prompt defaults to Yes 
when printing from the Order Confirmation, Direct Invoice Entry or Credit Memo Entry 
programs. 

15 At this point, you can modify another confirmed order or enter/modify another direct 
invoice, exit the Credit Memo Entry program by selecting the Done button, or switch to 
another Sales Order entry document from the Go To menu. 

Printing the Daily Sale Register (DSR) 
1 Access this program by choosing Sales Orders>Invoices>Daily Sales Register. 

2 In the Date field, enter the sales register date. Press F1 defaults to the system date. This 
displays the date and the current AR and GL periods. The period the sales register posts 
to in SA is the same as the period that it posts to in GL and is based on the register date 
that you enter here. 

3 In the Warehouse field, enter up to 20 two-character warehouse codes side by side to 
indicate the warehouse(s) for which register is to print. The codes must already be set up 
in Warehouse F/M on the IC Infrequent File Maintenance menu. The program defaults to 
the warehouse assigned to the terminal.  

4 In the Department field, enter as many GL department numbers as will fit in the field for 
which the register is to print. (GL department length is user-defined in the SM Company 
Control F/M. 
 
The field length is 40, so if the department length is two, enter up to 20 department 
numbers; if it’s three, enter up to 13; or if it’s four, enter up to 10. Department numbers 
must be on record in the GL Department F/M. F2 allows a search. F3 defaults to ALL. 

5 In the Scope field, enter whether to print S-summary or D-detail information. The 
program defaults to Summary. 

6 When the system displays: Correct, indicate whether or not this is the correct date and 
GL and SA period for the sales register to post. The Daily Sales Register prints by 
reading through the Ready-For-Register File. Information about each document prints as 
the General Ledger Distribution File is built. 

7 If you print the GL distribution, the following field displays: Check register. OK to print GL 
distribution? 

8  After printing the Daily Sales Register, verify the printout. If there is a correction to be 
made, exit the program and make the necessary corrections. After the correction is 
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made, the register can be rerun. If everything is correct, print the GL distribution. Once 
the GL distribution prints, proceed to: Check GL distribution. OK to update? 

9  After printing the GL distribution, verify the printout. If everything is correct, enter YES 
to continue. The program proceeds with the update. If there is a correction to be made, 
enter N to exit the program. After the correction is made, the entire register process 
begins again. 

10  If you do not print the GL distribution, the following field is displayed: Check register. OK 
to update? 

11  After printing the Daily Sales Register, verify the printout. If there is a correction to be 
made, exit the program and make the necessary corrections. After the correction is 
made, the register can be rerun. If everything is correct, proceed with the register update. 

12 Select the OK button to print the register. The system prints the register for the selected 
documents.  

13 The system displays the message: Invoice Receipt Register: OK to Update? 

14     After printing the Daily Sales Register, verify the printout. If you need to correct the 
register data, select Cancel or enter N to exit the program. After you make the correction, 
you can rerun the Invoice Daily Sales Register. If everything is correct, select OK or 
enter YES to continue. The program then prints the GL distribution.  

Using the Counter Sale system (Overview) 
1 At the beginning of a shift, open Update Shift to open a drawer, assign a tray to it and 

place an opening amount in the tray. 

2 Have your sales clerks sign on to cash drawers in Cash Drawer Sign On.  This program 
shows you which drawers are already in use and tells you which terminals (users) are 
signed on to them. If someone forgets to sign on in this program, the system will prompt 
them to do so when they enter a cash-type payment in Counter Sale Entry or 
Payment/Deposit Entry. 

3 Begin entering sales in the Counter Sale Entry. 

4 At the end of the shift, open Update Shift to remove trays from their respective drawers. 
Trays are actually removed by assigning another balanced tray to the same drawer. 
Once another tray is assigned, the first tray is automatically removed and ready to be 
balanced.  

5 Open Balance Cash Trays to count out the trays and run Z-out reports, which are 
printouts of the transactions run through those trays. A currency calculator is available to 
help you keep an accurate count of currency, checks, credit card slips, etc.  

6 Once a tray is balanced it can be assigned to another drawer.  

7 At the close of a day, make sure all drawers are signed off by entering Cash Drawer 
Sign On and setting each drawer to NONE.  
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Entering a new counter sale document 
1 Open Counter Sale Entry by selecting Sales Orders>Counter Sales>Counter Sale Entry. 

2 To open an existing counter sale: In the Doc/Cust field, enter the number of the counter 
sale you want to open or the customer for whom you are entering/modifying counter 
sales.  

3 In the Ship-to field, the system displays the ship-to code entered on the sales order 
along with the full ship-to address. Edit the ship-to code, if necessary. If a customer 
requests to have an order shipped to an address other than its usual shipping address, 
use the Temporary Ship-to feature to facilitate this request. You can Press F2 to search. 

4 In the Date field enter the date for the counter sale transaction, usually the system date. 

5 In the Initiating Warehouse field enter the warehouse from which the items on this order 
are shipping. If your system uses multiple warehousing, enter the warehouse from which 
this order initiated. Press F2 or choose the Search button to see the list of warehouses. . 

6 (Optional) The program automatically switches to add mode once you complete the 
header. This means the cursor appears in the Item Number field after you exit the last 
header field. 

7 (Optional) You can: 
 
Change quantity information by highlighting a line item, selecting Edit. Refer to the 
Editing line items in entry programs topic for details.  
 
Edit lines on the order as necessary by highlighting them in the item browser, and 
selecting the Line Detail button to make changes in the Line-item Detail Entry window.  
 
Edit header information on the order as necessary by highlighting them in the item 
browser, and selecting the Header Detail button to make changes in the Header Detail 
Entry window.  
 
Add line items or insert line items above the highlighted line in the browser.  
  
Refer to Adding line items in Counter Sale Entry topic for details.  
Delete a line item by highlighting it and selecting Delete. 
 
If you add an item that is designated as having companion items, the system displays the 
Companion Item Selection (SOE151) screen. Refer to the Companion Item Selection 
(SOE151) topic for details.  

8 Choose Done to access the footer and enter freight. Enter payments in multiple payment 
section The Deposit/Payment Entry window can also be accessed from the footer.  

9 (Optional) In the Memo field, enter a memo for the invoice.  

10 In the Frt Method field, the system displays the Document Freight Method (Q/C) for this 
customer– this value defaults from AR Customer Maintenance and is modifiable based 
on the Allow Method Change checkbox on the Invoicing tab of AR Customer 
Maintenance and is not a backorder. Based on the setting, you can select from: Quoted 
Freight or Calculated Freight. 
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In the Frt Method field the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
checkbox on the Invoicing tab of AR Customer Maintenance and is not a backorder. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  
Unless the Freight Type is prepaid, enter or update freight and handling charges in the 
Freight $ field. In the Freight $ field, the freight value can be entered freight, quoted 
freight or automatically-calculated freight, based on control settings in AR Customer 
Maintenance and SO Static Control F/M (SOF980). You can modify the entered freight, 
quoted freight amount. Press F2 to access the Freight Totals Display window Enter 
freight and handling, if applicable, in the document footer. Refer to the Entering Freight 
and Handling (Sales Orders) topic for details.  

11 You can modify values for the following fields: Ship To, Freight Code, Tax Code, and Tax 
Rate. You can also enter payment information. Refer to the Counter Sale Entry Footer 
Information topic for specific field descriptions. 

12 Indicate whether you want to print the invoice now or print it later from the Counter Sale 
Print.  You may want to print later if you print invoices before the carriers are closed out, 
you will have to reprint the invoices to get tracking numbers on the invoice.  

13  If you choose to print the counter sale now, select a printer in the dialog box.  

14 At this point, you can enter another document, exit the Counter Sale Entry program by 
selecting the Done button, or switch to another Sales Order entry document from the Go 
To menu. 

Refunding Counter Sales (process overview) 
Before issuing refunds with Credit Memo Entry, use Credit Memo Entry to perform refunds 
on counter sales receipts.  

Performing a refund: 

1 If you are already in Counter Sale Entry, select Go To>Credit Memo Entry from the 
menu. Otherwise type the access code CM at a FACTS menu screen. 

2 In Credit Memo Entry, enter the document header. Use the Invoice field in the header to 
apply the credit memo to an existing invoice.  

3 When you complete the header, press Enter (CR) to add the returned item information 
on the document.  

4 Enter the item number. Press F2 to search on items. 

5 Enter the quantity being returned. You do not need to enter a minus; the program 
automatically inserts one. 

6 Enter a two-character reason code. Press F2 to search for a reason code that best 
describes the customer’s reason for returning the item or items.  

7 Enter the price of the item being returned. Press F2 to change the pricing UM. Press F3 
to use the Price Search feature. 
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8 Add additional items if necessary. 

9 Choose Done when you are finished entering items to access the credit memo footer. 

10 Select a Refund Type in the footer. 

11 (Optional) To apply the refund to a customer’s account, use the A/R Terms field.  
 
Press F2 and select the CM A/R terms code in the search window. The CM, or credit 
memo, terms code uses no discounts or payment schedules.  It simply tells FACTS to 
post the document to the Accounts Receivable module.  
 
You can set CM as the default A/R terms code for all Credit Memo documents on the 
Inventory tab of the SO Static Control F/M. 

12 (Optional) To give the customer a cash refund, use the Cash Terms field.  
 
 Press F2 and select a Type C Cash Terms code from the search window. Enter the 
amount of the refund. Make sure you enter the amount as a negative number. For 
example, enter -50.50 if you want to give the customer $50.50 back in cash.  

13 (Optional) To apply the refund to the customer’s credit card, select the Payments 
button to access the Deposit/Payment Entry window.  
 
Press Enter in the Deposit/Payment Entry window or choose the Add button to the right 
of the browser. 
 
Enter a credit card terms code or press F2 to search for the appropriate credit card terms 
code.  
 
Enter the amount of the refund as a negative number, for instance -50.50, and press 
Enter (CR). 
 
Enter the credit card number and the expiration date, or swipe the card. 

14 Enter notes (optional). 

15 Choose Save. 

16 If you are not already signed onto a cash drawer, press F2 and select a cash drawer with 
a tray assigned to it from the search window.  

17 Choose Done to return to the Credit Memo Footer. 

18 Make sure the document is zeroed out. Choose OK to print the credit memo. 

Entering recurring document header information 
1 Open the Recurring Document Entry program. You can access this program by selecting 

Sales Orders > Recurring Invoices>Recurring Document Entry.  

2 Enter the customer number for the customer receiving the invoice. Press F2 to perform a 
customer search or F3 to perform a document search for recurring documents already on 
file. The system performs a credit check on this customer once you enter the number.  
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3 Enter the sequence number (0-99) for the document to be created. The sequence 
number is a counter that allows a given customer to have multiple recurring documents. 
Sequence 01 for example, can be considered the first recurring document for the 
customer. Press Enter (CR) to initially default to 0 

4 The system populates the remaining recurring document header fields with default 
information. At any point during the header inputs through Reference Number, you can 
press F3-header defaults. Pressing F3 causes the program to display the defaults on file 
from that input forward and skip to Reference Number. Refer to the Recurring Document 
Header topic for field definitions.  

5 NOTE: If the program does not skip to Reference Number and instead stops at an earlier 
input, the system could not find a valid default value for that input, and the user must 
enter a valid value before continuing.  

6 When you complete the recurring document invoice header information, the system 
displays the system displays the line-item detail screen. Refer to the How to enter line 
items on recurring document invoices procedure for step-by-step instructions. 

Entering or modifying line items on recurring document invoices 
1 Once the required header information is complete, the system displays the command 

prompt at the bottom of the screen, you can perform the following functions: 

Line #-Enter the line number to change. Enter the line number to select. Entering a line 
number sets the quantity default to the same amount sold the last time (displayed in the 
units column). Price is not affected. Press Enter (CR) displays more sales, if any. 

L-List 

A-Add a line 

D-Delete the highlighted line. 

F2-Change header information. 

F3-End line-item entry. 

2 (Optional) To add an item to the recurring document invoice, complete the following: 
 
In the Item Number input, you can enter the item number or perform the following 
functions:  

I  -  To display items and their corresponding interchange. 

A  -  Search catalog items  

L  -  Allow a lost sales entry  

P  -  Display past sales of all items in the selected warehouse. Item number, date 
sold, invoice number, quantity sold, price, and unit of measure.  

C  -  Search customer/item numbers  

#  -  Enter an item number or an interchange number  

M  -  Enter a memo  
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F1  -  Enables the Quick Item Add (ICF020) program.  

F2  -  Allows an item search  

F3  -  Ends line-item entries  

3 After entering a valid item the program displays item description 1 and 2, the item class, 
package size, item weight and its unit of measure, available quantity, on hand quantity, 
on order quantity and bin location. The program displays the Temporary, Vendor, Item 
Class, U of M, Weight, and Commission Percent inputs are only displayed if the item is a 
temporary item.  

4 Enter the quantity of the item to be sold per displayed unit of measure or select a display 
code. If this is a BOM finished item that can be assembled in SO, you may be able to 
enter component items. If this item has multiple selling units of measure, press F2 to 
change the unit of measure.  

5 Enter the cost per displayed costing unit of measure. The Cost input is available if the 
Change by Ln Cost flag in the SO Static Control Record is set to Y or B. If the Change by 
Ln Cost flag is set to B, press F4 to back up to this input. This input is also available if the 
item is temporary.  

6 Enter the price per displayed pricing unit of measure. Press Enter (CR) to default to the 
default price per the pricing hierarchy. Select the following (if available): S-Standard 
Price, C-Contract, T-List, L-Last, or enter L and a level number for a price level or enter 
Q and a quantity break level for a quantity break price. Press F2 to change the unit of 
measure for pricing if more than one is set up for this item. Press F3 to select another 
price via the price search. This input defaults to the pricing default UM for this item.  

7 (Optional) The system displays the Change Selling UM To Match Pricing UM prompt only 
displays if the pricing unit of measure entered in the previous input does not match the 
selling unit of measure. Enter Y or N to change the selling UM to match the pricing UM. 
Press Enter (CR ) to default to Y. If Y is entered, the value in the Quantity input may 
change.  

8 At this point, headings for the line-item fields used are displayed, and if the Display 
G.M.% flag in the sales orders static control is set to A, the gross margin percentage is 
also displayed.  

9 The line-item extension is calculated (price less any discounts multiplied by the quantity 
ordered multiplied by the conversion factor) and displayed. If the extension is greater 
than $999,999.99 the message EXTENSION TOO LARGE is displayed and the input is 
not accepted. If you have a line item with sales up to one million dollars, enter the item 
on more than one line.  

10 (Optional) Enter the discount amount or percent for this line. This input is only available if 
the Use Line Discount flag in the SO Static Control Record is set to % or $.  

11 (Optional) Enter the percent of commission. Press Enter (CR) to default to 0. This input is 
only available if the Change by Ln Comm% flag in the SO Static Control Record is set to 
Y or B. Press F1 to set this input to Use Default when the user override flag is set.  
Calculating Commissions: There are five commission percent sources: customer, 
salesperson, item, price and current line commission. The system contains a user 
override flag and a price type to designate if the user overrode the line’s commission 
during order entry. Refer to the Calculating Commissions topic for processing details. 
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12 (Optional) For the Taxable input, enter Y or N to indicate whether to charge tax for this 
line item. Press Enter (CR) to default to Y.  

13 (Optional) Enter the general ledger posting table to use in the Daily Sales Register to 
post this line to general ledger. Press F2 to perform a search. This input is only available 
if the Change by Ln GL Table flag in the SO Static Control Record is set to Y or B. If B is 
entered at Change by Ln GL Table , press F4 to backup to this input.  

14 If the line is correct, press Enter (CR) to continue. If the line is not correct, select F4 to 
back up to change the input that is not correct.  

15 Repeat this process for each line item you want to add to the recurring document invoice, 
then press F3-End Entries to end line-item entry. Refer to the procedure, How to enter 
recurring document invoice footer information for step-by-step instructions. 

Entering recurring document invoice footer information 
1 Once the recurring document invoice line item information is complete and you press F3-

End, the system displays the Memo input. Enter the memo to print on the recurring 
invoice. Press Enter (CR) to default to the displayed value (initially the standard memo 
set up in the Document Print Control Record). If no memo is desired, the user may press 
the space bar before pressing Enter (CR). Press F4 to back up to the selection prompt.  

2 (Optional) Enter the discount percent (maximum of 100) or dollar discount (maximum 
equals merchandise total) of the merchandise total. Press Enter (CR) to initially default to 
the invoice discount set in the customer file. This input only appears if % or $ was 
entered at the Use Invoice Discounts flag in the SO Static Control Record and is initially 
skipped if the total for the recurring invoice is zero.  

3 (Optional) If UPS was entered in the ship via input, enter the UPS zone here; otherwise, 
this input is skipped. The entry must be a valid zone as set up in the UPS Zone F/M. 
Press Enter (CR) to default to the zone of the ship-to's zip code.  

4 (Optional) The COM/RES input is skipped if the UPS zone is greater than 8. Enter 
whether this delivery is a C-commercial or R-residential UPS ground delivery. UPS 
charges different rates for commercial and residential deliveries. Press Enter (CR) to 
default to the default for the ship-to address.  

5 (Optional) If UPS was entered in the ship via input, enter the UPS zone here; otherwise, 
this input is skipped.  

6 Enter the weight of this package. Press Enter (CR) to default to the next highest whole 
pound from the weight entered in the IC Item F/M for this item.  

7 Enter the freight amount (+/-9999.99). Press Enter (CR) to default to 0, or if the ship via 
is UPS, to the freight calculated for the UPS zone.  

8 Enter the tax code for this ship-to customer. The entry must be a valid tax code. Press 
Enter (CR ) to default to the currently displayed value, initially the customer's tax code. 
This input is not available if the Charge Tax flag in the SO Static Control F/M is set to N. 
This input is initially skipped if the recurring invoice total is zero.  
 
NOTE: If you back up to this prompt after changing the tax rate or the tax amount and do 
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not select F1 - skip, the system recalculates the charges to reflect the tax code and the 
changes to the Tax Rate and Amount inputs are lost.  

9 (Optional) For the Tax Rate input, enter H-to use the high rate, L-to use the low rate, or X 
-to change tax status of this document to exempt. The rates are set up in the Accounts 
Receivable Tax Table F/M. Press Enter (CR) to default to the displayed value. This input 
is initially skipped. If the Charge Tax flag in the Sales Orders Static Control Record is not 
set to O, you are not able to override the tax code and this input is unavailable.  

10 (Optional) For the Tax Amount input, enter the amount of sales tax to charge for this 
invoice (+/-99999.99). Press Enter (CR) to default to the displayed value. This input is 
initially skipped. If the Charge Tax flag in the Sales Orders Static Control Record is not 
set to O, you are not able to override the tax amount and this input is unavailable.  

11 This concludes the ending routine of the Recurring Invoice Entry Program. Upon 
completion of the update, the screen is cleared of all input information and the program 
returns to the Customer Number input so you can enter more recurring documents or 
press F4 to exit the program.  

Freight Procedures 

Entering orders into the freight manifest system 
1 Open the Freight Entry program. You can access this program by selecting Sales Orders 

> Shipping >Freight Entry. 

2 Enter the order number for this shipment.  
 
You can enter 3 types of documents on this screen: 
-a valid sales order number displays the header information for that sales order.  
-a valid freight order number displays the document.  
-a new freight document that is not a sales order. You enter a new order number that is 
not on file when shipping packages that do not appear on sales orders.  

3 You can press F2 to perform a search and display all freight entries for the current 
warehouse or F3 to change the current warehouse.  
Tip: If this order is a multi-warehouse order, the Freight Totals Display window will 
display. This displays each warehouse that is on this order with the warehouse code, 
description, ship via and freight amount, as well as the total amount of freight for all 
warehouses on this order. Press Enter (CR).  

4 (Optional) If you enter an existing sales order or freight document, the system displays 
the document header information, such as the customer, ship via, zone, package total, 
charge information and freight line items for each package. For new freight documents 
complete steps 4-9. For existing fright or sales order documents, go to step 10.  

5 (Optional) For new freight documents, enter the customer code. The system displays the 
customer's assigned ship-to number, the ship via in the Ship-To Record, the default zone 
from the Ship-To Record; you can modify these values.  
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6 (Optional--For new freight documents) In the Com/Res field indicate whether this delivery 
is a C-commercial or R-residential UPS ground delivery. The system displays the default 
value for the ship-to address.  

7 (Optional--For new freight documents) In the Dept enter the valid general ledger 
department number that is approving this shipment as necessary. This field is initially 
skipped. Press Enter (CR) initially default to the general ledger department number 
assigned to the terminal. Press F2 to perform a search.  

8 (Optional--For new freight documents) In the line-item portion of the screen: 
 
In the WGT field, enter the weight of the package to be shipped (1-70). You can also 
enter L for letter service if the ship via is UPS RED, UPS 1ST, UPS BLU, or UPS 2ND or 
if the zone contains a Canadian air zone (87-89) or international zone (900-912, 921-
932). Press Enter ( CR) to initially default to the weight set up as the Default Weight in 
the Shipping Control Record.  
 
In the Tracking/ID# field, enter the tracking/id number. Press Enter (CR) to default to 
blanks.  
 
In the DCLRD VALUE field, enter the amount (0-99999.99) the user wants to declare as 
the value for the package. This amount is used to calculate insurance charges. If the 
carrier is UPS, there is no insurance charge for any value less than $100.00.  

9 (Optional--For new freight documents) Press Enter (CR) to accept the new line on the 
freight manifest. 
 
The system displays the messages: Print Shipping Label for This Line? or Print UPS 
C.O.D. label for this line? only if the Label at Each Line Item flag of the Shipping Control 
F/M is set to M (maybe). Enter Y or N to indicate whether a shipping label is to be 
immediately printed for this line-item. If you enter Y, the program prints a shipping label, 
UPS shipping label, or a UPS C.O.D. label, depending on the ship via. The printer is 
defined in the SM Program F/M for the Shipping Label Print Program (SOP410), UPS 
Shipping Label Print Program (SOP450), or UPS C.O.D. Label Print Program (SOP420).  
 
Press Enter (CR) to default to Y.  

10 (Optional--For new freight documents) You can repeat steps 7 and 8 to enter more lines 
on the freight manifest then press F3 to end line items entry and go to the selection 
prompt. 

11 At the selection prompt in the lower portion of the screen, you can perform the following 
functions: 

# - Changes a line-item  

L - Lists line-items  

A - Adds a line-item  

D - Deletes the order (if created from a sales order, the sales order is not affected)  

F2 - Changes the header  

F3 - Ends entries and proceeds to the ending routine  
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12 The system displays the message: Update freight on order? if the freight entry order 
number is a current sales order. The total freight charge for the order is displayed in the 
bottom right of the header. The current freight charge for the sales order is displayed. 
Enter whether this amount should be up dated to the freight field on the actual order. You 
can enter N-no, do not update the sales order, A-add the total freight charge to the 
existing amount on the sales order, or R -replace the current freight amount on the sales 
order with the total freight charge. Press Enter (CR) to default to N.  

13 The system displays the message: Print Shipping Labels Now? Enter N or Y to indicate 
whether to print the shipping labels for this order now. If you enter a Y, the program 
prints one label for each package. If the ship via is UPS the label printed is a UPS 
shipping label otherwise it is a general mail-shipping label. Press Enter (CR) to default to 
N.  

14 The system returns you to the Order field so you can enter freight or press F4 to exit the 
program. 

Contract Procedures 

Entering contract header information (customer scope, item scope, 
shipment scope, pricing UM, effective date and expiration date) 
1 Open the Contract Entry program. You can access this program by selecting Sales 

Orders > Contract Pricing> Contract Entry.  

2 In the Contract # field, enter the contract number to assign to this document. You can 
use the next contract number on file, search or copy a contract: The system displays a 
copy dialogue box where you can select the contract to copy, and enter a new 
description. The system loads the new contract for the user to edit. When you create a 
contract by copying it will force the Awaiting Review flag to default to Yes.   

3 In the Description field, enter the contract description. 

4 Enter the effective date of this contract price record.   

5 Enter the expiration date of this contract price. When running this Remove Contracts 
program, a cutoff date is entered and expiration dates up to that cutoff are removed. On 
any date after the expiration date, the contract price is not eligible for the price search 
program in the sales order entry programs. 

6 In the Type field, select a contract price type--Levels or Quantity Breaks. Refer to the 
Contract Pricing topic for details about contract price types. 

7 The Convert Fixed Prices and Qty Breaks field is only available if the contract is for a 
specific item and a specific UM. For all other quantity break contract types (non-specific) 
the flag is automatically set to Y and this field is skipped. Enter N or Y to indicate whether 
the quantity break prices for this item and UM should be used as the default to calculate 
prices for other quantity break UMs that do not have contract prices set up. For example, 
a quantity break price is set up for $5.00 EA for a minimum of 10 (10 EA /BX). If on the 
sales order 1 BX is sold the system would calculate a price of $50.00 BX. Or, a fixed 
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price is set for $1.00 EA , if there are 10 each per box, and a line is entered on a sales 
order with a UM of ‘boxes’ the system would calculate a price of $10.00 BX. 

8 Indicate whether this contract is for all customers by selecting the All Customers field. 
 
OR 
Press the Customer button or press F1 to access Customer Scope Entry (SOE561) to 
define the customers for the contract. 
 
If the contract is marked as valid for all customers, the Customers button is disabled. If 
you enter any information on the Customer Scope screen, then the system changes the 
All Customers prompt to selected (flag to "Yes)", and the system displays a message 
prompting for whether to remove all entries from the Customer Scope screen. If you 
select to not remove the Customer Scope information, the All Customers prompt will 
remain selected.  
 
If you don’t select the All Customers prompt and do not enter any information on the 
Customer Scope screen, the system will not allow you to exit.  

9 Indicate whether this contract is for all items by selecting the All Items field. 
 
OR 
Press the Item button or press F1 to access Item Scope Entry (SOE563) to define the 
customers for the contract. 
 
If the contract is marked as valid for all items, the Items button is disabled. If you enter 
any information on the Item Scope screen, then the system changes the All Items 
prompt to selected (flag to "Yes)", and the system displays a message prompting for 
whether to remove all entries from the Item Scope screen. If you select not to remove the 
Item Scope information, the All Items prompt will remain selected.  
 
If you don’t select the All Items prompt and do not enter any information on the Item 
Scope screen, the system will not allow you to exit.  

10 Indicate if the contract is valid for warehouse ships: If the Whse Ships prompt is set to 
Yes, you must enter the shipping warehouses that the contract applies to on the 
Shipment Scope screen. If it is set to No or All, individual warehouses cannot be entered 
on the Shipment Scope screen.  
 
To access the Shipment Scope Entry (SOE565) screen, press the Shipment button. 
 
If you enter any warehouse information on the Shipment Scope screen, then the system 
changes the Whse Ships prompt to Yes, and the system displays a message prompting 
for whether to remove all warehouses from the Shipment Scope screen. If you select not 
to remove the Shipment Scope information, the Whse Ships prompt will remain 
selected. 

11 Indicate if the contract is valid for direct shipments from vendors. If the Direct Ships 
prompt is set to Yes, you must enter the direct ship vendors that the contract applies to 
on the Shipment Scope screen. If it is set to No or All, individual vendors cannot be 
entered on the Shipment Scope screen.  
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To access the Shipment Scope Entry (SOE565) screen, press the Shipment button. 
 
If you enter any vendor information on the Shipment Scope screen, then the system 
changes the Direct Ships prompt to Yes, and the system displays a message prompting 
for whether to remove all vendors from the Shipment Scope screen. If you select not to 
remove the Shipment Scope information, the Direct Ships prompt will remain selected. 

12 (Optional) Enter the rounding code to establish rounding rules for contract prices.  

13 In the Excluded Items section of the screen you can select to exclude the following item 
types from the contract scope: Stocked, NonStocked, Uninventoried, and Catalog. 

14 After you complete the header information above, you can select from the options that 
are available during entry of contract prices:  

A or Add Choose this option to add contract pricing information for the first time to 
contracts. You must complete the contract header information before you can add 
pricing information to a contract. This option is available only if no contract pricing 
information is on file. Refer to the How to add pricing information to contracts or How 
to add quantity break price information to contracts procedure for step-by-step 
instructions.  

D or Delete Choose this option to delete the highlighted contract price line.  

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contract awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561) to enter any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to enter any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract.. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the 
contract is valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can 
enter or modify additional contracts. 

Editing existing contracts 
1 Open the Contract Entry program. You can access this program by selecting Sales 

Orders > Contract Pricing> Contract Entry.  

2 For existing contracts, enter the contract number in the Contract # field.   

3 When you enter the contract number, the system makes available the editable fields on 
the screen. 
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4 To edit existing contract prices for this contract, select one of the options across the 
bottom of the screen. Highlight a contract price (for Q-quantity break contract types or L-
price level contract types) in the browser in the lower portion of the screen and add 
pricing information. For Q-quantity breaks contract types you can enter a quantity break 
price and breaks 1-6. For L-price level contract types you can enter a standard price and 
price levels 1-6.  

5 The following options are available, when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561)  to enter any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to enter any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract.. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the 
contract is valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can 
enter or modify additional contracts. 

Adding quantity break price information to contracts 
1 Open the Contract Entry program. You can access this program by selecting Sales 

Orders > Contract Pricing> Contract Entry.  

2 For new contracts, refer to the How to enter contract header information procedure for 
details. For existing contracts, enter the contract number in the Contract # field.   

3 In the browser in the lower portion of the screen, highlight a contract price (for Q-quantity 
break contract types) and add pricing information. For Q-quantity breaks contract types 
you can enter a quantity break price and breaks 1-6.  

4 (Optional) To enter a quantity break price, select the Type, Break 1-6 in the line browser.  

5 Enter the minimum quantity that must be sold on a sales order document in order to 
utilize the price from the level. Quantity break is always defined in the selling unit of 
measure. 
 
For example, the standard price of I100 is $10.00 ea., the break 1 price is $9.75 and the 
break 2 price is $9.50. In order to receive a price of $9.75 the customer must purchase a 
minimum of 50. In order to receive a price of $9.50 the customer must purchase a 
minimum of 100. Therefore break 1’s quantity is 50 and break 2’s quantity is 100. 
 
If the contract is for a non-specific item, i.e., item price class, vendor or all items, the 
quantity break will apply to any item in that group of items regardless of UM. For 
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example, if 10 is set as the quantity for quantity break 1, it would apply to 10 boxes of 
widgets as well as 10 cases of wickets (as long as widgets and wickets were within the 
same item scope defined on the contract). 

6 If the contract is for a specific item, the quantity break price may be entered as a basis 
and multiplier, a set price or a change %. If the contract is for a non-specific item (i.e., 
item price class, vendor or all items), the quantity break price may be entered as a basis 
and multiplier. The valid options for basis for quantity break prices are as follows: list 
price, manual cost, sales order entry cost, standard price, quantity break price (up to the 
level being entered, e.g., if quantity break 3 is being entered, you may enter 1 - 3 as the 
basis for quantity break 3). 
Basis: The valid options for basis for quantity break price are list price, manual cost, 
sales order entry cost, standard price, any quantity break price or level price(up to the 
level being entered, e.g., if quantity break 3 is being entered, you may enter 1 - 3 as the 
basis for quantity break 3), entered in Costing and Pricing programs located in the 
Inventory Control module. 
Mult:  The multiplier for the quantity break price. 
-OR-  
Price: The set price for the contract quantity break price line. (If you select N/A as the 
basis you can enter a set price in this field.) 
Commission %: In addition to the three set up options for the quantity break prices, you 
can also enter a commission %. An Inventory Control static record flag determines 
whether this commission flag is used throughout the costing/pricing subsystem. If the flag 
is turned off, the option to enter the commission % is never available. If the flag is turned 
on, each contract price that is set up will require the field of a commission %. When 
entering the commission %, you can set the commission % to "no priority" (blank) 
indicating that commission is not generated based on the price being set up. (If the item 
is set to "no priority", any commission % entered in the contract pricing system will be 
ignored). (For more information on commissions, refer to the commission basis flag set in 
the Company Control F/M program in the System Management module.) 

7 Save your contract pricing line.  

8 You can highlight a pricing line and select: 

D  Delete. Deletes a highlighted pricing contact line 

F3 or  Stop Stops adding contract pricing lines. 

9 The following options are available; when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561)  to enter any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to enter any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract.. 

Shipping Accesses Shipment Scope Entry (SOE565) to specify whether the contract 
is valid for drop ship lines.  



Contract Procedures  

152 | Infor Distribution FACTS 7.9.0 Sales Orders Users Guide 

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can 
enter or modify additional contracts. 

Adding level pricing information to contracts 
1 Open the Contract Entry program. You can access this program by selecting Sales 

Orders > Contract Pricing> Contract Entry.  

2 For new contracts, refer to the How to enter contract header information procedure for 
details. For existing contracts, enter the contract number in the Contract # field.   

3 In the browser in the lower portion of the screen, highlight a contract price (for L-price 
level contract types) and add pricing information. For L-price level contract types you can 
enter a standard price and price levels 1-6.  

4 To enter a standard price, select the Type, STD PR line in the browser: 
 
The standard price may be entered as a basis and multiplier, a set price or a change %.  
Basis: The valid options for basis for standard price are as follows: list price, manual 
cost, sales order entry cost, standard price, any level price or quantity break price 
(entered in Costing and Pricing programs located in the Inventory Control module).  
Mult:  The multiplier for the standard price. 
-OR- 
Price: The set price for the contract price line. (If you select N/A as the basis you can 
enter a set price in this field.) 
Commission %: In addition to the three set up options for the standard price, you can 
also enter a commission %. The Inventory Control static record flag determines whether 
this commission flag is used throughout the costing/pricing subsystem. If the flag is 
turned off, the option to enter the commission % is never available. If the flag is turned 
on, each contract price that is set up will require the field of a commission %. When 
entering the commission %, you can set the commission % to "no priority" (blank) 
indicating that commission is not generated based on the price being set up. (If the item 
is set to "no priority", any commission % entered in the contract pricing system will be 
ignored). (For more information on commissions, refer to the commission basis flag set in 
the Company Control F/M program in the System Management module.) 

5 (Optional) To enter a level price, select the Type, Level 1-6 in the line browser.  
 
The level price may be entered as a basis and multiplier, a set price or a change %.  
Basis: The valid options for basis for level price are list price, manual cost, sales order 
entry cost, standard price, any price level.  
Mult:  The multiplier for the level price. 
-OR- 
Price: The set price for the contract price line. (If you select N/A as the basis you can 
enter a set price in this field.) 
Commission %: In addition to the three set up options for the price levels, you can also 
enter a commission %. An Inventory Control static record flag determines whether this 
commission flag is used throughout the costing/pricing subsystem. If the flag is turned 
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off, the option to enter the commission % is never available. If the flag is turned on, each 
contract price that is set up will require the field of a commission %. When entering the 
commission %, you can set the commission % to "no priority" (blank) indicating that 
commission is not generated based on the price being set up. (If the item is set to "no 
priority", any commission % entered in the contract pricing system will be ignored). (For 
more information on commissions, refer to the commission basis flag set in the Company 
Control F/M program in the System Management module.) 

6 Save your contract pricing line.  

7 (Optional) You can highlight a pricing line and select: 

D Delete. Deletes a highlighted pricing contact line 

F3 or  Stop Stops adding contract pricing lines. 

8 The following options are available; when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561)  to enter any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to enter any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract.. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the 
contract is valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can 
enter or modify additional contracts. 

Customer Returns Procedures 

Processing Customer Returns (Overview) 

1. Create a returns authorization document (optional) and print an authorization 

Customer Authorization document and Return Authorization 
• The Return document is created in Customer Returns Entry using the Quick Entry 

screen and the Invoice Search or with the Customer Returns Line Entry screen. 
• Since the original sale was also recorded on the system, the return can be tied to the 

past invoice. The authorization document number is given to the customer. 
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2. Print a returns receipt 

When you exit from Return Entry, the Return Authorization is printed. Provide a Returns 
Authorization or Returns Acknowledgment for the customer to use as a packing slip for the 
returned merchandise or keep as a receipt. 

3. Update the returns document 
• When the damaged merchandise is received, you can access the Order Entry suite 

of programs and select the menu option “RMA” and enter the return document 
number to access Returns Entry with the return document information loaded. 

• In Returns Entry, enter the quantity that was received back from the customer for 
each item. When done, the return goods credit memo and customer replacement 
sales order are created and status flags for the vendor return and vendor 
replacement is set to process the return in the Buyers Control Center.  Returns to 
stock or scrap result in a SO Credit Memo. Returns for repair or replacement result in 
a Sales Order. 

4. Check Buyers Control Center--PO 
• As the return goods credit memo is processed through the Daily Sales Register, the 

status flags change for the vendor returns so the Buyer’s Control Center can then 
process the returns to the vendor and create the negative PO.  The Buyer’s Control 
Center will also be aware of any vendor replacements that are indicated by a 
customer return and create the replacement PO.  These will update back to the 
Customer Returns System files. 

• As the return and replacement POs are processed through the Receipt Register, the 
status flags on the CRS lines are again updated.  If the customer credit and customer 
replacement were waiting on vendor action, the credit memo and sales order will be 
created.  The DSR updating these documents will again update back to the CRS line. 

5. Returns Inquiry and/or Report Analysis 
• Use Customer Returns Inquiry (SOI810) to check the status of documents in the 

process of being returned. 
• Run the CRS Status Report (SOR820) to list open returns, and analyze what stock is 

being returned. 
• Run the Returns Analysis Report (SOR830) as needed to list past returns, and 

analyze how much inventory was returned and for what reasons. 

6. Remove Past Customer Returns History  

Run SM System Clean Up F/M as needed to remove past Customer Returns documents 
which do not need to remain on the system. 

Enter a Customer Authorization or Return (Quick Entry Method) 
1 From the CRS main menu, select Customer Returns Entry. 

2 Enter the customer number and press F1-Quick Entry. 
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3 Enter the past invoice number for the return if it is known.  
--OR-- 
Use the Inv # search to select past invoice lines to be returned, or enter an item number 
to return an item not associated with a past invoice.   

4 In the Filters section, enter any of the following to limit the invoice search: item, 
beginning and ending invoice date, serial/lot number, ship-to, or reference number. Press 
the Apply Filters button. 

5 Enter the authorized and received (if known) amounts to select lines and press OK. All 
selected lines will return to the Quick Entry screen. (If the goods are already at the 
distributor’s warehouse, then the received quantity can also be entered.) 

6 On the Quick Entry screen, modify the authorized or received quantity, or reason code, if 
needed, and enter the CM returns code.  

7 (Optional) You can also update the Return Actions and Replace to Customer options, as 
well as add a warehouse for processing and modify the credit cost, credit price and 
restocking fee amounts. 

8 Click OK to automatically create the lines on the CRS document.  Only lines from the 
Quick Entry screen that have an authorized quantity will import into the return document. 

9 (Optional) On the Customer Returns Entry screen, you can now add return lines to this 
CRS document. 

10 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

11 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

12 Select OK to create the return and associated documents. Repeat step 4 as needed for 
each document created. 

13 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  If 
received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document. 

14 Press Done to enter another returns document; press Done again to exit the program.  

15  Press Done again to return to the CRS main menu. 

Creating return documents 
1 Access Sales Orders>Returns>Customer Returns Entry 

2 Select the customer return.  
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3 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

4 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

5 Select OK to create the return and associated documents. Repeat step 4 as needed for 
each document created. 

6 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  If 
received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document. 

7 Press Done to enter another returns document; press Done again to exit the program.  

Using Past Invoice Search for Customer Returns 
1 From the CRS main menu, select Customer Returns Entry.  

2 Press F1-Quick Entry and then enter the customer number. 

3 Use the Inv # search to select past invoice lines to be returned. 

4 In the Filters section, enter any of the following to limit the invoice search: item, 
beginning and ending invoice date, serial/lot number, ship-to, or reference number. You 
can also enter an item number to return an item not associated with any past invoice. 

5 Press the Apply Filters button to display past invoices in the grid. 

6 Enter the authorized and received (if known) amounts to select lines and press OK. All 
selected lines will return to the Quick Entry screen. (If the goods are already at the 
distributor’s warehouse, then the received quantity can also be entered.)  

7  (Optional) You can click the None icon beside a line to unselect it or enter 0 as the 
authorized quantity. 

8 Select OK to close the Past Invoice Search and any selected lines (lines with a positive 
authorized quantity) will be returned to the Quick Entry screen. 

Entering Customer Returns header details 
1 Access Sales Orders>Returns>Customer Returns Entry 

2 Specify the customer return number. 

3 Select the Header button to display the Header Detail window. 

4 Update the salesperson, terms, department and contact and reference information as 
needed. 
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5 Press Ok to save and display Customer Returns Entry. 

Entering customer return line item information 
Whether you are creating a Returned Goods Document, Return to Vendor PO, Vendor 
Replacement PO, and/or Customer Replacement Order, the beginning process for 
entering customer return line item information is the same. 

1 Access Sales Orders>Returns>Customer Returns Entry 

2 Create a new return or enter the return number. 

3 Select Add and enter the item number  

4 The Customer Returns Line Entry program is displayed. 

5 Enter the past invoice number, if any, for the return. 

6 Enter the Received and Authorized quantities. 

7 Specify the Return Action: W - Return to Warehouse, R - Return to Vendor for 
Replacement, C - Return to Vendor for Credit, S – Scrap, P – Repair. 

8 Specify how Replace to Customer:  W – From Warehouse (default), D – Direct Ship from 
Vendor, or N – No. Note that for temporary items, the D – Direct Ship from Vendor option 
is not available for the R - Return to Vendor for Replacement Return Action. 

9 Enter the Reason Code and the Returns Code. 

10  (Optional) If the Return Action you selected is R, C or P, indicate whether to Wait for 
Vendor Action/Repair. 

11 Complete the remaining fields as needed to produce the following: Returned Goods 
Document, Return to Vendor PO, Vendor Replacement PO, and/or Customer 
Replacement Order.  Refer to the step-by-step procedures for creating each kind of 
document to complete this process. 

Entering CRS Serial Lot Numbers 
1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Select Add and enter the item number. 

4 The Customer Returns Line Entry program is displayed. 

5 Enter the past invoice number, if any, for the return. 

6 Enter the Received and Authorized quantities. 

7 When the system asks: Enter serial/lot number, select Yes. 

8 For serial/lot items, the CRS Serial/Lot Number Entry screen is displayed. 

9 Select Add. 
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10 Enter the Serial/Lot number. 

11 Enter the quantity for the return. 

12 You can add or edit additional serial/lot items as needed to distribute the received 
quantity. 

13 Save your work and select Done to return to the Customer Returns Line Entry screen to 
complete processing the return. Complete the remaining fields as needed to produce the 
following: Returned Goods Document, Return to Vendor PO, Vendor Replacement PO, 
and/or Customer Replacement Order.  Refer to the step-by-step procedures for creating 
each kind of document to complete this process. 

Entering Temporary Items in CRS 
1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Specify the customer or return number. 

3 Specify the temporary item number for the return. 

4 When the system asks: Is this a temporary item, select Yes.  
(Optional--Note that you can select Quick Add to access Default Item Entry, where you 
can specify a item to use for the temporary item's default values.) 

5 The system displays the Customer Returns Line Entry screen, with the temporary item 
number and description: TEMPORARY displayed. 

6 In the Temporary Items section, specify the vendor, item class, unit of measure, and 
(optional) weight per unit. 

7 Enter the past invoice number, if any, for the return. 

8 Enter the Received and Authorized quantities. 

9 Specify the Return Action: W - Return to Warehouse, R - Return to Vendor for 
Replacement, C - Return to Vendor for Credit, S – Scrap, P – Repair. 

10 Specify how Replace to Customer:  W – From Warehouse (default), D-Direct Ship from 
Vendor, or N – No. For temporary items, the D – Direct Ship from Vendor option is not 
available for the R - Return to Vendor for Replacement Return Action. 

11 Enter the Reason Code and the Returns Code. 

12 (Optional) If Return Action you selected is R, C or P, indicate whether to Wait for Vendor 
Action/Repair. 

13 Complete the remaining fields as needed to produce the following:  Returned Goods 
Document, Return to Vendor PO, and/or Customer Replacement Order.  Refer to step 6 
of the step-by-step procedures below for creating each kind of document to complete this 
process. 

Entering Customer Replacement Information to create the Customer Replacement order 

Entering Vendor Return Information (to create the Return to Vendor negative PO and 
return the goods from stock) 
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Entering Vendor Replacement Information (to create the Vendor Replacement PO and 
will return the goods to stock) 

Entering Customer Return Information to create Returned Goods documents 

Entering Customer Replacement Information to create the Customer 
Replacement order 
Note this action is only available if Replace to Customer is Warehouse or Direct Ship 
from Vendor. If Replace to Customer is Warehouse, then a warehouse ship sales order 
will be created. If Replace to Customer is Direct from Vendor then a direct ship sales 
order and a tied direct ship PO will be created. 

1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Select Add and enter the item number.  

4 The Customer Returns Line Entry program is displayed. 

5 Enter the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.) 

6 In the Customer Replacement Information section, specify the customer return 
warehouse. This value defaults to the return warehouse’s Authorized Replenishment 
Path. If the replenish path is ‘From Vendor’ then this value defaults to the return 
warehouse. If the Replace to Customer setting is Direct Ship from Vendor then this field 
is disabled. 

7 Specify the Vendor. If the Replace to Customer setting is not Direct Ship from Vendor 
then this field is disabled. See the setting for “wait for vendor action/repair” in Vendor F/M 
(APF910). 

8 Indicate whether to Update Usage. This checkbox is only enabled if Replace to 
Customer is W. 

9 Enter the replacement information, including cost and price (press F1 to use the values 
from the past invoice), discount, ship to, order priority shipping, freight and tax 
information. 

10 The system displays the SO/Line# and SO Line Status. You can edit the SO/Line# 
values. 

21 Press OK to display the Customer Returns Entry screen. 

22 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

23 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

24 Select OK to create the return and a Customer Replacement Document. Repeat step 4 
as needed for each document created. 
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25 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  
The value displays in the Return Goods CM/Line # field or the Return Credit CM/Line # 
field, which is only populated if the Wait for Vendor Action/Repair setting is “Yes.” 
If received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document.  

26 Press Done to enter another returns document; press Done again to exit the program.  

Entering Vendor Replacement Information (to create the Vendor 
Replacement PO and will return the goods to stock) 
Note this action is only available if Return to Vendor is Replacement 

1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Select Add and enter the item number  

4 The Customer Returns Line Entry program is displayed. 

5 Enter the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.)     

6 In the Vendor Replacement Information section, specify the receiving warehouse. 

7 The system displays the PO/Line# and PO Line Status. You can edit the PO/Line# value. 

8 Press OK to display the Customer Returns Entry screen. 

9 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

10 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

11 Select OK to create the return and a Vendor Replacement PO and return the goods from 
stock. Repeat step 4 as needed for each document created. 

12 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  
The value displays in the Return Goods CM/Line # field or the Return Credit CM/Line # 
field, which is only populated if the Wait for Vendor Action/Repair setting is “Yes.” 
If received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document.  

13 Press Done to enter another returns document; press Done again to exit the program.  
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Entering Vendor Return Information (to create the Return to Vendor 
negative PO and return the goods from stock) 
Note this action is only available if Return to Vendor is Credit or Replacement. 

1 Access Sales Orders>Returns>Customer Returns Entry 

2 Create a new return or enter the return number. 

3 Select Add and enter the item number  

4 The Customer Returns Line Entry program is displayed. 

5 Enter the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.)     

6 In the Vendor Return Information section, enter the Vendor for the return. If the vendor is 
no longer valid or no past invoice entered, this value defaults to item’s primary vendor 

7 The system displays the Consolidation warehouse of the vendor (or the return 
warehouse if consolidation warehouse is blank), the Transfer/Line# and Transfer line 
Status, Transfer To Warehouse (if created), PO/Line# and PO Line Status and PO 
Warehouse, if created. 

8 (Optional) You can edit the Transfer/Line# and the PO/Line# values. 

9 Press OK to display the Customer Returns Entry screen. 

10 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

11 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

12 Select OK to create the return and a Return to Vendor negative PO and return the goods 
from stock. Repeat step 4 as needed for each document created. 

13 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  
The value displays in the Return Goods CM/Line # field or the Return Credit CM/Line # 
field, which is only populated if the Wait for Vendor Action/Repair setting is “Yes.” 
If received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document.  

14 Press Done to enter another returns document; press Done again to exit the program.  

Entering Customer Return Information (Creating Returned Goods 
documents) 
1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 
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3 Select Add and enter the item number  

4 The Customer Returns Line Entry program is displayed. 

5 Enter the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.)  If the Return Action specified is 
Scrap, an allowance credit memo will be created; if not a return credit memo will be 
created and the goods will be returned to stock. 

6 In the Customer Return Information section, specify the Return Warehouse where the 
items will be returned. 

7 Enter the Usage information. (Note that temporary items do not track usage.) 

8 Enter the credit information for the return, including warranty, discount, restocking fees, 
ship-to location, freight and tax information. 

9 Press OK to display the Customer Returns Entry screen. 

10 Select Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

11 Enter the requested information.  For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

12 Select OK to create the return and a Returned Goods Document for this returned item. 
Repeat step 4 as needed for each document created. 

13 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified.  
The value displays in the Return Goods CM/Line # field or the Return Credit CM/Line # 
field, which is only populated if the Wait for Vendor Action/Repair setting is “Yes.” 
If received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
line that the documents have not been created for, you will not be allowed to exit the 
document.  

14 Press Done to enter another returns document; press Done again to exit the program.  

Inquiries Procedures 

How to view customer information 
1 Open the Customer Inquiry program. You can access this program by selecting Sales 

Orders>Inquiries> Customer Inquiry. 

2 Enter the customer for which you want to view information in the Go to field.  The Go to 
field is case sensitive and relates to the sort order you select. This means that if you 
enter c100 to lookup a customer number when someone entered it as C100, the 
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customer record you are looking for will not appear in the browser. You get the same 
results if you enter C100 in the Go to field with the Alpha sort order selected. 

3 (Optional) Select whether to sort customer records by alpha lookup, customer number, 
phone number, contact name or customer class. Select a sort order by choosing Sort by 
from the menu bar.  

4 (Optional) You can use the Starts With field to enter the beginning characters for the 
customer code. If the Start From field in the lower portion of the screen, you can select to 
display documents by document number or reference number. 

5 (Optional) Select the warehouse for which you want to view information. 

6 The program defaults to the warehouse assigned to the terminal you are using.  
To change the warehouse filter:  Choose Options>Filter Views.  
In the window or popup box, press F1 to select the next warehouse on record. Press F2 
to search for a warehouse record. Press F3 to choose ALL warehouses. 
Select a view. 
Choose a view from the View  menu option or select a view from the view bar. 

View  View description 

Quotes Displays quote information including quote number, quote date, expiration 
date, warehouse, sales order number (if converted to a sale), the customer 
for whom the quote was made, who gave the quote and the quote total.  
Getting more information on a quote: 
In the view area, select the line and choose the Line Detail button or double 
click on the icon at the beginning of that line. 
  

Sales  
Orders 

Displays sales order information including document number, document type 
(work order, invoice, credit memo, counter sale, etc.), document status (work 
order entered but not printed, work order printed, confirmed invoice, 
receipted invoice, deleted sales order, voided invoice), document origin, 
invoice date, warehouse, amount, ship-to and reference number.  
Sorting open sales orders: 
Orders sort by document number by default. Click on the Reference number 
column header to sort by reference number. Click on the Document number 
column header to sort by document number. You can also click on any other 
column header to sort by that information. 
  
If the document is on hold, *HOLD* appears in the column after the reference 
number. Documents on hold cannot be printed or confirmed. Any non-deleted 
or non-voided document may be selected for detail inquiry. 
Getting more information on an order: 
In the view area, select the line and choose the Line Detail button or double 
click on the icon at the beginning of that line. On the Line Detail screen for 
Past Invoices view of SO Document Inquiry, the AR Detail button is available 
to view the AR document associated with the invoice if it is still on file.  
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View  View description 
  

Past 
Invoices 

Displays past invoices including SO document number, AR invoice number, 
document type (work order, invoice, credit memo, counter sale, etc.), 
document origin, invoice date, warehouse, amount, ship-to and reference 
number.  
Sorting past invoices: 
Click on the Invoice column header to sort by past invoice number or click on 
the Reference number column header to sort by reference number. You can 
also click on any of the other column headers to sort by that information. 
  
Getting more information on a past invoice: 
In the view area, select the line and choose the Line Detail button or double 
click on the icon at the beginning of that line. In the Line Detail Past Invoices 
view of SO Customer Inquiry, there are 2 special buttons available above the 
line item browser. The GL Posting button is enabled when the transaction 
highlighted in the browser is one that allows for drill back from the source 
document to the GL posting that was created by the register. If the GL 
posting records can be found, then Journal Inquiry will display defaulting to 
showing transactions for this document only. The AR Detail button is 
available to view the AR document associated with the invoice if it is still on 
file. 
  

Past Sales Displays past sales information for each item number and description. Listed 
information consists of invoice number and date, document origin, quantity 
sold and the corresponding unit of measure, price and the pricing unit of 
measure.  
Filtering past sales information by item type: 
Select Options>Filter Views from the menu bar.  
  

Customer 
Pricing 

Displays customer pricing information on items. Listed information consists of 
item number, item description, the customer’s default price, pricing unit of 
measure and item type.  
Getting more detail on pricing information: 
Double-click on the item line or select the line and press Line Detail to access 
level pricing, contracts, and past sales information for the customer/item 
combination.  
The Level Prices detail window shows the item’s standard pricing for the 
customer selected, as well as any price levels or quantity breaks that exist for 
this customer. 
 
The Contracts detail window shows the Contract Entry (SOE560) screen in 
view-only mode. The Past Sales detail window shows past sales information 
for the customer/item combination.  
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View  View description 

Ship-to 
Addresses 

Displays alternate ship-to information from the created in the Ship-To F/M for 
this customer. This view lists the alternate ship-to numbers, location names, 
contact 1, and phone number  
Getting more information on alternate ship-to addresses: 
In the view area, select the line and choose the Line Detail button or double 
click on the icon at the beginning of that line. The detail window displays the 
alternate location’s mailing address, both phone numbers and contact names 
if provided, salesperson/territory, default ship via code, UPS zone, route code 
if routes are used in your system, tax code and tax rate as well as any user 
defined fields entered on the User Defined tab of Ship-To F/M (ARF920). 
  
Press Enter (CR) to view detail on the next alternate ship-to for the customer 
selected. Press F4 to back up to the main inquiry screen.  

Blanket 
Sales 
Orders 

Displays information on blanket sales orders including document number, 
hold status, warehouse, entry date, expiration date, completion date, ship-to 
number and reference number.  
Sorting blanket sales orders: 
Orders sort by document number by default. Click on the Reference number 
column header to resort by reference number. Click on the Document 
number column header to resort by document number. You can also click on 
any other column header to sort by that information. 
If the document is on hold, *HOLD* appears to the right of the reference 
number. Documents on hold cannot be released or distributed.  
Getting more information on blanket sales orders: 
In the view area, select the line and choose the Line Detail button or double 
click on the icon at the beginning of that line. 
  

MSDS Displays information on Material Safety Data Sheets (MSDS) that were sent 
to this customer. The information in the view consists of the MSDS ID and ID 
description, ship-to, date last sent, MSDS revision date and the invoice 
numbers with which the MSDS sheets were sent. 
Filtering MSDS information by ship-to addresses: 
Select Options>Filter Views from the menu. 
Press F2 to search existing ship-to addresses. Press F3 to select all ship-to 
addresses for this customer. 

Customer 
Notes 

Displays customer notes information. 

 User-
Defined  

The data that appears on the User-Defined view of Customer Inquiry comes 
from the User-Defined view of Customer F/M (ARF910). Many users have a 
few pieces of information about customers, vendors, and items that are 
unique to their business that they would like to enter into FACTS for 
reference purposes. The User-Defined view displays user-defined fields 
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View  View description 
entered the major file maintenances and makes them available in FACTS 
Inquiry programs for information only. There are 5 user-defined fields that 
can be entered on the User-Defined screen of Customer F/M). There user-
defined field must first be configured by a user that has administrator 
privileges for User-defined Fields setting on the Security tab of User Code 
F/M (SMF410).  
  

27 When you are finished reviewing information for customers, close the Customer Inquiry 
program. 

How to view document information 
1 Open the Document Inquiry program. You can access this program by selecting Sales 

Orders>Inquiries>Document Inquiry. 

2 This program displays sales order documents by sales order document number as the 
default.  
When you first access Document Inquiry, the upper portion of the screen contains a 
Whse field, which is used to locate specify the warehouse used in the inquiry. The 
system defaults to the initiating warehouse for the user. You can also use the drop-down 
list to select open documents or past invoices, or quotes.  
 
In the Document (Or Invoice) Number field, enter the document/invoice number to 
display. Entering a valid sales order document/invoice number displays the document as 
it would be in the corresponding entry program (Quote Entry for quotes, Direct Invoice 
Entry for invoices, Credit Memo Entry for credit memos, etc.), and denotes the type (BO - 
backorder, IN - invoice, WO - open order, CS - counter sale or CM - credit memo) 
(except for quotes) in the center top of the screen. If the document is on hold, *HOLD* is 
displayed in the header next to the ship-to number. Documents on hold may not be 
printed or confirmed. 

3 You can search for and display sales order documents, quotes and past invoices in this 
program.  
 
Past Invoice View Details  
In the Past Invoices view of SO Document Inquiry, there are 2 special buttons available 
above the line item browser. The GL Posting button is enabled when the transaction 
highlighted in the browser is one that allows for drill back from the source document to 
the GL posting that was created by the register. If the GL posting records can be found, 
then Journal Inquiry will display defaulting to showing transactions for this document 
only. The AR Detail button is available to view the AR document associated with the 
invoice if it is still on file.  
From the Past Invoice view, you can also select the File>Print Invoices option to print 
past invoices. 

4 (Optional) You can select from the following: 
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Invoices button to display the invoice numbers for this document (only valid for open 
sales orders). The system displays a list of invoices for this order. You can then 
choose an invoice to display or return to the main screen. For past documents, notes 
are only available to view/edit (based on your user security access) from the Invoice 
view (accessed by the Invoice button) of Document Inquiry.  
 
Dep/Payment button to display Deposit/Payment entry information. The system 
displays the Deposit/Payment Entry (SOC718) in display-only mode.  
 
Footer button to display the footer memo for the document. 
 
Header button to display the Header Detail Window for the document. Refer to the 
Order Entry Header Detail Window topic for details. 
 
Highlight a line item and select the Line Detail button to access the Line detail screen 
for the document. Refer to the Document Inquiry Line Number Detail topic for details. 
 
For open quotes and open sales order documents and past invoices, access Note 
Entry (SME710) for the sales order header or line record specified in the program.   

For Past Invoices and Past Documents, the Open Doc button is available to access 
the open document ties to the past invoice line or past document line.  

For Blanket Sales Orders, the Rel Req button is available to access the Blanket 
Order Entry Release Request Screen (SOE711) in display-only mode.  

5 When you are finished reviewing information for documents, select the Done button to 
exit the Document Inquiry program. 

End of Period Procedures  

End-Of-Period Checklist - Sales Orders  
The end-of-period procedures are critical to the proper functioning of the system. Certain 
programs must be run in a specific order to close the Sales Orders Module accurately. 

It is suggested that copies of the checklist be made and used for each period close-out to be 
filed for future reference. 

Period ___ Year _____  

User  Date  Menu    Description  

________  ________  Recurring  1.  Post Recurring Documents 
through last day of period  

________  ________  Invoices  2.  Print/update last Daily Sales 
Register  
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________  ________  EOP  3.  Print/update Period Sales Register  

________  ________  EOP  4.  Run End-of-Period Update  

End-of-Period Checklist Explanation for Sales Orders 
1. Post Recurring Documents through last day of period. If Recurring Documents are 
used, in order to close the current period, this procedure must be complete. The End-of-
Period Update checks to make sure that the last day posted is the last day of the month. The 
reason for this check is to ensure that the user posts all recurring documents in the correct 
period.  

2. Complete all invoicing and print/update last Daily Sales Register. All invoices for the 
period should be entered and printed and the last Daily Sales Register printed and updated. 
If these procedures are not complete, the sales figures will not be an accurate accounting of 
the period in AR, IC, SO, SA and GL.  

3. Print/update Period Sales Register. This report allows the user to obtain a listing of all 
sales (by each Daily Sales Register printed) for the period. After the register prints, the user 
should remove the records just printed to clear the file. If records are not removed, they 
appear on next period’s register. All Period Sales Registers should be kept as an audit trail.  

4. Run End-of-Period Update. This is the last step to closing the sales orders current period 
and should only be run after all of the above procedures have been completed. The program 
clears month-to-date Daily Sales Register recap figures and closes the current period. If it is 
the last period of the year, year-to-date figures are also cleared. When this program is 
complete, the user may begin daily procedures in Sales Orders in the new (current) period.  

A detailed account is provided of the purpose of each program on the checklist. 

How to create a SO to GL distribution table 
1 Begin by selecting the type of GL distribution, which determines how transactions 

processed by the Daily Sales Register post into the Journal File in General Ledger 
(example: print only, print and post). See the GL Distribution input for options.  

2 Then indicate to which General Ledger Journal file the distribution should post, such as 
Sales Journal. 

3 Select a basis. The basis tells the system whether to use the default GL number set in 
this program, or GL numbers that exist in various GL Table file maintenances located in 
other modules.  
For instance, Accounts Receivable entry in this program gives you the option of posting 
to the default GL number or the customer’s GL number. If you look in the Customer F/M 
program, it contains a field in which you can assign an AR GL Table to each customer. 
By selecting the customer basis, you are telling FACTS that you want the DSR to post to 
the Accounts Receivable GL number associated with the table assigned to that customer 
— not to the GL number entered here.  
In many cases, the other basis options — such as customer, item, tax code, ship via and 
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returns code — enable you to create a much more accurate and detailed accounting 
system than you could be simply posting to default GLs. 

4 Indicate whether you want the department and/or branch numbers embedded within the 
GL account number (if applicable). If you use departments and branches and select this 
option, the system looks at the department and branch number on the invoices and 
inserts this information into the GL number.  
For example, if the G/L number to post is 415-00-00 (department is fourth and fifth digits, 
branch is sixth and seventh digits), the department is 01 and the branch is 02, then the 
system posts to 415-01-0The system inserts the department and/or branch in the proper 
place within the GL account number.  

5 If the Department Position flag in the Company Control Record is 0, the department 
inputs are disabled. If the Branch Position flag in the Company Control Record is 0, the 
branch inputs are disabled. By default, these inputs are deselected. 

6 Enter default GL numbers for each of the accounts listed in this program regardless of 
whether you intend to use the default basis or not. In some cases, the system can only 
post to a default GL entered in this program.  

 

Remote Order Entry Processing  

Signing onto the ROE system 
1 From the Sign-On Screen, follow these steps to sign on to the system and access the 

Remote Order Entry Menu. 

2 Enter your user code or press F4-Exit to exit the system. If an incorrect entry is made, 
press CR to reenter the code. 

3 Enter your password or press F4-Backup/Exit to backup/exit the system. The password 
will not display on screen. If a remote user makes an incorrect entry, press Enter (CR) to 
reenter the password. 

Note: If at any time during the sign-on process you see the message Contact the system 
administrator - code XX, please make note of the code number and contact your 
distributor. 

Signing off of the ROE system 
From the menu system, type "OFF" and press Enter (CR).  

Entering a remote order 
1 From the ROE main menu, select Remote Order Entry. 
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2 Press Enter (CR) for the system to assign the next available document number. 

3 Enter the required header information. 

4 Enter the line-item detail and memo line information. 

5 Complete the ending routine.  

6 Enter another return, or return to the ROE main menu. 

Editing a remote order 
1 From the ROE main menu, select Remote Order Entry. 

2 Enter the document number to edit. The order number will not be accessible if it has 
been reviewed by the distributor. *HOLD* will display on screen, if the order is on hold. 
Contact the system administrator for further assistance. 

3 Make all required changes to the header by pressing F2-Change Header, or enter the 
line number of the line-item/memo line to change. 

4 Press F3-End to access the ending routine. 

5 Enter another return to edit, or return to the ROE main menu. 

Deleting a remote order 
1 From the ROE main menu, select Remote Order Entry. 

2 Enter the document number to delete. If the order number will not be accessible if it has 
been reviewed by the distributor. Call your system administrator for further assistance.  

3 Enter D-Delete and press Enter (CR) to continue. 

4 The system prompts "Are you sure you want to delete the entire document (y/n)?  

5 Answer YES. The system will remove each line item and the entire order from the 
system.  

Entering a Customer Item Number in ROE 
1 From the ROE main menu, select Customer Item F/M. 

2 Enter the customer’s item number, system item number, (optionally) customer 
description, and the default selling unit of measure. 

3 The system prompts "OK to Add (Y/N)?", answer Yes to add or No to change or delete 
the entry. 

4 Enter another association or press F4-End.  
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Editing a Customer Item Number in ROE 
1 From the ROE main menu, select Customer Item F/M. 

2 Enter the customer’s item number to modify. 

3 Enter the line number of the line to change. The system prompts "OK to Change 
(Y/N)?", answer Yes to add or No to change or delete the entry. 

4 Enter another association to modify or press F4-End.  

Deleting a Customer Item Number in ROE 
1 From the ROE main menu, select Customer Item F/M. 

2 Enter the customer’s item number. 

3 Choose Delete from the button bar. Enter D-Delete and press CR to continue. 

4 The system prompts "Are you sure you want to delete this record (N/YES)? Answer 
YES. The system will remove the record. 

Sending a message in ROE 
1 From the ROE main menu, select General Message Entry. 

2 The current user code displays in the From field; enter the subject of the message in the 
Regarding prompt. Indicate Yes or No if a Reply Required? 

3 Enter the body of the message. Press Enter (CR) to complete each line and F3-End to 
end. 

4 Make any necessary adjustments to the message. Press F3-End and F3-Send. 

5 Indicate whether to send the message to an Employee or Group of employees. Use F2-
Search to display a list of employees or available groups.  

6 From the To Employee/Group prompt, press F2-Display Receivers to display a list of 
message recipients. Delete any entries from the list by entering the line number which 
corresponds to the name to delete. When done, press F4-Backup and F3-Send. 
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